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Introduction 
 

SAAM II is a very powerful software tool for model development and testing using 
multicompartmental models. Mathematically, these models translate into systems of ordinary 
linear or non-linear differential equations. A flexible, graphical user interface (GUI) makes the 
power of SAAM II easily available to researchers with diverse backgrounds.  
 
The purpose of the “SAAM II” Tutorials is to amplify the information provided in the Help 
Menu and answer questions on how to use SAAM II. The philosophy behind the tutorials is to 
illustrate how different components of the SAAM II work using hands-on examples. 
 
SAAM II Basic Tutorials illustrate SAAM II’s most commonly used features, features that 
almost everyone will use at some time during the modeling exercises. 
 
SAAM II Advanced Tutorials illustrate SAAM II’s more sophisticated features that are 
needed to model more complex experimental protocols than is usually the case.  These tutorials 
and a brief description of each are: 
 

• Creating Conditionals deals with the need to model conditional statements such as “if-
then-else”. If a state variable such as a qi(t) is included in part of the conditional 
statement, then mathematically the problem can be unstable. More specifically, in some 
software packages that permit conditionals, incorrect answers can be returned because of 
this. In SAAM II, conditional statements are implemented using the “Heaviside 
Function”. This function is continuous and differentiable, and can be tuned to appear 
almost as a step function. 

 
• Using Change Conditions permit the modeling of an experimental perturbation such as 

changing dosing during an experiment, or collecting 24 hour urine samples. 
Mathematically, change conditions stops integration, interrogates what changes are 
needed, makes those changes, and resumes integration. 

 
• Using Delays explains why the Delay Tool in SAAM II is created by a string of 

compartments. This tutorial explains how to use this tool. It also explains how to create 
an “absolute” delay using the Heaviside function. 

 
• Using Experimental Inputs (Advanced) explains some of the advanced techniques that 

can be used to specify less common or more advanced types of input dosage and to 
conduct parametric deconvolution. These techniques have been designed for maximum 
flexibility.  

 



• Multiple Input-Multiple Output Experiments explains how to deal with experimental 
protocols with one input-multiple outputs or multiple inputs-multiple outputs. This 
experimental protocol can be modeled in SAAM II in two ways; both permit the 
software to do the internal book keeping. 

 
• Using Forcing Functions explains how to use the Forcing Function tool. Forcing 

functions are an engineering concept that allows the modeler to describe the effect of a 
driving section, or compartment, of a model without having to mathematically describe 
the compartment.  The forcing function essentially enables all differential equations in 
your model to “see” the particular function. Forcing functions can be used as a 
convenient modeling tool in dealing with precursor-product models; they are also used 
as a model development tool. 

 
• Using Parameters (Advanced) explains some of the more sophisticated ways of 

describing parameters, setting upper and lower limits, and using SAAM II’s Bayesian 
capability to use prior information.   

 
• Saving and Restoring Solutions is a feature of SAAM II that lets you save different 

model configurations and solutions so that you can compare solutions among different 
parameter or model configurations. This feature is used in model development and 
testing when you want to be able to compare different situations as you proceed. 

 
• Simulating Data explains how to use your model to simulate experimental data for 

single-subject analysis. It illustrates how to simulate a single input-single output 
experiment and a single input-two output experiment. 

 
The goal of these Advanced Tutorials is to help you explore and utilize the full functionality of 
SAAM II. 
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Creating Conditional Expressions 

 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to create conditional statements in your SAAM 
II Compartmental model. You will learn 
 

 How to create “if-then-else” ((Part 1) 
 How to create zero-order inputs (Part 2) 
 How to create an input pump (Part 3) 

 
Files Required 
 

Study Files: The study files for this tutorial are 
 

if_then_else.stu 
zero_order.stu 
pump_1.stu 
pump_2.stu 

 
Data Files: The data files for this tutorial are 
 
  if_then_else.dat 
  zero_order.dat 
  pump_1.dat 
 

Introduction 
 
There may be times in your modeling work when you need to create what is called a 
conditional. This means you are interrogating some variable in your model, and changing 
another variable or parameter in the model depending upon the “question” being asked. 
 
 Conditional statements 
 
Conditional statements provide a mechanism for switching an execution path or the value 
assigned to one of more variables or parameters. Thus the conditional statement is a means by 
which to specify a switching mechanism. The most common example is the “if-then-else” 
statement. An example of the “if-then-else” statement is: 
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k(2,1) = if (variable > 0) then 1 else 2 

 
In this situation if the variable you are interrogating is greater than zero, then the parameter 
k(2,1) = 1; otherwise it equals 2. 
 
SAAM II regards conditionals as explicit or implicit. An explicit conditional statement is one 
where the time at which the switching occurs is known (can be predicted in advance). An 
implicit conditional statement is one where this time at which the switch occurs is not known 
until the condition itself is evaluated. Examples are: 
 

Explicit: k(2,1) = if (t ge 10) then 1 else 2 
Implicit: k(2,1) = if (q1 < q2) then 1 else 2 

 
In these examples, “ge” is “greater than or equal to”, and q1 and q2 are the contents of 
Compartments 1 and 2 at time “t”. 
 
In the explicit example, the time at which the switch occurs is known to equal 10. In the implicit 
case, there is no way to predict in advance when q1 will be less than q2; values for q1 and q2 
must be obtained at every integration step, and the test for “q1 < q2.” performed. 
 
 Continuity and differentiability 
 
It is essential to understand the difference between continuity and differentiability because both 
are involved in how SAAM II “Solves” and “Fits”. During either a “Solve” or a “Fit”, SAAM II 
must perform numerical integration of the differential equations of your model. In order for the 
integrator to perform correctly, the functions (the qi) must be both continuous and differentiable. 
 
What do we mean by continuous and differentiable? Consider the following plot of q1 from 
study_0: 
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This curve is “smooth”. That is, pick any point on the curve. Then start from a point on the 
curve to the left of this point. Move to the point along the curve. Then start from a point on the 
curve to the right of this point. Move to the point along the curve. You will reach the same final 
point no matter which side you start from and where. You can try this using the point at time 
equal to 5 days. 
 
Now consider the following curve: 
 

 
 

If you pick time equal to 5 days, and move to five days from the left (e.g. starting from 4) you 
will arrive at a different point than if you move to five days from the right (e.g. starting at 6). 
We say q1 is not continuous (or discontinuous, or has a discontinuity) when t = 5. You can see 
this even more clearly by looking at the table of values around t = 5: 
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Moving in from a point less than time equal to 5 days you will end up at about 4.41e+07; 
moving from a point to the right hand side of time equal to 5 days you will end up at 1.48E+08, 
two very different values. This also is why there are two values reported by SAAM II at time 
equal to 5 days since this simulation was set up using Change Conditions. 
 
What about differentiable? Differentiable is similar to continuity but deals with tangent lines. In 
the solution of q1 in study_0, pick an arbitrary point on the curve. Then move away from that 
point, and draw a tangent line to the curve. Then move the tangent line to the point you picked. 
You can see that no matter whether you start from the left or right side of your chosen point, 
you will end up with the same tangent line. 
 
Now consider the following curve: 
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There is a break at day 5. The function is continuous, but, as shown in the figure below, you will 
end up with two different tangent lines at t = 5 depending on whether you start to the right or 
left of t = 5: 
 

 
 

In this case, when the tangent lines do not coincide, we say the function is non-differentiable at 
that point. In this case, q1 is not differentiable when t = 5. 
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 Explicit and implicit conditionals. 
 
An explicit conditional is allowed because the time at which it occurs is known. Integration can 
stop at the prescribed time, be reset, and continue. An implicit conditional can create either a 
discontinuity or non-differentiable function, or both. For this reason, implicit conditionals are 
not allowed in the SAAMI II Compartmental application. 
 
Explicit conditionals are allowed in the SAAM II Compartmental application. They are 
implemented using the Change Condition tool in the SAAM II Compartmental Toolbox. 
When using Change Conditions, it is assumed that the time at which the change takes place is 
known exactly. For more information on the Change Condition tool, see the Using SAAM II 
tutorial “Working with Change Conditions.” 
 
There is no equivalent to Change Condition in the SAAM II Numerical application. However, 
the explicit form of the “if-then-else” statement is allowed. An example is the following: 
 

y(t) = if (t < 300) then yrise(t) else ywash(t) 
 

This is an example of fitting a sum of exponentials to a constant infusion study where a washout 
phase was included starting at t = 300. Two functions, yrise(t) and ywash(t), are required. One 
describes the rise during the infusion and the other the washout. It is known that the infusion 
stops at “300.” The function that is fitted to the data, y(t), then equals yrise(t) for t less than 300, 
and equals ywash(t) when t is greater than or equal to 300. 
 
 Implicit conditionals and the Heaviside function 
 
How can one deal with implicit conditionals in SAAM II? The “work-around” is to use the 
Heaviside function. The conditional statement specified by the Heaviside function approximates 
the desired switch by assuming a value of zero or 1 at a given point. While virtually 
instantaneous, the function is continuous and differentiable! Thus switches can be created using 
this function, and one does not need to worry during the “Solve” or “Fit” about the continuity 
and differentiability assumptions. 
 
The Heaviside function is 
 

heaviside=0.5*(1.0+atan(lambda*(x - xlag))*2/3.141592653) 
 

In this expression, “atan” is the arctangent function. The expression “x – xlag” creates the 
switch. “x” can be any function of “t”, and xlag is the value at which the Heaviside function 
changes between 0 and 1. Normally “x” will be “t”, time. but the expression is general, and 
there may be time when “x” may equal one of the “qi(t)” in your model. For values of “x” less 
than “xlag”, the value of the Heaviside function equals “zero.” For values of “x” greater than 
“xlag”, the value is “one.” Thus the values of the Heaviside function are, for all practical 
purposes, either zero or 1. That is, the change from 0 to 1 is extremely rapid yet the function 
remains continuous and differentiable. The parameter, lambda, controls the sharpness of the 
function, i.e. how fast the values change between zero and 1. This can be seen in the following 
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figure where the Heaviside function is calculated for lambda equal to 100, 1.000, 10.000 and 
100,000 respectively where the Heaviside function is written 
 

heaviside=0.5*(1.0+atan(lambda*(t - tlag))*2/3.141592653) 
 

where “t” is the independent variable “time” and tlag is set equal to 30. (In this example, then, 
“x” is specifically defined as “t”, time.) Thus when t = 30, the Heaviside function changes from 
zero to 1. 
 

 
 
In the linear plot shown above, you can see how abrupt the change is; it almost looks 
discontinuous and nondifferentiable. To see what is really happening, and the role that lambda 
plays, one must look at the plot in semilog mode: 
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In this figure, you can see the function is continuous and differentiable despite the “sharp” 
change from zero to “1.” As lambda increases, the value of the Heaviside function between zero 
and 30 becomes smaller, i.e. closer to zero, and the “sharpness” of the change from zero to 1 is 
increased. “Zero”, as you can see, is not true zero, but is arbitrarily small relative to the other 
values you are calculating so, for all practical purposes, it can be regarded as zero. 
 
When you use the Heaviside function to create a conditional, you must set a value for lambda. 
Typical values for lambda are usually between 1,000 and 1.0e+08 depending upon the situation. 
But you need to “tune” lambda for your particular situation. What happens is the following. 
When you Fit your model to your data, the results may depend on the value of lambda. What 
you want to do, and this will be illustrated below, is change (usually increase) the value for 
lambda so that the final values for the adjustable parameters and their error estimates do not 
change. This will be a function of the sharpness of the Heaviside function mentioned above. It 
also depends upon the magnitude of “x – xlag”. 
 
 Example 
 
Suppose you have a loss, k(0,1) from your model which you believe, up to a certain unknown 
time, exhibits Michaelis-Menten behavior and thereafter is an unknown constant. If “tlag” is the 
unknown time at which the change occurs, you can write the Heaviside function as 
 
  heaviside=0.5*(1.0+atan(lambda*(t - tlag))*2/3.141592653) 

 
in the Equations window of the SAAM II Compartmental application. tlag will be a 
parameter which will appear in the Parameters dialog box; it can be either fixed or adjustable. 
You can then write in the Equations window: 
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  Loss1 = Vm/(Kd+q1) 
 
The expression you would write for k(0,1) is 
 
  k(0,1) = (1-heaviside)*Loss1 + heaviside*Loss2 
 
Up to time tlag, “t – tlag” is negative hence “1-heaviside” equals 1, and k(0,1) will equal Loss1, 
the Michaelis-Menten loss. For values of t greater than tlag, the Heaviside function will equal 1, 
and k(0,1) will be equal to Loss2. Loss2 will be recognized by SAAM II as a parameter which 
will appear in the Parameters dialog box; it can be either fixed or adjustable. 
 
This is a specific example of the more general case when 
 
  heaviside=0.5*(1.0+atan(lambda*(x - xlag))*2/3.141592653) 
 
i.e. you do not need “t – tlag”. One can then write 
 
  y = heaviside*expression1 + (1 – heaviside)*expression2 
 
For values of “x – xlag” that are positive, y will equal expression 1; when “x – xlag is negative, 
y will equal expression2. expression1 and expression 2 can be a single value, parameter, a 
function such as “q1/vol”, or the Michaelis-Menten expression used above. 
 
 Computational considerations 
 
As you might expect, the Heaviside function, because of its sharpness, has the potential to create 
some problems when you Solve or Fit your model to your data. In general if there is only one 
conditional statement, the default Computational Settings will be sufficient although it is 
recommended you set the Minimum Number of Calculation Intervals equal to their 
maximum (500). You will see this is the case in the first two parts of this tutorial. 
 
There may be other times when the switch specified by the conditional statement is active 
several times during the simulation of your experiment. An example is provided in Part 3 where 
an input pump is simulated to maintain plasma concentration at a certain level. In this case, the 
Heaviside function changes rapidly.  
 
In this situation, the following Computational Settings are recommended: 
 

 Set the Minimum Number of Calculation Intervals equal to 500. 
 Change the Integrator to the “Runge-Kutta”. 
 Set Derivative calculation to “Central”. 

 
 
The Computational Settings dialog box will appear as follows: 
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Even with these setting, there are other adjustments you may need to make; most are suggested 
by SAAM II. As an example, you may need to change the value of the Relative Error. If you 
get such a warning message, first try decreasing this from 0.001 to 0.01. 
 
The most important point is that when the switch specified by the conditional statement is 
rapidly turning on and off, you must be very careful that the software is operating correctly. 
This is why you should “tune” lambda until the solutions do not change. 
 
 Conclusion 
 
Finally, besides being used to specify implicit conditionals, the Heaviside function is used to 
create “absolute” delays. You can learn about “absolute” delays in the Using SAAM II tutorial 
“Working with Delays.” 



Advanced Tutorials SAAM II v.2.1 Creating Conditionals 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Conditionals – 11 SAAM  II Version 2.1 

Part 1. Creating a model with the conditional “if-then-else.” 
 
The example given below is a modification of the experiment in study_0. In the experiment 
described below, it is hypothesized that, for plasma concentration above a certain value, the loss 
from Compartment 1 exhibits Michaelis-Menten nonlinear behavior, and for concentration 
below this value, the loss is a constant rate. Information about the Michaelis-Menten constants, 
Vmax and Km, is available from the literature, so these parameters are entered using the SAAM 
II Bayesian option (for more information on this option, see the Using SAAM II tutorial 
“Working with Parameters.”) 
 
You will use the study file if_then_else. This file has been created with the conditional 
expressed and the parameter values entered. The data file is included separately in case you 
would like to reconstruct the study file yourself. Each particular entry will be explained in 
detail. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file , if_then_else. 
 

a. The file , if_then_else should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as follows: 
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3. View the model and the experiment on the model, and change the model. In the SAAM 
II Toolbox, click Experiment. The experiment on the model will appear as follows: 

 
The model of the experiment appears the same as the model of the experiment in 
study_0 structurally. The way in which the input and equations are specified in order to 
deal with the “if-then-else” makes the model different . 

 
4. View the different components of the experiment on the model. 
 

a. View the Sample Attributes dialog box associated with s1. 
 

(1) Double-click s1. The Sample Attributes dialog box will open as follows: 
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The information in the Sample Attributes dialog box is standard in that the 
sample is associated with the Data Name “plasma”, and the sample equation 
“s1=q1/vol” will introduce the new parameter vol. You can open the Data 
window if you wish to view the “plasma” data. 

 
(2) Click Done. 

 
b. View the Exogenous Input dialog box associated with ex1. 
 

(1) Double-click ex1. The Exogenous Input dialog box will open as follows: 
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The information in the Exogenous Input dialog box is standard in that the input 
is a single bolus of 400 units. 

 
(2) Click Done. 

 
5. Creating the conditional. 
 

As stated above, it is hypothesized that for plasma concentrations above a certain, known 
level, the loss k(0,1) exhibits Michaelis-Menten kinetics while below that level, the loss 
rate is a constant. The plasma concentration ranges from approximately 0.2mg/ml to 
0.04mg/ml. The concentration at which the loss changes from Michaelis-Menten to a 
constant is known to be 0.1mg/ml, but the exact time at which this occurs is unknown. 
 
The following describes how to specify k(0,1) equal to a Michaelis-Menten expression 
for values of s1 greater than 0.1 and equal to a constant for values of s1 less than 0.1. 
 
a. View the equations setting up the Michaelis-Menten loss and the conditional 

expression to create the switch. 
  

(1) In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 
click Equations . The Equations dialog box will open as shown below: 

 

 
 

There are two equations in the Equations Defined Here pane. 
 
The equation “MM” defines the Michaelis-Menten term which will be used to 
defined k(0,1). This will introduce two new parameters in the model, Vm and Kd. 
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The second equation is the Heaviside equation. In this equation, the 
concentration s1 is being compared to the parameter set. s1 is the model 
calculated value for the concentration, and set will be entered as a fixed 
parameter, in this case equal to 0.1. When s1 is greater than or equal to set, the 
value of heaviside will equal 1, otherwise it will equal zero.  

 
(2) Close the Equations dialog box. 
 

b. View the definition of k(0,1). 
 
(1) Double-click k(0,1). The Loss Attributes dialog box will appear as follows: 
 

 
 

The equation specifying k(0,1) now is the key to understand how the conditional 
expression is working. The expression is: 
 
k(0,1)=heaviside*MM+(1-heaviside)*loss 
 
When the Heaviside function equals 1, i.e. when s1 is greater than or equal to set, 
k(0,1) will equal “MM”. Otherwise it will equal “loss”; “loss” will be recognized 
by SAAM II as a parameter appearing in the Parameters window. Thus this 
expression is equivalent to 
 
k(0,1) = if (s1 ge set) then MM else loss. 
 

 If-then-else and the Heaviside function. The Heaviside function can be used to create 
if-then-else statement by recognizing that the “then” part of the statement occurs 
when the value of the Heaviside function is 1, and the “else” part of the statement 
occurs when the value of the Heaviside function is zero. 
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(2) Click Done. 
 

At this point, the model is fully specified. It remains to examine the Parameters window. Then 
you can proceed to Solve and Fit the model to the data. 
 

6. View the Parameters window. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open as shown below: 

 

 
 

The first two parameters, Kd and Vm, are the Michaelis-Menten parameters. Since 
prior information is available about these parameters, they are entered as Bayesian 
(for more information on SAAM II Bayesian parameters, see the Using SAAM II 
tutorial “Working with Parameters.” The next two parameters, k(2,1) and k(1,2), are 
the exchange rate constants. The parameter lambda is fixed; it is part of the 
Heaviside function. The “tuning” of lambda will be explained below. The initial 
value of 1.0e+06 is usually a reliable starting point; it can be changed during the 
tuning process. The parameter loss is the constant rate of loss once s1 falls below set, 
the concentration at which k(0,1) changes from Michaelis-Menten to a constant. vol 
is just the volume of Compartment 1. 

 

Jake Kraft


Jake Kraft
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b. Click Done. 
 
7. Solve the model and save the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
c. Click s1:plasma to move this to the Current Selection pane. 
 
d. Click Done. If the plot is not in semilog, in the View menu, click Semilog. The plot 

will appear as follows: 
 

 
 
e. Close the Plot window. 
 
f. In the Compute menu, click Solutions. The Solutions dialog box will open.  
 
g. Click Add. The Solution Variables dialog box will open. Scroll through the 

variables and click s1. The two dialog boxes will appear as follows: 
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h. In the Solution Variables dialog box, click Done. 
 
i. Close the Solutions dialog box. 
 

Tuning lambda. The parameter lambda is “tuned” by changing its value until there are 
no longer any significant changes in the adjustable parameters and their error 
estimates. To tune lambda, i.e. as you change the value, you must start from the 
same set of initial parameter estimates. This solution has been saved as that starting 
point. For more information on saving and restoring solutions, see the Using SAAM 
II tutorial “Saving and Restoring Solutions.” 

 
 

8. Fit the model to the data, view and record the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, click 

Fit . The plot of s1:plasma will appear as shown below: 
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b. In the Show menu, click Statistics, or alternatively on the SAAM II Toolbar click 

Statistics . The Statistics window will appear as follows: 
 

 
 
c. Record the results as shown below: 
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lambda 1.00E+06 1.00E+07
Kd 399(11)
Vm 59.6(19)
k(1,2) .069(80)
k(2,1) .085(19)
loss .089(39)
vol 2060(1)  

 
These are the values when lambda equals 1.00e+06. You can see Kd and Vm do not 
change much from their initial values meaning there is not much information in these 
data to help determine them. In addition, k(1,2) does not have very good precision. 

 
d. Close all open windows and dialog boxes. 
 

9. Restore the original solution, and refit the model to the data with lambda equal to 
1.0e+07, and record the results. 

 
a. In the Compute menu, click Solutions. The Solutions dialog box will open. 
 
b. Click “1” in the Solutions pane. The Solutions dialog box will appear as follows: 
 

 
 

Notice Restore Selected is now available. 
 
c. Click Restore Selected. The following message will appear: 
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d. Click OK, and close the Solutions dialog box. 
 
e.  Re-Solve the model. The original solution is now restored. 
 
f. Change the value of lambda from 1.0e+06 to 1.0e+07. The Parameters dialog box 

will appear as follows: 
 

 
 

 Close the Parameters dialog box. 
 
g. Re-Fit the model to the data, and record the results. The results should appear as 

follows: 
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lambda 1.00E+06 1.00E+07
Kd 399(11) 399(11)
Vm 59.6(19) 59.6(19)
k(1,2) .069(80) .069(80)
k(2,1) .085(19) .085(19)
loss .089(39) .089(39)
vol 2060(1) 2060(1)  

 
You can see there is no difference between lambda equaling 1.0e+06 and 1.0e+07, 
so you can regard lambda equal to 1.0e+06 as a well-tuned value. 
 
You should also try different values for lambda such as 1.0e+05 and 1.0e+04 to see 
which parameters change, if any. 

 
h. Close all open windows and dialog boxes. 

 
 
Quit the SAAM II Compartmental application. Do not save the changes to if_then_else. 
 
 
In this example, it is useful to examine k(0,1). A plot of this parameter is shown below 
following the last “Fit”: 
 

 
 

You can clearly see the value of k(0,1) rising during the initial decay phase of the data; the rise 
continues until around 4 hours at which point s1 is less than set. However just before the switch 
defined by the conditional statement occurs, k(0,1) is actually greater than loss (the straight line 
portion parallel to the t-axis.) If one believes this should not be the case, then the value for set 
may be off a little. 
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 Part 2. Creating a zero-order input of unknown duration 
 
A zero-order input into a compartment is actually equivalent to a constant infusion. However, 
there are instances when specifying it in this manner is not appealing in terms of the physiology, 
or drug absorption, being studied. It is a difference between 
 

 
 
and 
 

 
If one is dealing with absorption and believes that the absorptive process is zero-order, then 
either of these two model configurations can explain the kinetics. In the case of the second 
model, k(2,1) would be a zero-order rate constant. The first model will yield identical results, 
but the lack of a schematic for absorption is not appealing. 
 
This part will explain how to create a zero-order absorption of an unknown amount for an 
unknown duration. 
 
The experiment is one in which 100mg of the drug was given orally at the start of the 
experiment followed by several other doses sufficient to have drug mass levels high enough in 
Compartment q1 for zero-order absorption to realistically take place. The hypothesis is that 
absorption is zero order of unknown amount for an unknown duration. The experiment lasts for 
24 hours. 
 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 
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2. Create the following system model: 
 

 
 
3. Create the experiment on the model.  
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. Set the experimental attributes as follows: 

 

 
 
b. Click Done. The Create Experiment dialog box will open. Click Create. The 

model will appear as follows: 
 

 
 

4. Add the data to the model. 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
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b. On the File menu, click Open. The file zero_order.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click zero_order.dat. The data in this file will appear in the Data window. 

The Data window should appear as follows: 
 

 
 
d. Close the Data window. 

 
5. Create a sample on Compartment q2, associated with “plasma” and edit the sample 

equation to read “s1=q2/vol”. The Sample Attributes dialog box should appear together 
with the model as follows: 
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Click Done. The sample s1 will become filled. 
 
6. Create an input into Compartment q1. 
 

a. Create the input into Compartment q1. The model should appear as follows: 
 

 
 
b. Specify the input as a bolus equal to 100 using the equation format. 
 

(1) Double-click ex1 to open the Exogenous Input dialog box. 
 
(2) Select Equation as the input type. 
 
(3) Set the Start and Stop time equal to zero. 
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(4) Write the input equation “ex1 = input”. Click Add. The Exogenous Input dialog 
box should appear as follows: 

 

 
 
(4) Click Done. 

 

Exogenous input. Technically an exogenous input should not be needed in the case of 
zero-order absorption,  . In this case, specifying the exogenous input as an equation 
“ex1 = input” will create input as a parameter; this allows for different studies to 
have different input values without having to go to the Exogenous Input dialog box 
first. The real reason why there needs to be an initial value at time zero is to prevent 
division by zero; this will be explained below. 

 
 
7. Create the zero-order input. 
 
 To create the zero order input, the parameter k(2,1) must be changed to zero order. To 

estimate the unknown time of the zero-order absorption, a Heaviside function must be 
created. 

 
a. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 

click Equations . The Equations dialog box will open. 
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b. Create the Heaviside function. In the Equations Defined Here pane, type  
 

“heaviside=0.5*(1+atan(lambda*(t-tlag))*2/3.141592653)” 
 

In this expression, for t less than the unknown parameter tlag, the value of the 
Heaviside function will be zero; otherwise it will equal 1. The parameter tlag will 
thus be the time when zero-order absorption stops. 
 

c. Create the zero-order absorption parameter. In the Equations Defined Here pane, 
type  

 
“k(2,1)=(1-heaviside)*ka/q1” 

 
This equation specifies k(2,1) as a zero-order parameter because of the division by 
q1. It is this division that requires q1 to have a value at time zero, otherwise you will 
receive a warning of division by zero. The absorption rate is the parameter ka. Up to 
time tlag, “1 – heaviside” will equal 1, and the zero-order absorptive process will 
occur. After time tlag, zero-order absorption will stop. 
 
The Equations dialog box should appear as follows: 

 

 
 
d. Close the Equations dialog box. 
 

8. Enter the parameter values as shown below: 
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Of the parameters, input is the known initial dose; it is fixed. k(0,2) is the unknown loss 
from Compartment 2. ka is the unknown zero-order absorption rate. lambda is the tuning 
parameter for the Heaviside function. tlag is the unknown duration of the zero-order 
absorption. The initial value of 100 is lower than the normally used 1.0e+06 for lambda. 
This value was picked by examining different values for lambda starting from 1.0e+06. 
Thus, choosing the initial value is also part of the tuning process. vol is the volume of 
Compartment 2. The volume is assumed to be known otherwise the amount of the zero-
order absorption could not be estimated (if both were allowed to adjust, you will find 
they are perfectly correlated.) 

 
9. Solve the model, and view and save the solution. A plot of s1 and plasma will appear as 

follows: 
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a. Close the Plot window. 
 
b. In the Compute menu, click Solutions. The Solutions dialog box will open.  
 
c. Click Add. The Solution Variables dialog box will open. Scroll through the 

variables and click s1. The two dialog boxes will appear as follows: 
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d. In the Solution Variables dialog box, click Done. 
 
e. Close the Solutions dialog box. 
 

Tuning lambda. The parameter lambda is “tuned” by changing its value until there are 
no longer any significant changes in the adjustable parameters and their error 
estimates. To tune lambda, one must start from the same set of initial parameter 
estimates. This solution has been saved as that starting point. For more information 
on saving and restoring solutions, see the Using SAAM II tutorial “Saving and 
Restoring Solutions.” 

 
 
10. Fit the model to the data, view and record the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, click 

Fit . The plot of s1:plasma will appear as shown below: 
 

 
 
b. In the Show menu, click Statistics, or alternatively on the SAAM II Toolbar click 

Statistics . The Statistics window will appear as follows: 
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c. Record the results as shown below: 
 

lambda 1.00E+02 1.00E+03
k(0,2) 0.203(0.52)
ka 302(0.90)
tlag 5.54(1.2)  

 
These are the values when lambda equals 100. The precision of all parameters is 
quite good. 

 
d. Close all open windows and dialog boxes. 
 

11. Restore the original solution, and refit the model to the data with lambda equal to 1000, 
and record the results. 

 
a. In the Compute menu, click Solutions. The Solutions dialog box will open. 
 
b. Click “1” in the Solutions pane. The Solutions dialog box will appear as follows: 
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Notice Restore Selected is now available. 
 
c. Click Restore Selected. The following message will appear: 
 

 
 
d. Click OK, and close the Solutions dialog box. 
 
e.  Re-Solve the model. The original solution is now restored. 
 
f. Change the value of lambda from 100 to 1000. The Parameters dialog box will 

appear as follows: 
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 Close the Parameters dialog box. 
 
g. Re-Fit the model to the data (you may have to click Fit twice), and record the results. 

The results should appear as follows: 
 

lambda 1.00E+02 1.00E+03
k(0,2) 0.203(0.52) 0.202(0.51)
ka 302(0.90) 302(0.89)
tlag 5.54(1.2) 5.53(0.2)  

 
You can see there are some small differences in the values depending upon lambda. 
For the parameters, they are in the third digit. You can repeat the above setting 
lambda equal to 10000 if you wish. The results should be as follows: 
 

lambda 1.00E+02 1.00E+03 1.00E+04
k(0,2) 0.203(0.52) 0.202(0.51) 0.202(0.51)
ka 302(0.90) 302(0.89) 302(0.89)
tlag 5.54(1.2) 5.53(0.2) 5.52(0.02)  

 
Now there are no differences in k(0,2) or ka; tlag is still fine-tuning slightly. If you 
wish, you can continue increasing lambda until there is no change in any of the 
parameters or their estimates; this should be the optimal value of lambda chosen. See 
below for more comments before increasing lambda. 
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h. Close all open windows and dialog boxes. 

 
The last value of lambda was 1.0e+04. If you increase lambda to 1.0e+05, you will not be able 
to fit the model to the data. Instead, you will receive the following message: 
 

 
 
When you are using the Heaviside function and this message appears, you need to change your 
computational settings. So far the default integrator and forward derivative methods have been 
used. You now need to try the Runge Kutta integrator and the central derivative method. In 
the Compute menu, open the Computational Settings dialog box and make these changes. The 
Computational Settings dialog box will appear as follows: 
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Click Done. You will now be able to fit the model to the data with lambda equal to 1.0e+05. 
Changing lambda to 1.0e+06 will yield no changes in the parameters or their error estimates. 
 
Thus for this problem, the above computational settings (i.e. Runge-Kutta integrator and the 
central derivative method) with lambda equal to 1.0e+05 is optimal. 
 
Repeating all of the above calculations using Runge-Kutta integrator and the central derivative 
method yields the following: 
 
 
 
 
 
 
 
Quit the SAAM II Compartmental application. You can save the study file if you wish.  This 
study file is provided as zero_order.stu with the initial parameter values. 

 

lambda 1.00E+02 1.00E+03 1.00E+04 1.00E+05 1.00E+06
k(0,2) 0.203(0.52) 0.202(0.51) 0.202(0.51) 0.202(0.51) 0.202(0.51)
ka 302(0.90) 302(0.89) 302(0.89) 302(0.89) 302(0.89)
tlag 5.55(0.56) 5.55(0.18) 5.55(0.08) 5.55(0.01) 5.55(0.01)
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Part 3. Creating a pump to maintain plasma concentration. 
 
There are several experimental protocols that use an infusion pump to maintain plasma 
concentration of a substance of interest at or near a specific level. The times at which the pump 
turns on or off are not known and need to be simulated. In this part, such a pump will be created 
and the results compared with a set of simulated data. 
 
In this experiment, a pump capable of infusing at a rate of 100 mg/hr of drug is used. The 
experiment lasts for 24 hours. The desired concentration is maintained at approximately 
0.06mg/ml. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Create the following system model: 
 

 
 
3. Create the experiment on the model.  
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. Set the experimental attributes as follows: 

 

 
 
b. Click Done. The Create Experiment dialog box will open. Click Create. The 

model will appear as follows: 
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4. Add the data to the model. 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. On the File menu, click Open. The file pump_1.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click pump_1.dat. The data in this file will appear in the Data window. The 

Data window should appear as follows: 
 

 
 
d. Close the Data window. 

 
5. Create a sample on Compartment q1, associated with “plasma” and edit the sample 

equation to read “s1=q1/vol”. The Sample Attributes dialog box should appear together 
with the model as follows: 
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Click Done. Notice that the circle at the top of the sample object is now filled as shown 
in the diagram below; this is because data are now associated with the sample. 

 
6. Create an input into Compartment q1. 
 

a. Create the input into Compartment q1. The model should appear as follows: 
 

 
 
b. Specify the input equation. 
 

(1) Double-click ex1 to open the Exogenous Input dialog box. 
 
(2) Select Equation as the input type. 
 
(3) Set the Start equal to 0 and Stop time equal to 24. 
 
(4) Write the input equation “ex1 = input”. Click Add. The Exogenous Input dialog 

box should appear as follows: 
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(4) Click Done. 

 

Exogenous input. In this case, the input is defined by the equation “ex1 = input.” The 
equation “input” will be defined using the Heaviside function which will be defined 
to turn on and off to maintain the plasma concentration of the drug at a specific level. 

 
 
7. Create the input equation. 
 
 The input equation “input” will be created using the Heaviside function, and will be 

defined to turn on or off depending upon whether s1, the plasma concentration, is below 
or above a certain set point, i.e. a concentration specified by the user. In this case, the set 
point concentration is 0.06 mg/ml. 

 
a. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 

click Equations . The Equations dialog box will open. 
 
b. Create the conditional expression to define the switch. In the Equations Defined 

Here pane, type: 
 

“condition=0.06-s1” 
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“condition” will be positive when s1 is less than 0.06, and will be negative when it is 
larger. This will be used as the switching mechanism in the Heaviside function. 

 
c. Create the Heaviside function. In the Equations Defined Here pane, type  
 

“heaviside=0.5*(1.0 + atan(lambda*condition)*2/3.141592653)” 
 

In this expression, when “condition” is negative, the value of the Heaviside function 
will be zero; otherwise it will equal 1. Values for s1 will thus oscillate around 0.06. 
 

d. Create the input equation. In the Equations Defined Here pane, type  
 

“input=heaviside*100” 
 

The infusion rate is 100mg/hr. When the value for the Heaviside function is 1, the 
infusion will be turned on; when it is zero, the infusion will be turned off. 
 
The Equations dialog box should appear as follows: 

 
 
e. Close the Equations dialog box. 
 

8. Enter the parameter values as shown below: 
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The parameters are those for the two-compartment model together with lambda, the 
“tuning” parameter for the Heaviside function. The initial value for lambda of 1.0e+08 
was determined by initial tuning starting from 1.0e+06. 

 
9. Solve the model and view the solution.  
 

a. Because the input will be turning off and on very rapidly, the Computational Settings 
are going to be changed as shown below: 
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The Min.Nr. of Calculation Intervals is set to the maximum so you can visualize as 
much as possible the changes in the input function and s1. The integrator will be 
changed to the Runge-Kutta (you should compare results using the Rosenbrock if you 
are interested). The Derivative calculation is changed to Central. 
 
When you have changed the settings, click Done. 
 
b. Solve the model and view the solution. A plot of s1 and plasma will appear as 

follows (the Y Axis maximum has been set equal to 0.075): 
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You can see the oscillations around 0.06. To visualize them better, change the 
Plot/Table Scale to a minimum and maximum respectively of 0.058 and 0.062. The 
plot will appear as follows: 
 

 
 
The rapidity of the oscillations indicates that you have to be very careful with the 
computational settings.  You should try different options to be sure the same result is 
returned. 
 
The plot of the input function “input” is shown below; again the rapidity of the input 
turning on and off is evident: 
 



Advanced Tutorials SAAM II v.2.1 Creating Conditionals 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Conditionals – 45 SAAM  II Version 2.1 

 
 
The calculation of the Heaviside function parallels that of the input function: 
 

 
 
Notice the infusion is on until just after 3 hours when the concentration reaches the 
critical level for the infusion to turn off for the first time. Thereafter it turns off and 
on rapidly. The “gaps” after 3 hours are due to an insufficient number of calculation 
points for plotting purposes. You can tell from the plot of s1 and plasma that the 
pump is still turning off and on. 

 
c. Close the Plot window and any remaining open dialog boxes. 

 
The purpose of this part of the tutorial was to simulate a pump that is rapidly turning off and on. 
If you try to fit the model to the data, you will have problems with optimization because this 
example is not intended to illustrate fitting such pump models to data (there are insufficient 
data). 
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Quit the SAAM II Compartmental application. You can save the study file if you wish. This 
file is provided.  pump_1.stu is the study file with the initial parameter values and 
computational settings. 
 
 
The above example dealt with introducing material into the system for the first time. What about 
the situation where material is already in the system. For example, suppose you wished to infuse 
glucose to maintain glucose slightly above some basal level? The discussion below is based on 
the study file pump_2.stu. If you wish to follow the discussion, you can open pump_2.stu and 
click on Experiment in the SAAM II Toolbox. 
 
The model of the experiment is shown in the figure below: 
 

 
 
This is a typical 3-compartment model to explain glucose kinetics. The values of the rate 
constants, shown in the figure, are also typical. 
 
Suppose you wanted to simulate a pump that elevates basal glucose concentration. Then you 
must first create the model of the experiment so that baseline conditions exist. This means you 
must specify masses in all compartments, and a rate of input that mirrors endogenous glucose 
production. 
 
Suppose the baseline concentration is 100mg/ml and plasma volume is 3000ml. Then the mass 
in Compartment 1, Q1, equals 300,000. Since k(0,1) equals 0.3, the loss flux is 
“k(0,1)*300000”, or 90,000. To maintain a constant mass in Compartment 1, therefore, you 
must specify a constant infusion of 90,000 during the experiment to simulate endogenous 
production. 
 
However there are masses to be described in Compartments 2 and 3. Knowing the mass in 
Compartment 1, these can easily be calculated since, for example, 
 

k(2,1)*Q1 = k(1,2)*Q2 
 
where Q1 and Q2 are respectively the masses in Compartments 1 and 2. Since the 
corresponding exchange rate constants are equal, the mass in Compartments 2 and 3 are also 
equal to 300,000. 
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How is this information specified? 
 
Double-click on ex2 to open the Exogenous Input dialog box associated with Compartment q2. 
It will appear as follows: 
 

 
 
Click Done. 
 
The bolus injection of 300,000 will ensure the proper mass in Compartment q2 at the start of the 
experiment. A parallel situation exists for Compartment q3. 
 
Now double-click ex1 to open the Exogenous Input dialog box associated with Compartment 
q1. It will appear as follows: 
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The first two inputs characterize the baseline state. Here the state variables (mass in the 
compartments) in the system, though dynamic in the sense that glucose is being metabolized, do 
not change. Input equals output. The bolus of 300,000 specifies the initial mass, and the infusion 
mimics endogenous glucose production. 
 
The last equation input specifies the pump. The pump will start at 30 minutes. Thus for the first 
30 minutes, the system will not change. With the pump turned on, the concentration in 
Compartment q1 will rise to a new set point, and be maintained at that set point. 
 
Click Done. 
 
The pump input rate has been set in a manner similar to the previous tutorial. Open the 
Equations dialog box; it will appear as follows: 
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In the Equations Defined Here pane, the first two equations specify the Heaviside function. 
The function is zero (h1 = 0) up to the time the pump starts at 30 minutes. It then equals: 
 

h1_set=0.5*(1.0+atan(lambda*(s1-s1_point))*2/3.141592653) 
 
Thus s1_point will be specified in the Parameters dialog box as the new concentration to be 
maintained. 
 
The last equation specifies the input rate. It will turn off and on according to the value of (1-h1). 
The magnitude,  rate, will be a parameter specified in the Parameters dialog box. 
 
Close the Equations dialog box. Changing the value of h1 from zero to h1_set is done using 
Change Conditions. In the SAAM II Toolbox, click Change Conditions. The Change 
Conditions dialog box will open as follows: 
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In the Equations dialog box, h1 was initially set equal to zero; here it changes to h1_set at 30 
minutes and maintains this value for the duration of the experiment. Click Done. 
 
Open the Parameters dialog box; it will appear as follows: 
 



Advanced Tutorials SAAM II v.2.1 Creating Conditionals 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Conditionals – 51 SAAM  II Version 2.1 

 
 
Since this exercise is a simulation, all parameters are fixed. Notice the value for s1_point is 102 
meaning the pump will only slightly elevate the baseline concentration. Click Done to close the 
Parameters dialog box, and open the Computational Settings dialog box. It will appear as 
follows: 
 



Advanced Tutorials SAAM II v.2.1 Creating Conditionals 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Conditionals – 52 SAAM  II Version 2.1 

 
 
The Minimum Number of Calculation Intervals is set to its maximum value of 500. The 
integrator is the Runge-Kutta, and the derivative calculations are done using the Central 
mechanism. Click Done. 
 
Solve the model and view the solution. A plot of s1 (with the minimum and maximum values 
respectively set at 98 and 103) will appear in linear mode as follows: 
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You can clearly see that the basal state is maintained for the first 30 minutes after which the 
pump takes over. You can also see the switching mechanism maintains the new concentration 
very close to the desired 102. The input function will appear as follows: 
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Notice that input has a value during the first 30 minutes equal to 6000 (rate). However, input is 
not “seen” until 30 minutes as specified in the Exogenous Input dialog box. You can see this 
by plotting ex1.infusion, the infusion rate specified: 
 

 
 

This is the actual infusion rate into Compartment q1. It equals the baseline up to time 30 after 
which time “input” is added to this baseline rate. 
 
This study file is worth experimenting with to understand the behavior of such pumps. The 
parameters to change, and to see how these changes affect the solution, are s1_point and rate. 
Depending upon the magnitude of the changes, you may have to adjust lambda. You may also 
have to change some computational settings the most likely of which is value of the integrator 
relative error (you may need to reduce it). 
 
Experimenting with this study file will give you a much better feeling to the strengths and 
limitations of trying to simulate pumps such as this. 
 
Quit the SAAM II Compartmental application. Do not save any changes you made to 
pump_2.stu 
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Working with Change Conditions 

 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to use Change Conditions in SAAM II. You will 
learn 
 

 How to create continuous changes in your model (Part 1) 
 How to create instantaneous changes at different times in your model (Part 2) 
 How to create instantaneous changes at an equal time interval in your model (Part 3) 

 
Files Required 
 

Study Files: The study files for this tutorial are 
 

cc_cont.stu 
cc_instInulin.stu 
cc_instLDL 
 

Data Files: The data files for this tutorial are: 
 

cc.cont.dat 
cc.instInulin.dat 
cc.instLD.dat 

 
These files are included as part of this tutorial.  
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Introduction 
 
This tutorial will show you how to use Change Conditions, a tool in the SAAM II Toolbox. 
Change conditions allow you to describe experimental perturbations in your model. There are 
two kinds of perturbations – continuous and instantaneous. 
 
An example of a continuous perturbation would be an experiment in which at some known time, 
something was done that altered the characteristics of the data. You might want to account for 
this by changing the value of one or more of your model parameters. The start would begin at 
some known time, and continue until the experiment ended, or another experimental 
perturbation occurred. 
 
An example of an instantaneous perturbation would be urine collections. In the urine collection, 
the container holding the urine would be emptied at the time specified, and the collection for the 
next period would begin. You can model this by including a compartment for individual urine 
samples, and “emptying” it at the end of the collection period. 
 
Two examples are presented. Inulin kinetics is a simpler model because inulin is represented by 
a single plasma compartment. The collections times, however, do not always coincide with a 
plasma measurement. LDL kinetics is a more complex model because plasma LDL exists in two 
plasma compartments. The collection times, however, are at 24 (daily) intervals. 
 
Operationally when SAAM II detects a Change Condition, integration (simulation) will stop. 
The change or changes specified will be made, and integration (simulation) or optimization 
(fitting) will start again. 
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Part 1. A continuous Change Condition 
 
The following study investigated the effect of total parenteral nutrition (TPN) on the kinetics of 
low density lipoprotein (LDL) metabolism. Radioiodinated LDL was injected at time zero, and 
on day 9, TPN was commenced. The experiment lasted 19 days. The question asked was the 
following: Which of the model parameters change as a result of the TPN? 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file cc_cont. 

 
a. The file cc_cont.stu should appear in the file list; if it does not, find the folder where 

you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

You may recognize this as the model used for study_0, the study file supplied with 
SAAM II. This is in fact the case. The data used for study_0 are the first 9 days of 
the data used in this part of the tutorial. 

 
 

3. View the model and the experiment on the model, and the parameters. 
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a. In the SAAM II Toolbox, click Experiment. The model of the experiment will 

appear on the Drawing Canvas as follows: 
 

 
 

b. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open, as shown below: 

 

 
 

These are the parameters for study_0. The question posed in this part of the tutorial 
is which of these parameters change following TPN starting on day 9. 

 
c. Close the Parameters dialog box. 
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4. View the plasma data. 
 

An important part of deciding how to deal with a continuous change is to look at the raw 
data to see if a change is obvious. 
 
a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is selected. 

 
b. Click plasma to move this to the Current Selection pane. 
 
c. Click Done. The plot of the plasma data will appear in semilog for as follows: 
 

 
 

You can see there appears to be a break in the curve at day 9. You can actually solve 
the model, and see how the model predicts the data. Fit the model to the data, and 
change the Plot/Table Variables to s1:plasma. You will obtain the following plot 
which only further supports a change at day 9: 
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d. Close the Plot window. 

 
5. Change the value of k(2,1) and k(0,1) from day 9 to 19. 
 

It is hypothesized that these two parameters change following TPN. Such a change will 
be done using continuous Change Conditions. 
 
You must first provide values for these parameters up to day 9, and then provide values 
following TPN on day 9. This will be done as described below. 
 
a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equations box, type the equation “k(0,1)=loss0_before”. The Loss Attributes 

dialog box will appear as follows: 
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c. Click Done. The parameter k(0,1) is now defined by the equation, and loss0_before 

will appear as a parameter in the Parameters dialog box. 
 
d. Double-click k(2,1) to open the Transfer Attributes dialog box. 
 
e. In the Equations box, type the equation “k(2,1)=loss2_before”. The Transfer 

Attributes dialog box will appear as follows: 
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f. Click Done. The parameter k(2,1) is now defined by the equation, and loss2_before 

will appear as a parameter in the Parameters dialog box. If you open the 
Parameters dialog box, it will appear as follows: 

 

 
Close the Parameters dialog box. 

 

 Transfer and Loss Attributes dialog boxes. When you open either of these boxes, 
they will appear as shown above. However, once you define a parameter by an 
equation, the lower pane will not appear if you open them again. For example, if you 
double-click k(0,1) to open the Loss Attributes dialog box, it will appear as follows: 
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g. In the SAAM II Toolbox, click Change Condition. The Change Conditions dialog 
box will open as follows: 

 

 
 

 Change Conditions dialog box. The Change Conditions dialog box contains the 
Duration pane where you set the Change Condition to be Continuous (default) or 
Instantaneous. You set the Start and Stop times in the boxes below this pane. If the 
Change Condition is Instantaneous, the First event, Interval, and Last Event 
boxes will be active. You define the change in the Equation box. 
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h. In the Start box, type “9”. 
 
i. In the Stop box, type “19”. 
 
j. In the Equation box, type “k(0,1)=loss0_after” 
 
k. Click Add. The Change Conditions dialog box will appear as follows: 
 

 
 
l. Edit the equation to read “k(2,1)=loss2_after” 
 
m. Click Add. The Change Conditions dialog box will appear as follows: 
 

 
 
n. Click Done. 
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 Using Change Conditions. While the above shows you how to change the value of 
one or more parameters, there are assumptions that must be made about the 
particular system being studied. In this case, the data are being analyzed using a 
constant coefficient model. The values of the two parameters k(0,1) and k(2,1) 
change instantaneously at day 9, and remain at the new value throughout the rest of 
the experiment. Is this realistic? That is, will the parameter values change that 
quickly? The assumption here is that, relative to the daily sampling, the change does 
occur that fast. 

 
 

6. Add parameter values to the model as shown in the Parameters dialog box below: 
 

 
 

Notice the presence now of the values for the loss0 (k(0,1)) and loss2 (k(2,1)) before 
and after the perturbation. All values are the same; they will change when you fit the 
model to the data. 
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7. Solve the model and view the solution. The Plot window will appear as follows: 
 

 
 
8. Fit the model to the data. The plot will be updated as follows: 
 

 
 
You can see that the parameter changes nicely describe the change starting at day 9. 

 
9. View the statistics. The Statistics window will appear as follows: 
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The statistics are reasonable except that loss2_after is not well defined, and hence its 
change is not supported by the data. Restore the initial values for the other parameters;  
Open the Change Conditions dialog box, and delete the change in k(2,1). 
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 Restore the initial values for the other parameters;  
 

 
 
 
 
 
Fit the model; the Compute Log Error will appear: 
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Modify the limits of loss2_before as shown below: 
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Solve the model; 
 

 
 
 
Fit the model; the fit will be essentially the same as that shown above.  
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The statistics will change as follows: 
 

 
 
 

 
 
These are better, so a change in the loss is supported by the plasma data. In the actual 
experiment, urine data were also collected. When these are incorporated into the model, 
the change in the return is supported by the data. 
 

Quit the SAAM II Compartmental application. Do not save the changes to cont_cc. 
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Part 2. An instantaneous Change Condition – inulin kinetics 
 
The following study investigated the metabolism of inulin. Inulin is known to be described by a 
three compartment model, and to be totally excreted in the urine. The experiment lasted 500 
minutes. Plasma concentration is mg/L and urine measurements are mg. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file cc_instInulin. 

 
a. The file cc_instInulin.stu should appear in the file list; if it does not, find the folder 

where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

The model is characterized by a central plasma compartment which exchanges with 
two peripheral compartments. Excretion in urine, Compartment 4, is from the plasma 
compartment, Compartment 1.  

 
3. View the model and the experiment on the model. In the SAAM II Toolbox, click 

Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 
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The plasma samples, s1, are the concentration of plasma inulin. Double-click s1 to view 
the Sample Attributes dialog box. The compartment for the individual urine samples is 
Compartment q4. The sample s2 links this compartment with the individual urine 
samples. Double-click s2 to view the Sample Attributes dialog box. 
 
The input is ex1. It is a bolus into plasma.  
 
The data to be analyzed are shown in the Data window below: 
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The data are entered in two segments, one for plasma and one for the individual urine 
samples. Notice that the urine collection times do not coincide with the time of plasma 
samples. 

 
4. Use Change Conditions to model the individual urine collections. 
 

a. In the SAAM II Toolbox, click Change Condition. The Change Conditions dialog 
box will open as shown below: 
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 Change Conditions dialog box. The Change Conditions dialog box contains the 
Duration pane. The Duration pane is where you set the Change Condition to be 
Continuous (default) or Instantaneous. You set the Start and Stop times in the 
boxes below this pane. If the Change Condition is Instantaneous, the First event, 
Interval, and Last Event boxes will be active. You define the change in the 
Equation box. 

 
 
b. In the Duration pane, select Instantaneous. The Change Conditions dialog box 

will appear as follows: 
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c. In the First event box, type “92.001”. 
 
d. In the Equation box, type “q4=0”. 
 
e. Click Add. The Change Conditions dialog box will appear as follows: 
 

 
 
f. In the First Event box, type “183.001”, and click Add. 
 
g. In the First Event box, type “285.001”, and click Add. 
 
h. In the First Event box, type “390.001”, and click Add. 
 
i. In the First Event box, type “490.001”, and click Add. The Change Conditions 

dialog box will appear as follows: 

 
 
j.  Click Done. 



Advanced Tutorials SAAM II v.2.1 Working with Change Conditions 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Change Conditions – 23 SAAM  II Version 2.1 

 

 Instantaneous Change Conditions. Why do we enter the first event at 92.001? The 
reason is that the urine collections last for 92 hours. The container is emptied after 
the volume and concentration of inulin are made. Thus the actual event of emptying 
the container takes place slightly after the actual sample. Adding 0.001 to the time 
will accommodate this. The equation “q4 = 0” will resent the value of Compartment 
q4 equal to zero at the specified time point. SAAM II will stop integration at, for 
example, 92.001, reset q4 equal to zero, and continue integrating. 

 
 

5. View the model parameters. The parameters have been entered as part of the study file. 
The Parameters dialog box is shown below: 

 

 
 

 
6. Solve the model, and view the solution. The plot of s1:Plasma will appear as follows (in 

semi-log mode): 
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Notice the first datum and the datum at 420 are unweighted as indicated by the red x 
through them. The plot of s2:Urine will appear as follows: 
 

 
 

 Viewing the individual urine samples. In viewing the individual urine samples, you 
can clearly see the effect of resetting q4 equal to zero; this is produces the saw-tooth 
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curve. It is also important to note in these situations it is best to reset the Minimum 
Number of Computation Intervals equal to 200 to improve the resolution of the 
plot. This has been done in the study file. On the Compute menu, if you click 
Settings, the Computational Settings dialog box will open. You can see that the 
Minimum Number of Computation Intervals is set equal to 200. If you reduce this 
and resolve the model, you will loose some of the resolution of the plot. 

 
 

Leave the above plot of s2:Urine open. 
 

7. Fit the model to the data, and view the solution. 
 

a. The plot of s2:Urine will be updated as follows: 
 

 
 

In the linear mode, the plot will appear (the Y Axis minimum should be set equal to 
zero to 4200): 
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Here you can see that q4 has been reset to zero at the appropriate times.  
 

b. Plot s1:Plasma. The plot in semilog will appear as follows (the Y Axis scale should 
be set to autoscale): 

 

 
 

You can see that the model describes the data reasonably well. 
 
Close the Plot window. 
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c. View the statistics. The Statistics window will appear as follows: 
 

 
 
The statistical information supports the model quite well also. 
 
Close the Statistics window. 
 

Quit the SAAM II Compartmental application. Do not save the changes to cc_instInulin. 
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Part 3. An instantaneous Change Condition – LDL kinetics 
 
The following study investigated the metabolism of low density lipoproteins (LDL). 
Radioiodinated LDL was injected, and plasma and urinary radioactivity was determined. 24 
hour urine collections were made. This part of the tutorial will show you have to model such 
collections using instantaneous change conditions. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file cc_instLDL. 

 
a. The file cc_instLDL.stu should appear in the file list; if it does not, find the folder 

where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

The model is characterized by two plasma pools representing two kinetically distinct 
subpopulations of LDL particles. Radioiodide leaves the LDL during the metabolic 
process and enters the total body iodide pool. It is excreted there into the urine. 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 

Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 

 

 
 

The plasma samples, s1, are a sum of the radioactivity in the two plasma compartments, 
q1 and q2, divided by the plasma volume. Double-click s1 to view the Sample 
Attributes dialog box. The compartment for the individual urine samples is 
Compartment q23. The sample s2 links this compartment with the individual urine 
samples. Double-click s2 to view the Sample Attributes dialog box. 
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The input ex1 is a split input. This is because the radiolabeled LDL is split between the 
two subpopulations of LDL represented by Compartments q1 and q2. Double-click ex1 
to open the Exogenous Input dialog box. Then click Split Input; the two dialog boxes 
will appear as follows: 
 

 
 
The parameter frac will split the bolus dose between Compartments q1 and q2. For more 
information on split inputs, see the Using SAAM II (Advanced) tutorial “Working with 
Experimental Inputs”.  
 
Close the two dialog boxes. 
 
The data to be analyzed are shown in the Data window below: 
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The two columns of data are the plasma and the individual urine samples. The initial 
data were recorded in hours instead of days. The line in the data file 
 

“(/24) () ()” 
 
divides all samples up to 12 hours by 24 converting them to days. The line in the data 
file 
 

()  ()  () 
 
will stop the division by 24. The entries “n” in the “ind_urine” column means there are 
no urine data collected at these times. 

 
4. Use Change Conditions to model the 24 hour urine collections. 
 

a. In the SAAM II Toolbox, click Change Condition. The Change Conditions dialog 
box will open as shown below: 
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 Change Conditions dialog box. The Change Conditions dialog box contains the 
Duration pane. The Duration pane is where you set the Change Condition to be 
Continuous (default) or Instantaneous. You set the Start and Stop times in the 
boxes below this pane. If the Change Condition is Instantaneous, the First event, 
Interval, and Last Event boxes will be active. You define the change in the 
Equation box. 

 
 
b. In the Duration pane, select Instantaneous. The Change Conditions dialog box 

will appear as follows: 
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c. In the First event box, type “1.001”. 
 
d. In the Interval box, type “1”. 
 
e. In the Last Event box, type “13.001”. 
 
f. In the Equation box, type “q23=0”. 
 
g. Click Add. The Change Conditions dialog box will appear as follows: 
 

 
 
h.  Click Done. 
 

 Instantaneous Change Conditions. Why do we enter the first event at 1.001? The 
reason is that the urine collections last for 24 hours, 1 day. The container is emptied 
after the volume and concentration of radioactivity are measured. Thus the actual 
event of emptying the container takes place slightly after the actual sample. Adding 
0.001 to each day will accommodate this. The equation “q23 = 0” will reset the value 
of Compartment q23 equal to zero at the specified time point. SAAM II will stop 
integration at, for example, 1.001, reset q23 equal to zero, and continue integrating. 

 
 

5. View the model parameters. The parameters have been entered as part of the study file. 
The Parameters dialog box is shown below: 
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Of note in the Parameters dialog box is the fact that frac, the parameter that distributes 
the initial dose between the two plasma compartments, lies between 0.1 and 0.9; this 
parameter cannot be less than zero nor greater than 1. The parameter k(23,13) is fixed 
equal to 2.5. This is the fractional excretion rate from the body iodide pool, 
Compartment q13; this parameter cannot be determined from the data, and is taken from 
the literature where it is known that the total body iodide pool turns over at 
approximately 2.5/day. 

 
6. Solve the model, and view the solution. The plot of s1:plasma will appear as follows (in 

semi-log mode): 
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The plot of s2:ind_urine will appear as follows (the Y Axis scale has been set with 
10000 and 2.0e+07 as the minimum and maximum respectively): 
 

 
 

 Viewing the individual urine samples. In viewing the individual urine samples, you 
can clearly see the effect of resetting q23 equal to zero; this is what produces the 
saw-tooth curve. It is also important to note in these situations it is best to reset the 
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Minimum Number of Computation Intervals equal to 200 to improve the 
resolution of the plot. This has been done in the study file. On the Compute menu, if 
you click Settings, the Computational Settings dialog box will open. You can see 
that the Minimum Number of Computation Intervals is set equal to 200. If you 
reduce this and resolve the model, you will loose the resolution of the plot. 

 
 

Leave the above plot of s2:ind_urine open. 
 

7. Fit the model to the data, and view the solution. 
 

a. The plot of s2:ind_urine will be updated as follows: 
 

 
 

In the linear mode, the plot will appear (the Y Axis minimum has been set equal to 
zero): 
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Here you can see that q23 has been reset to zero at the appropriate times.  
 

b. Plot s1:plasma. The plot will appear as follows (the Y Axis scale has been set to 
autoscale): 

 

 
 

You can see that the model describes the data quite well. 
 
Close the Plot window. 
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c. View the statistics. The Statistics window will appear as follows: 
 

 
 
The statistical information supports the model quite well also. 
 
Close the Statistics window. 
 

Quit the SAAM II Compartmental application. Do not save the changes to cc_instLDL. 
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Working with Delays 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” It is recommended that you 
have worked through the SAAM II tutorial “Saving and Restoring Solutions.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to how to create delays in your compartment 
model. You will learn 
 

 How to use the Delay tool in the Model Toolbox to create a delay (Part 1). 
 How to use the Delay tool in the Model Toolbox to create a delay with split output (Part 2). 
 How to create absolute delays (Part 3) 

 
Files Required 
 

Study Files: The study files for this tutorial are 
 

delay1.stu 
delay2.stu 
delay3.stu 

 
These file are included as part of this tutorial for convenience; you will actually create 
these study files as part of the tutorial.  
 
Data files: The data files for this tutorial are 
 

delay1.dat 
delay3.dat 

 
 

Introduction 
 
This tutorial focuses on how to create delays in your compartment model. In the SAAM II 
Compartmental application, there are two ways delays can be created. One way is to use the 
Delay tool in the SAAM II Toolbox. The other way is to use a mathematical function called the 
Heaviside function. The latter is an advanced modeling technique that should be used only in 
specific instances when a nearly absolute delay is required; it is discussed in Part 3. 
 
The Delay tool in the SAAM II Compartmental application creates delays automatically as a 
series of compartments. The larger the number of compartments specified for the delay in the 
Delay Attributes dialog box, the closer the delay will be to a true (absolute) delay, but the 
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longer the computation time may be. The number of compartments in the delay is set by the 
user. The delay time can be either fixed, when the attributes associated with the delay are 
defined, or can be defined as a parameter that can be either fixed or adjustable.  
 
Delays are usually required to describe physiological processes such as absorption, uptake 
across cell membranes, or amino acid incorporation into proteins. The situation can be 
represented schematically as follows: 
 

 
 
 
 
 
 
 
 
 
There is an input “upstream” from where the experimental samples are taken. The delay is 
required when there is an actual delay in the appearance of the test substance in the 
compartment from which samples are taken. The delay usually represents a composite of 
metabolic activity, the details of which cannot be described from the actual data. This is why, in 
most instances, delays represented by a series of compartments is appropriate. 
 
The situation above is one where the delay is between the input and the sample site. There are 
instances where material from the delay may actually pass to several compartments. An 
example would be the measurement of amino acid incorporation into several proteins. The 
situation for two outputs can be diagrammed as follows: 
 

delay

input

sample

sample

 
 
In this case, information on the split output must be provided; this is discussed in Part 2. 
 
Delays implemented by a string of compartments actually represent a transfer function 
corresponding to a probability distribution function. The distribution function has a mean and a 
variance (standard deviation). The mean is the delay time, and the standard deviation is the 
delay width which is a measure of the “sharpness” of the delay. The transfer rate constant 
between compartments in the delay equals the number of compartments in the delay divided by 
the delay time. 

delay

input sample
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What does this mean? The Delay Attributes dialog box associated with a delay in SAAM II 
appears as follows: 
 

 
 
In this case, the delay number is “3”. The default values for the delay time and the number of 
compartments in the delay are 1.0 and 2 respectively. Normally, as illustrated in this tutorial, the 
delay time is set equal to a parameter. 
 
Consider the following example: 
 

 
 
This could illustrate the first steps of absorption where Compartment 1 could be the stomach 
and Delay 2 could be the gut. If the number of compartments in the delay were set equal to 5, 
internally the model would appear: 
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while if the number were set equal to 10, the model internally would appear: 
 

 
What is the difference, and what is the relationship between the delay time specified as part of 
the delay attribute, and the actual delay time that is desired? That is, the “delay time” as the 
transfer function mean, and the “delay time” actually required by the data may be different. This 
is a function of how a delay as a string of compartments works. 
 
Consider an experiment on these two models where a bolus of “100” is given respectively into 
Compartments 1 and 11. Suppose k(2,1)=k(12,11)=0.05, and the delay time is 150. Then for a 
the five compartment delay, the transfer rate constant equals 5/150, or .033 while for the 10 
compartment delay, this is 10/150, or .0667. This is shown in the following figure: 
 

 
 
 
The actual delay is created by the material leaving the last compartment in the delay, q6 and 
q21 respectively. 
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For the five compartment delay, s1 is the total mass in the delay as a function of time while s2 is 
the amount in Compartment q6; it is this amount that will appear in the next compartment of 
interest in your model. A plot of the two is shown in the following figure: 
 

 
 
You can see that s1 has a slightly skewed distribution with a mean around 150. You can also see 
that material starts to appear from Compartment q6 (measured by s2) at around 30 minutes. 
Thus the “physiological” delay is about 30 minutes. The counterparts for the 10 compartment 
delay are shown in the following figure: 
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You can see the mean of the delay is again at 150, but now the width is smaller (as shown in the 
following figure). Material starts to appear from the last compartment in the delay (s4) at about 
50 minutes. 
 
Comparing the mass in the delay: 
 

Simone
Sticky Note
magnitude is also halved
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The 10 compartment delay, s3, has a slightly narrower distribution. Of interest is the effect on 
the “physiological” delay as shown in the following figure: 
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The difference in the appearance of material from the last compartment in the delay between the 
5 and 10 compartment delay is quite dramatic. 
 
In this tutorial, you will explore these phenomena in more detail so that you can better 
appreciate the nature of a string of compartments as a delay tool, and know better how to select 
the number of compartments. 
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Part 1. Working with the delay tool – Single output from the delay 
 
In this part of the tutorial, you will create and work with the following model: 
 

 
 
In the model shown above, Compartment 1 represents plasma and Compartment 2 represents an 
extra-plasma compartment. Thus, the “system” model, from the point of how the substance is 
metabolized in the body, is represented by these two compartments. Compartment 3 is the 
compartment into which the test substance, for example a drug, is administered. If the 
administration of the drug is oral, Compartment 3 can represent the first part of the 
gastrointestinal system. The Delay 4 represents passage and absorption of the drug through the 
gut. Since there is no loss from either Compartment 3 or Delay 4, it is assumed that the drug is 
completely absorbed (100% absorption). 
 
1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 

window will open. 
 

2. Create the model. 
 
a. Create the following part of the model. 
 

 
 
b. Add the delay and transfer from the delay to Compartment 1. 
 

(1) In the SAAM II Toolbox, click Delay. 
 
(2) Click on the Drawing Canvas where you would like the delay to be located.  
 
(3) In the SAAM II Toolbox, click Flux 
 (4) Click on Delay 3 and then Compartment 1; the transfer d(1,3) will be created. 

Your model will appear as follows: 
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Transfers from delays. Transfers from delays are denoted by “d(i,j)” instead of “k(i,j)”. 
The reason is that all material entering the delay eventually will leave the delay. 
Thus the d(i,j) represents a fraction of material moving along this pathway. In the 
model shown above, d(1,3) equals “1” because this is the only route by which 
material can leave the delay. If there were, for example, two routes by which 
material could leave the delay (as illustrated below in Part 2), the two d(i,j) would be 
numbers between 0 and 1, but the sum of the two would equal 1. An actual rate 
constant k(1,3) will be calculated internally by SAAM II; this value is available as 
output following a Solve or Fit. The value is the sum of the rate constants connecting 
the compartments in the chain representing the delay. 

 
 

c. Change the number of the delay from “3” to “4”. 
 

(1) Double-click Delay 3 to open the Delay Attributes dialog box. The dialog box 
will appear as follows: 

 

 
 
(2) Change the Delay Number from “3” to “4”. 
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(3) Click Done. Your model will appear as follows: 
 

 
 

d. Add Compartment 3 and transfer k(4,3) to your model. 
 
(1) In the SAAM II Toolbox, click Compartment. 
 
(2) Click on the Drawing Canvas where you would like Compartment 3 located. 
 
(3) In the SAAM II Toolbox, click Flux. 
 
(4) Click on Compartment 3 and then Delay 4. The transfer k(4,3) will be added to 

your model which should appear as follows: 
 

 
 

 
3. Create the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours”. 
 
c. Type “60” in the End At box. The Experiment Attributes dialog box will appear as 

follows: 

 



Advanced Tutorials SAAM II v.2.1 Working with Delays 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Delays – 12 SAAM  II Version 2.1 

 
d. Click Done. The Create Experiment dialog box will open as shown below: 
 

 
 

Be sure Experiment is selected (as indicated by “Exper” in the New Name box). 
 
e. Click Create. Your model will appear as follows: 
 

 
 

4. Add the data to the model 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. On the File menu, click Open. The file delay1.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click delay1.dat. The data in this file will appear in the Data window as 

shown below: 
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d. Close the Data window. 

 
5. Create the input and sample 
 

a. In the SAAM II Toolbox, click Input. 
 
b. On the Drawing Canvas, click Compartment q3, and then click on the canvas. The 

input ex1 will appear associated with your model. 
 
c. Double-click ex1. The Exogenous Input dialog box will open.  
 
d. Type “400” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows: 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Sample. 
 
h. On the Drawing Canvas, click Compartment q1, and then click on the canvas. The 

sample s1 will appear associated with your model. 
 
i. On the Drawing Canvas, double-click s1 to open the Sample Attributes dialog 

box. 
 
j. Type “conc” in the Associate with Data Name box. 
 
k. Edit the sample equation to read “s1=q1/Vc” in the Equation box. The Sample 

Attributes dialog box will appear as follows: 
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l. Click Done. 
 

6. Enter the parameter values as shown below: 
 

 
 
 
 
 
7. Work with the delay tool 
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At this point, your model is specified except for information about the delay. 
Information about the delay is specified in the Delay Attributes dialog box which is 
accessible only in the Model mode. 
 
The Delay Attributes dialog box is shown below: 
 

 
 
The boxes in which information can be entered are: 

 
Delay Number: Here you can specify the number you want associated with the delay. 
 
Reference Name: You may add a reference name if you wish; this will appear 

associated with the delay in the same manner reference names appear with 
compartments. 

 
Delay Time: The delay time can be specified here numerically if you know the exact 

time of the delay. It can also be specified as a parameter. For example, if you 
changed “1.0000000” to “deltime”, deltime (delay time) would be interpreted by 
SAAM II as a parameter which would appear when you open the Parameters dialog 
box. 

 
Number of Compartments: You can specify the number of compartments in the delay. 

The more compartments in the delay, the “sharper” the delay, but the more time it 
will take to solve your model. 

 
Fractional Distribution: When there is only one pathway leaving the delay, this box is 

dimmed. If there is more than one pathway leaving the delay, the fractional delay is 
active. As described in Part 2, you must specify the characteristics of the split delay 
if there is more than one pathway leaving the delay. 
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Technical information about delays. The delay represents a transfer function 
corresponding to a probability distribution; the distribution has a mean and variance 
(standard deviation). 

 
The mean is the delay time and the standard deviation is the delay width (measure of 
the sharpness of the delay). 
 
The transfer coefficient equals the number of compartments in the delay divided by 
the delay time. In the above example, this is “2” divided by “1” which equals “2”. 
Thus the transfer coefficient is reported as “2”  
 
The delay width equals the square root of the delay time divided by the transfer 
coefficient. In the above example, this is the square root of ½ which equals 
0.70710678. 

 
a. Set the time of the delay equal to a parameter. 
 
 This tutorial will not work with delays where the exact time value is known. If this 

were the case, simply enter the time of the delay in the Delay Time box, and enter 
the number of compartments in the delay in the Number of compartments box. 

 
(1) In the SAAM II Toolbox, click Model to activate the Model tools. 
 
(2) Double-click Delay 4 to open the Delay Attributes dialog box. 
 
(3) Change “1.0000000” to “tlag” in the Delay Time box. The Delay Attributes 

dialog box will appear as follows: 
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(4) Click Done. 
 

The delay attributes dialog box. Remember the Delay Attributes dialog box can be 
opened only when you are in the Model mode. If you are in the Experiment mode 
and double-click on a delay, the following message will appear on the Drawing 
Canvas: 

 

 
 

Click OK, and return to the Model mode. 

 
 

The delay time as a parameter. When you change the time of the delay from a number 
to a name, the name will appear as a parameter. In this case, tlag will appear when 
you open the Parameters dialog box. The time of a delay can be either a fixed or an 
adjustable parameter. 

 
 

b. Work with the delay time. 
 

In this part of the tutorial, three simulations will be run using different times for the 
delay. Remember the number of compartments in the delay is set at the default value 
“2”. Each simulation will be saved, and a final plot comparing the three will be 
created. 
 
(1) In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 
(2) Double-click tlag to select it. Type “1” in the value box, and click Save. The 

Parameters dialog box will appear as follows: 
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(3) Click Done. 
 
(4) In the Compute menu, click Settings. The Computational Settings dialog box 

will open. In the Min. Nr. of Calculation Intervals box, change “20” to “200”. 
The Computational Settings dialog box will appear as follows: 
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Click Done. (Remember increasing the calculation intervals will give better 
resolution to the plots). 

 
(5) In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, 

click Solve . 
 
(6) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click 

Plot . The Plot and Table Variables dialog box will open. Be sure the List 
All Variables check box is selected. 

 
(7) Click s1 to move this to the Current Selection pane. 
 
(8) Click Done. The plot will appear as follows (the maximum for the Y Scale has 

been set equal to “12”) 
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(9) In the Compute menu click solutions. The Solutions dialog box will open. Click 

Add. The Solutions Variables dialog box will open. Scroll through the list, and 
select s1. The two dialog boxes will appear as follows: 
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Click Done. The Solutions dialog box will appear as follows: 
 

 
 

Close the Solutions dialog box. 
 
(10) Set tlag equal to “10”. Set the Upper Limit for tlag equal to “50”. Repeat the 

above steps saving the solution as solution number “2”. The plot will appear as 
follows: 
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Notice the peak is not as high as when the delay was equal to “1”. This is due to 
a combination of only two compartments in the delay, and the length of the 
delay time. 

 
(10) Set tlag equal to “20”, and repeat the above steps saving the solution as solution 

number “3”. The plot will appear as follows: 
 

 
 
(11) Plot all three simulations simultaneously. With the plot window open, in the Set 

menu, click Plot/Tables Variables; click the select variables button ; or 
right-click in the plot window and select variables. The Plot and Table 
Variables dialog box will open. Be sure the List All Variables check box is 
selected. Select s1{1}, s1{2} and s1; the Plot and Table Variables dialog box 
will appear as follows: 
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Click Done. The plot will appear as follows: 
 

 
 

Close the Plot window. 
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The delay time. For a given number of compartments in the delay, the longer the delay 
time, the less “pronounced” the delay will be. This is the result of the way the 
transfer between compartments in the delay is calculated.  

 
The transfer coefficient equals the number of compartments in the delay divided by 
the delay time. In the above example, this is “2” divided by “1”, “10” and “20” 
which equals “2”, “0.2” and “0.01” respectively. The material is slower passing 
through the delay as the delay time increases. 
 
The delay width equals the square root of the delay time divided by the transfer 
coefficient. This also increases as the delay time increases. 

 
c. Work with the number of compartments in the delay. 
 

In this part of the tutorial, the effect of the number of compartments in the delay will 
be investigated. Remember the number of compartments in the delay equals “2”. 
Leave all parameters as set previously; leave tlag equal to “20”. The Parameters 
dialog box should appear as follows: 
 

 
 

Jake Kraft


Jake Kraft


Jake Kraft


Jake Kraft
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(1) In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, 
click Solve . 

 
(2) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click 

Plot . The Plot and Table Variables dialog box will open. Be sure the List 
All Variables check box is selected. 

 
(3) Click s1 to move this to the Current Selection pane. 
 
(4) Click Done. The plot will appear as follows (remember the maximum for the Y 

Scale has been set equal to “12”) 
 

 
 
(5) In the Compute menu click solutions. The Solutions dialog box will open. Click 

Add. The Solutions Variables dialog box will open. Scroll through the list, and 
select s1. The two dialog boxes will appear as follows (remember you already 
have saved solutions – this will be solution “3”): 

 



Advanced Tutorials SAAM II v.2.1 Working with Delays 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Delays – 27 SAAM  II Version 2.1 

 
 

Click Done. The Solutions dialog box will appear as follows: 
 

 
 

Close the Solutions dialog box. 
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(7) In the SAAM II Toolbox, click Model to return to the Model mode.  
 
(8) Double-click Delay 4 to open the Delay Attributes dialog box. Change the 

number of compartments in the delay from “2” to “5”. The Delay Attributes 
dialog box will appear as follows: 

 

 
 

Click Done. 
 
(9) Solve the model and view the solution. The plot will appear as follows: 
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(10) Save s1 as solution “4”. 
 
(11) Set the number of compartments in the delay equal to “10”. Solve the model, 

view the solution, and save the solution as solution “5”. The plot will appear as 
follows: 

 
 

(12) Repeat the previous step with the number of compartments in the delay set equal 
to “20”. The plot will appear as follows: 
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(13) Compare all four simulations. With the Plot window open, in the Set menu, 
click Plot/Tables Variables. In the Plot and Table Variables dialog box, 
select s1{3}, s1{4}, s1{5} and s1. The Plot and Table Variables dialog box will 
appear as follows: 

 

 
 

Click Done. The plot will appear as follows: 
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The number of compartments in a delay. For a given delay time, the more 
compartments in the delay, the “sharper” the delay will become. This is the result of 
the way the transfer between compartments in the delay is calculated.  

 
The transfer coefficient equals the number of compartments in the delay divided by 
the delay time. In the above example, this is “2”, “5”, “10” and “20” divided by 
“20”. The material is faster passing through each compartment in the delay as the as 
the number of compartments increases. 

 
 
d. Solve the model, and fit the model to the data. 
 

(1) Set the value for tlag equal to “1” with a minimum and maximum respectively 
equal to “0.1” and “10”. 

 
(2) Set the number of compartments in the delay equal to “5”. 
 
(3) Solve the model, and view the solution. The plot will appear as follows (the Y 

Scale maximum has been set equal to “20”): 
 

 
 
(4) In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar click 

Fit . The plot will be updated as follows: 
 

Jake Kraft
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(5) View the details of the initial rise and fall. In the Set menu, click Plot/Table 

Scale. The Plot and Table Scale dialog box will open. Set the X Axis maximum 
equal to “5”. The Plot and Table Scale dialog box will appear as follows: 

 

 
 

Click Done. The plot will appear as follows: 
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You can see the effect of the delay in the initial portion of the curve. What is the 
effect of the number of compartments in the delay in this situation? If you 
increase the number of compartments to “20”, the plot will appear as follows: 
 

 
 

The value for tlag is approximately 0.3, so you can see with the number of 
compartments equal to 20, the delay is approaching an absolute delay. 
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(6) View the statistics. In the Show menu, click Statistics, or alternatively on the 

SAAM II Toolbar click Statistics . The Statistics window for the 5 delay 
compartment model will appear as follows: 

 

 
 
Scrolling to reveal all of the values: 

 
 

The statistics for the model and data are satisfactory since the largest coefficient 
of variation is just under 25%. Notice, however, the derived variable k(1,4). 
There is no k(1,4) in the model; there is a d(1,4) for the delay. The value for 
k(1,4) is the value for the rate constants in the delay, and equal to the transfer rate 
constant from the last compartment in the delay to Compartment 1. 
 
It should be noted that the statistics will change a little if you change the number 
of compartments in the delay. The largest change will normally be in k(1,4) 
whose numerical value is a function of the number of compartments in the delay. 
 

How many compartments in a delay. The number of compartments in a delay is an 
integer, and cannot be specified as an adjustable parameter. The number of 
compartments is set by the user, and can be determined by simulating which number 
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provides the most reasonable description of the data. You need to be sure that the 
number of compartments in the delay does not have a substantial effect on the model 
parameters. For example, in the above if the number of compartments in the delay is 
set at “20”, the statistical information is: 

 

 
 

Scrolling to reveal all of the values: 

 
 

You can see there is essentially no difference except in the value of k(1,4) which, 
because the number of compartments is different, should be different. 

 
 

(7) Close all open windows and dialog boxes.  
 
(8) Quit the SAAM II Compartmental application. You may save the study file if 

you wish. Note that it is provided as part of this tutorial as delay1.stu. 
 

A Note about Solution Names: 
Although the Solution # tacked onto the name prefix cannot be controlled, the user can specify 
the Name Prefix each time a solution is saved.  An illustration of this use: In the previous 
example, the Solution names could have been specified as Lag1_1, Lag10_1, Lag20_1, C5_1, 
C10_1, C20_1, and the last two solutions could have been saved as FitC5_1 and FitC20_1. 
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Part 2. Working with the delay tool – Split output from the delay 
 
This part of the tutorial assumes you have worked through Part 1, and hence are familiar with 
the role of delay time and the number of compartments in the delay.  
 
In this part of the tutorial, you will create and work with the following model: 
 

 
 

In the model shown above, Compartments 1 and 2 represent two distinct plasma compartments 
of the test substance introduced into the system. Thus, the “system” model, from the point of 
how the substance is metabolized in the body, is represented by these two compartments. 
Compartment 3 is the compartment into which the test substance, for example a drug, is 
administered. If the administration of the drug is oral, Compartment 3 can represent the first part 
of the gastrointestinal system. The Delay 4 represents passage and absorption of the drug 
through the gut. Since there is no loss from either Compartment 3 or Delay 4, it is assumed that 
the drug is completely absorbed (100% absorption). The two plasma compartments in this 
situation could be interpreted as a drug and a metabolite of the drug where conversion takes 
place during the absorptive process. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Create the Model shown above. 
 
3. Double-click Delay 4 to open the Delay Attributes dialog box. The Delay Attributes 

dialog box will open as follows: 
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Notice unlike the situation in Part 1, the Fractional Distribution check box is active. 
This is because there are two outputs from Delay 4. 

 
4. Set the Delay Attributes. 
 

a. Change the Delay Time from “1.000000” to “timelag”; timelag will become a model 
parameter. 

 
b. Change the Number of compartments from “2” to “10”. 
 
c. Click the Fractional Distribution check box. The Delay Fractional Distribution 

dialog box will open as shown below: 
 

 
 

Edit the equation “d(1,4) = 1.0-d(2,4)” to read “d(1,4) = frac”. Edit the equation 
“d(2,4)=d(1,4)” to read “d(2,4)=1-frac”. The Delay Fractional Distribution dialog 
box and the Delay Attributes dialog box will appear as follows: 
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d. Click Done in the Delay Fractional Distribution dialog box, and then click Done in 
the Delay Attributes dialog box. 

 

Fractional distribution from a delay. When there is more than one loss from a delay, 
you must specify the fractional distribution along each loss pathway. It is essential to 
remember that the total fractional loss must equal 1. Thus when you specify the 
fractional distribution, you must be sure the total equals 1. In the situation here, 
d(2,4) is defined as a parameter frac; this parameter will appear in the Parameters 
dialog box. The equation “d(1,4) = 1.0 – d(2,4)” will define d(1,4) in such a way that 
“d(1,4) + d(2,4) = 1.” With two losses from a delay, making sure the sum of the 
fractional output equals “1” is easy; with more than two losses, it requires more 
bookkeeping. 

 
 

5. Create the Experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours”. 
 
c. Type “60” in the End At box. The Experiment Attributes dialog box will appear as 

follows: 
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d. Click Done. The Create Experiment dialog box will open as shown below: 
 

 
 

Be sure Experiment is selected (as indicated by “Exper” in the New Name box). 
 
e. Click Create.  

 
6. Add the Data to the model 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. On the File menu, click Open. The file delay1.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click delay1.dat. The data in this file will appear in the Data window as 

shown below: 
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d. Close the Data window. 

 
7. Create the Input and Sample in the Experiment window. 
 

a. In the SAAM II Toolbox, click Input. 
 
b. On the Drawing Canvas, click Compartment q3, and then click on the canvas. The 

input ex1 will appear associated with your model. 
 
c. Double-click ex1. The Exogenous Input dialog box will open.  
 
d. Type “400” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows: 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Sample. 
 
h. On the Drawing Canvas, click Compartments q1 and q2, and then click on the 

canvas. The sample s1 will appear associated with your model. 
 
i. On the Drawing Canvas, double-click s1 to open the Sample Attributes dialog 

box. 
 
j. Type “conc” in the Associate with Data Name box. 
 
k. Edit the sample equation to read “s1=(q1+q2)/Vc” in the Equation box. The Sample 

Attributes dialog box will appear as follows: 
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 Click Done. The model will appear as follows: 
 

 
 

8. Check the Computational Settings; the Minimum Number of Calculations Intervals 
should be at least 200 and the Minimum Number of Fit Iterations should be at least 20. 

 
 
9. Enter the Parameters values as shown below: 
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It is important to notice the limits on the parameter frac; the value of this parameter 
cannot exceed “1”, nor be less than zero. 

 
10. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

 or right-click in the plot window and select Variables. The Plot and Table 
Variables dialog box will open. Be sure the List All Variables check box is not 
selected. 

 
c. Click s1:conc to move this to the Current Selection pane. 
 
d. Click Done. The plot will appear as follows (y-axis has been set to 20):   
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10. Fit the model to the data, and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar click Fit 
. The plot will be updated as follows: 

 

 
 
b. View the statistics. In the Show menu, click Statistics, or alternatively on the 

SAAM II Toolbar click Statistics . The Statistics window will appear as 
follows: 
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To obtain this figure, you must scroll down thru the Parameter/Variable pane so 
that the derived variables are shown. The parameter d(1,4) equals frac; d(2,4) equals 
“1 – frac.” The rate constants k(1,4) and k(2,4) are the rate constants from the last 
compartment in the delay to Compartment 1 and Compartment 2 respectively. The 
sum of these rate constants equals the rate constant connecting the other 
compartments in the delay. 

Here is the entire Parameter/Variable Pane 

 
11. Close all open windows and dialog boxes. 
 

Quit the SAAM II Compartmental application. You may save the study file is you wish. It is 
provided as part of this tutorial as delay2.stu. 
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Part 3. Specifying a delay using the Heaviside function 
 
 The Heaviside function 
 
The Heaviside function is: 
 

heaviside=0.5*(1.0+atan(lambda*(t - tlag))*2/3.141592653) 
 

In this expression, “atan” is the arctangent function. The expression “t – tlag” acts as a switch. 
For values of “t” less than “tlag” the value of the Heaviside function equals zero. For values of 
“t” greater than “tlag”, the value is non-zero. The values of the Heaviside function are between 
zero and 1. The parameter lambda controls the sharpness of the function, i.e. how close the 
values lie “exactly” between zero and 1. 
 
The following shows a series of simulations with lambda equal to “1” (s1{1}), “10” (s1{2}), 
“100” (s1{3}) and “1000” (s1).  
 

 
 
To see how the Heaviside function works, the following is the table of values when lambda 
equals 1000. 
 

Jake Kraft
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You can see up to time “5” the values of s1 are close to zero. After time “5”, they rise. This 
illustrates the essential point of the Heaviside function: it is continuous and differentiable! This 
is extremely important not so much for simulations (solving differential equations) but for 
fitting.  
 
Suppose delays could be implemented using a conditional expression “if-then-else”. The 
problem here is the conditional can introduce a discontinuity in the model solution. Problems 
can arise when there is a datum near the discontinuity during optimization since the algorithm 
for optimization does not know on which side of the discontinuity the datum lays. When using 
conditionals, one needs to be very careful that incorrect solutions are not returned. This is why 
conditionals (e.g. “if-then-else” or the FORTRAN functions AMIN and AMAX) are not 
implemented in the SAAM II Compartmental application. 
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In this part of the tutorial, you will create and work with the following model: 
 

 
 

The difference between this model and the model used in Part 1 is that the delay will be 
specified as part of the transfer k(1,3). 
 
 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Create the Model shown above. 
 
3. Create the Experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours”. 
 
c. Type “60” in the End At box. The Experiment Attributes dialog box will appear as 

follows: 
 

 
 
d. Click Done. The Create Experiment dialog box will open as shown below: 
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Be sure Experiment is selected (as indicated by “Exper” in the New Name box). 
 
e. Click Create.  

 
4. Add the Data to the model 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. On the File menu, click Open. The file delay3.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click delay3.dat. The data in this file will appear in the Data window as 

shown below: 
 

 
 
d. Close the Data window. 
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5. Create the Input and Sample 
 

a. In the SAAM II Toolbox, click Input. 
 
b. On the Drawing Canvas, click Compartment q3, and then click on the canvas. The 

input ex1 will appear associated with your model. 
 
c. Double-click ex1. The Exogenous Input dialog box will open.  
 
d. Type “400” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows: 
 

 
 
f. Click Done. 
 
g. In the SAAM II Toolbox, click Sample. 
 
h. On the Drawing Canvas, click Compartment q1, and then click on the canvas. The 

sample s1 will appear associated with your model. 
 
i. On the Drawing Canvas, double-click s1 to open the Sample Attributes dialog 

box. 
 
j. Type “conc” in the Associate with Data Name box. 
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k. Edit the sample equation to read “s1=q1/Vc” in the Equation box. The Sample 
Attributes dialog box will appear as follows: 

 

 
 
l. Click Done. The model will appear as follows: 
 

 
 

6. Specify the Delay k(1,3) 
 

a. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 
click Equations . The Equations dialog box will open. 

 
b. Type the following equation in the Equations Defined Here box: 
 

heaviside=0.5*(1.0+atan(lambda*(t - tlag))*2/3.141592653) 
 

The Equations Defined Here pane in the Equations dialog box will appear as 
follows: 
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c. Close the Equations dialog box. 
 

Using the Heaviside function. In the expression for the Heaviside function above, tlag 
will be an adjustable parameter which will equal the time of the delay. “t” is the 
name of the independent variable in the model. lambda is a parameter which will be 
hand tuned before fitting the model to the data. 

 
 
d. Double-click k(1,3) to open the Transfer Attributes dialog box. The Transfer 

Attributes dialog box will open. 
 
e. Type the equation “k(1,3)=ka*heaviside” in the Equation box. The Transfer 

Attributes dialog box will appear as follows: 
 

 
 

This expression will result in ka being defined as a parameter. 
 

f. Close the Transfer Attributes dialog box. 
 
7. Enter the Parameters values as shown below: 
 



Advanced Tutorials SAAM II v.2.1 Working with Delays 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Delays – 53 SAAM  II Version 2.1 

 
 
8. Solve the model and view the solution. 
 

a. In the Compute menu, click Settings. The Computational Settings dialog box will 
open. Change the Min. Nr. of Calculation Intervals from “20” to “200”. This will 
improve the resolution of your plots. 

 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
d. Click s1:conc to move this to the Current Selection pane. 
 
e. Click Done. The plot will appear as follows:   
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9. Fit the model to the data, and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar click Fit 
. The plot will be updated as follows: 

 

 
 
b. View the first 5 minutes of the solution. 
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(1) In the Compute menu, click Plot/Table Scale, click the plot variables button 

, or right-click in the plot window and select Scale. The Plot and 
Table Scale dialog box will open. 

 
(2) In the X Axis pane, click Set. 
 
(3) Type “5” in the Maximum box. 
 
(4) Click Done. The plot will appear as follows: 
 

 
 
c. View the statistics. In the Show menu, click Statistics, or alternatively on the 

SAAM II Toolbar click Statistics . The Statistics window will appear as 
follows: 
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11. Close all open windows and dialog boxes. 
 
 

lambda in  the Heaviside function. In the above, lambda was set equal to 100. The 
following plot compares the best fit of the model to the data with lambda equal to 10 
(s1{L10_1}), 100 (s1{ L100_1}) and 1000 (L1000_1). 

 

 
 
The details of the initial rise are shown as follows: 
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You can see the differences in the initial rise caused by different values for lambda. 
 
The statistics for the fit when lambda equal 10 and 1000 respectively are: 
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You can see that, while the actual “Fits” are essentially the same, and the values for 
the Total objective function are essentially the same, there are differences in Vc and 
k(0,1). The reason for these differences is the fact that these parameters are highly 
correlated as shown in the statistics below for the case lambda equals 1000: 
 

 
 

With a correlation coefficient for Vc and k(0,1) equal to -0.99 it is not surprising 
there are differences for these parameters for different values of lambda. However all 
lie within the calculated 95% confidence intervals. 
 
What is meant by “tuning lambda”? “Tuning lambda” is the process of adjusting 
lambda in increments until the model parameters become stable. Because of the 
nature of the Heaviside function, it is recommended tuning be done by increasing 
lambda by factors of 10 until the model parameters become stable (independent of 
the value of lambda). Note that the Forward Difference Formula was used in the 
previous fitting procedures. It is also recommended that in the fitting procedure the 
central difference formula be used for calculating the numerical derivatives. To set 
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the central difference, in the Compute menu, click Settings. The Computational 
Settings dialog box will open. In the Derivative pane in the Optimizer pane, click 
Central. The Computational Settings dialog box will appear as follows: 
 

 
 

The following shows the results of fitting the model to the data for different values of 
lambda using these Computational Settings. 
 

lambda 10 100 1000 10000 100000
Vc 3.793 4.248 4.295 4.292 4.295
k(0,1) 1.433 1.288 1.274 1.276 1.275  

 
You can see that for lambda equal to 1,000 the parameters are stable. Thus in this 
tutorial a value of lambda equal to 1,000 or 10,000 would have been more 
appropriate than 100. If you wish, you can repeat this part of the tutorial using 
lambda equal to 100,000 and carefully compare the results with the case lambda 
equals 100. 



Advanced Tutorials SAAM II v.2.1 Working with Delays 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Delays – 60 SAAM  II Version 2.1 

When using the Heaviside function to create delays, you should go through the 
tuning process as described above to obtain an appropriate value of lambda for your 
particular modeling situation. 

 
 

Quit the SAAM II Compartmental application. You may save the study file is you wish. It is 
provided as part of this tutorial as delay3.stu. 
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Working with Experimental Inputs 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to specify different input formats for your 
experiment in SAAM II. You will learn 
 

 How to specify the amount of your input in a data file (Part 1) 
 How to specify the amount of the input as an adjustable parameter (Part 2) 
 How to specify split inputs (an input into more than one compartment (Part 3) 
 How to perform parametric deconvolution (Part 4) 

 
Files Required 
 

Study Files: The study files for this tutorial are 
 

ExpInp.stu 
study_0.stu 

 
These files are included as part of this tutorial. The file ExpInp.stu is the same as 
study_0.stu that is installed in the SAAM II program folder and referred to in the 
SAAM II User Guide with the exception there are no data in the Data window and the 
parameters have been set to “fixed.” 
 
Remember study_0 is a study file for an experiment lasting 9 days. In this tutorial, the 
time of the experiment may be adjusted so specific points can be illustrated. 
 
Data Files:  The data files for this tutorial are 
 

Paradecon.dat 
study_0.dat 
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Introduction 
 
This tutorial focuses on how to use the options in the Exogenous Input dialog box to specify 
less common or more advanced types of input dosage and to conduct parametric deconvolution. 
The tutorial covers 
 

 Specifying the amount of a dose as a constant in the data file. 
 Specifying the dose as an adjustable parameter. 
 Split inputs (an input into more than one compartment) 
 Parametric deconvolution 

 
The most frequently used types of dosage inputs are covered in the tutorial Experimental 
Inputs, Basic.  These input types are the bolus, the constant infusion and the primed 
constant infusion and are predefined. The equation input allows the user to specify any 
input as long as the terms of the equation are recognized by SAAM II.  
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Part 1. Specifying the amount of an input from the Data window 
 
You can specify information about dosing from the data window. To do so, you use the equation 
input option in the Exogenous Input dialog box. This part of the tutorial will illustrate how to 
specify the amount of a bolus injection in the Data window. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file ExpInpUS. 
 

a. The file ExpInpUS.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 
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Notice the difference between this model and the experimental model developed and 
used in the Getting Started with Compartmental tutorial. Here there is no 
experimental input, ex1, and the sample circle, s1, is not filled because there are no data 
in the study file. 
 
You may wish to review the Parameters dialog box and the Samples Attributes dialog 
box. The parameters are those from study_0 except they have been fixed since this 
tutorial involves only simulations and no data fitting. The sample equation is “s1 = 
q1/vol”. 
 

4. Create a bolus injection into Compartment q1 where the amount of the bolus is specified 
in the Data window. 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The experimental 

input ex1 will appear associated with the model as shown below: 
 

 
 

c. Double-click ex1 to open the Exogenous Input dialog box. The Exogenous Input 
dialog box will appear as follows: 
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Notice in the Input Type pane, bolus is selected. 
 

d. Enter a bolus injection of “dose” specified by an equation. 
 

(1) In the Input Type pane, select Equation. 
 
(2) In the Equation box, type “ex1 = dose”. 
 
(3) In the Event Start box, type “0”. 
 
(4) In the Event Stop box, type “0”. 
 
(5) Click Add. The Exogenous Input dialog box will appear as follows: 
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 Specifying an equation as a bolus input. The effect of the above is the following. The 
equation is specified “ex1 = dose”. However, the start and stop times being equal to 
zero, specifies the bolus. The result will be a bolus dose at time zero equal to an 
amount “dose”. “dose” can either be entered as a parameter or in the Data window. 

 
 
 (6) Click Done. 

 
e. Enter the amount of the dose in the Data window. 
 

(1) In the Show menu, click Data, or alternatively, on the SAAM II Toolbar click 

Data   . The Data window will open as blank since there are no data 
associated with this study file. 

 
(2) In the Data window, type “CONST  dose  100”. The Data window will appear as 

follows: 
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 Specifying constants in the Data window. You can specify constants in the data 
window using the CONST designator. In this case CONST is used to define the 
constant “dose” equal to “100.” 

 
 
 (3) Close the Data window. 

 
5. Solve the model and view the solution. 
 

a. It will be useful to increase the resolution of your plot. In the Compute Menu, click 
Computational Settings. Type “200” in the Min. Nr. of Calculation Intervals box. 
Click Done. 

 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 

c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 
. The Plot and Table Variables dialog box will open. Be sure the List All 

Variables check box is not selected so s1 is the only option in the Variables for Y-
Axis pane. 

 
d. Click s1 to add this to the Current Selection pane. The Plot and Table Variables 

dialog box will appear as shown below: 
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e. Click Done. A plot of s1 will appear in semilog mode in the Plot window as shown 
below (if it is not in semilog mode, in the View menu, click Semilog): 

 

 
 
f. Close the Plot window. 

 
Quit the SAAM II Compartmental application. Do not save the changes to study_0_ExpInp. 
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 Specifying the amount of an input in the Data window using the Equation type of 
Exogenous Input. The above is an example of how to specify the amount of a bolus 
injection where the amount of the bolus is specified in the Data window. It is clear 
that multiple boluses, constant infusions, multiple constant infusions and primed 
infusions can be specified similarly. It is simply a matter of how the equation input is 
specified. Suppose, for example, you wanted to specify a primed constant infusion 
where the priming dose was 100 and the infusion rate was 25 for a specified time 
interval. If in the Data window, there were two constants entered, for example  

 
  CONST dose 100  
 and  
  CONST dose1 25 
 
 were entered, the Exogenous Input dialog box could look as follows: 
 

 
 

Here the bolus is specified equal to “dose” since it starts and stops at time zero. It is 
followed by a constant infusion equal to “dose1” starting at time 0 and ending at t=4. 
 
Thus the Equation input type gives you great flexibility in specifying inputs where 
information about the input can be contained in the data file. 
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Part 2. Dose as an adjustable parameter 
 
 It is not often that the amount of material in the dose can be an adjustable parameter. This is 
because, under normal circumstances, the volume of the pool into which the test substance is 
administered needs to be estimated. To obtain an estimate of this volume, it is necessary to 
know the dose precisely. 
 
There are instances, however, when the amount of the dose can be an adjustable parameter. 
Normally this occurs when one has a single input-multiple output experimental design. An 
example would be a bolus injection into plasma with plasma and urine samples. Another 
example would be if volume were precisely known. This is the example that will be illustrated 
in this part of the tutorial. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder where 

you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 

 

 
 
You may wish to review the Parameters dialog box and the Samples Attributes dialog 
box. The sample equation is “s1 = q1/vol”. 
 

4. Create a bolus injection into Compartment q1 where the amount of the dose is an 
unknown parameter. 

 
a. Double-click ex1 to open the Exogenous Input dialog box. The Exogenous Input 

dialog box will appear as follows: 
 

 
 

This is the bolus input specified in study_0. It assumes the dose is known and the 
volume vol is unknown. In what follows, the situation will be reversed. The dose will 
be assumed unknown and the volume known. 
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b. Click Delete to remove the bolus injection. 
 
c. Create the input. 
 

(1) In the Input Type pane, select Equation. 
 
(2) In the Equation box, type “ex1 = dose”. 
 
(3) Be sure the Event Start and Event Stop times are set equal to zero. 
 
(4) Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 
(5) Click Done. 
 

The input now has been defined as an equation where the equation is a constant 
“dose”. “dose” will appear as a parameter when you open the Parameters dialog 
box. The event start and stop times being zero specifies the equation as a bolus. 
Since a new parameter has been introduced, a value for it must be specified in the 
Parameters dialog box.  
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5. Specify the model parameters. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open, as shown below: 

 

 
 

You can see dose now appears as a parameter. If you specify a value for the dose and 
leave all the other parameters adjustable, you will not be able to fit the model to the 
data because there are too many parameter values. In this example, it will be 
assumed that the volume vol is known, and equal to 2000 ml. 
 

b. Set the parameters are follows: 
 

(1) Double-click dose to select it. 
 
(2) In the Value box, type “1.0e+08”. 
 
(3) Click Save. 
 
(4) Double-click vol to select it. 
 
(5) Select Fixed as the Type. 
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 (6) Click Save. The Parameters dialog box will appear as follows: 
 

 
 
(7) Click Done. 

 
6. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 

b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 
. The Plot and Table Variables dialog box will open. Be sure the List All 

Variables check box is not selected so s1:plasma is the only option in the Variables 
for Y-Axis pane. 

 
c. Click s1:plasma to add this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as follows: 
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d. Click Done. A plot of s1 and plasma will appear in semilog mode in the Plot 
window as shown below (if it is not in semilog mode, in the View menu, click 
Semilog): 

 

 
 

Leave the Plot window open. 
 

7. Fit the model to the data and view the solution. 
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a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, click 

Fit . Your plot will be updated as follows: 

 
 

b. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar, click 

Statistics . The Statistics window will open as follows: 

 
The model parameters are estimated with good precision. Notice, of course, vol is a 
fixed parameter. ex1.bolus appears as a derived parameter because of the 
specification of the input as an equation. 
 

c. Close the Statistics and Plot windows. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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Part 3. Split inputs (an input into more than one compartment) 
 
There may be occasion when your have an experimental input into more than one compartment, 
and you may not know how the input distributes among the compartments. One example is 
injecting radioiodinated low density lipoproteins (LDL) where the radioactive iodide distributes 
between two subpopulations of LDL particles. Another example would be an injected material 
with an unknown amount of contaminants where the material and contaminant have different 
kinetics. Thus what is known is the total amount of material administered; what may not be 
known is how it distributed. This situation is accommodated in SAAM II using the split input 
capability in the Exogenous Input dialog box. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Create the following system model. 
 

 
Notice this is a two-compartment model where there is no interconnection between the 
two compartments; there is only a loss from each. 

 
3. Create the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 
unavailable and the Experiment tools are available. The Experiment Attributes 
dialog box will open. 

 
b. Change the entry in the Units box from “minutes” to “days.” 
 
c. Type “9” in the End at box. The Experiment Attributes dialog box will appear as 

shown below: 
 

 



Advanced Tutorials SAAM II v.2.1 Working with Experimental Inputs 
 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Adv. Exp. Input – 18 SAAM  II Version 2.1 

 
d. Click Done. The Create Experiment dialog box will appear on the Drawing 

Canvas. The choice is to create an Experiment (Exper) or System experiment. The 
Exper experiment is selected as follows: 

 

 
 

e. Click Create (since Exper is selected, and this is the type of experiment you want to 
create). Your model will appear as follows: 

 

 
 

4. Add the data 
 
a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. On the File menu, click Open. The file study_0.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click study_0. The data in this file will appear in the Data window. The 

model and the Data window should appear with the model on the Drawing Canvas 
as follows: 
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d. Close the Data window. 
 

5. Create the sample on the model. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1, then Compartment q2, and then click on the Drawing 

Canvas. 
 

A sample object, s1, will appear on the Drawing Canvas attached to Compartments 
q1 and q2. This means your sample was from plasma. Notice that the circle at the 
top of the sample object is an open circle; data have not yet been associated with the 
sample. The sample object can be moved on the Drawing Canvas to a location you 
desire. 

 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “plasma” in the Associate with Data Name box.  
 
e. Edit the sample equation “s1 = q1+q2” to read “s1 = (q1+q2)/vol” in the Equations 

pane. The Sample Attributes dialog box will appear as follows: 
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f. Click Done. The model will appear as follows: 

 
 

7. Create the experimental input 
 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, then Compartment q2, and then click on the Drawing 

Canvas. 
 

An input arrow named ex1 will appear on the Drawing Canvas attached to 
Compartments q1 and q2. The input syringe can be moved to a desired location. The 
model will appear as follows: 

 
 

c. Double-click ex1 to open the Exogenous Input dialog box. 
 

b. Type “1.04e+08” in the Initial Amount box. 
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e. Click Add. The Exogenous Input dialog box should appear as follows: 

 
 

Notice the Split Input button is active. 

 Split inputs. Split inputs occur when your injected test substance is not kinetically 
homogeneous, but kinetically heterogeneous. This means the input consists of two or 
more substances with different kinetics. This can be due to a variety of factors 
including contamination. It is important to be aware when this can happen, and 
incorporate it into your model. 

 
f. In the Exogenous Input dialog box, click Split Input. The Split Exogenous Input 

dialog box will open as follows: 
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 Split Exogenous Input. When you have a split input, you know the total amount of 
substance given, but you may not know how the substance distributes among 
different compartments. You must write equations which relate the amounts in the 
different compartments to the total. In this example where the input is a bolus, ex1 is 
the total dose. The doses in Compartments q1 and q2 are respectively ex1.1 and 
ex1.2. 

 
g. In the Equation box in the Split Exogenous Input dialog box, edit the equations to 

read: 
ex1.1 = frac*ex1 
ex1.2 = (1-frac)*ex1 

 
The Split Exogenous Input dialog box together with the Exogenous Input dialog 
box will appear as follows: 
 

 
 

 Split exogenous input. The above equations partition the total dose, ex1, into two 
fractions. frac will become a parameter whose value lies between 0 and 1. It will be 
the fraction of the total dose in Compartment q1. The value 1 – frac will be the total 
dose in Compartment q2. 
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h. In the Split Exogenous Input dialog box, click Done. The Exogenous Input dialog 

box will remain as shown above. The only indication of the split input is the Split 
Input option is active. 

 
i. In the Exogenous Input dialog box, click Done. 
 

8. Add parameter values to the model. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open.  

 
b. Add the parameters as shown in the Parameters dialog box below: 
 

 
 

 Split exogenous input. In the above, frac is a parameter whose value lies between 0.1 
and 0.9. Notice also there are four parameters to estimate, the two losses, the volume, 
and frac. 
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c. Click Done. 
 

9. Solve the model, and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 

b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 
. The Plot and Table Variables dialog box will open. Be sure the List All 

Variables check box is not selected so s1:plasma is the only option in the Variables 
for Y-Axis pane. 

 
c. Click s1:plasma to add this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as follows: 
 

 
 

 
d. Click Done. A plot of s1 and plasma will appear in semilog mode in the Plot 

window as shown below (if it is not in linear mode, in the View menu, click 
Semilog): 
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Leave the Plot window open. 
 

7. Fit the model to the data and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, click 

Fit . Your plot will be updated as follows: 
 

 
 
b. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar, click 

Statistics . The Statistics window will open as follows: 
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The model parameters are estimated with good precision. The value for frac is 0.69 
which means 69% of the original injected dose is into Compartment q1. Under 
Derived Variables, you can see the exact amount of dose in each compartment 
predicted by the model. 

 
c. Close the Statistics and Plot windows. 

 
Quit the SAAM II Compartmental application. You may save the study file if you wish. 
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Part 4. Parametric deconvolution 
 

Deconvolution is the technique used to address the following problem. There is a known 
system and a known output from an unknown input. The problem is to calculate the 
unknown input. The problem is shown diagrammatically as follows: 

  
 

There are basically two ways to deal with this problem. One is called nonparametric 
deconvolution. This is an extremely difficult problem. The other is called parametric 
deconvolution. 
 
In parametric deconvolution, the following are assumed: 
 

 The exact specification of the system model (in terms of a compartmental model, this 
means the structure and all parameter values). 

 There are output data. 
 The specification of the input is known (in terms of the situation here, this means the 

equation for the input is known but the parameters of the equation are unknown and 
will be estimated from the data). 

 
This part of the tutorial will illustrate how to perform parametric deconvolution using 
SAAM II. 
 
1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 

window will open as shown below: 
 
2. Open the SAAM II Compartmental study file ExpInp_0. 
 

a. The file ExpInp_0.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
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b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear. In the SAAM II Toolbox, click Experiment. The model of the experiment 
for ExpInp_0.stu will appear on the Drawing Canvas as follows: 

 

 
3. Enter and view the data. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. In the File menu, click Open. The file paradecon.dat should appear in the list (if it 

does not, find the folder where you put this data file). 
 
c. Double-click paradecon.dat. The data in this file will appear in the Data window as 

follows: 
 

 
 

These are simulated data obtained when an exponential input was specified and 
samples were created at the same time samples were taken in the data file 
study_0.dat. 
 

d. Close the Data window. 
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e. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. 
 

f. Be sure the List All Variables check box is selected. (Click this box if it is not 
selected). 

 
g. Click plasma to move it to the Current Selection pane. 
 
h. Click Done. A plot of the data will appear in the Plot window. 
 
i. In the View menu or right-click in the plot window, click Line Plot. 

 
j. In the View menu or right-click in the plot window, be sure Semilog is selected. 

Your plot will appear as follows: 
 

 
 

These are the output data. The problem is to specify an input function format, and to 
estimate the parameters of this input from the data. 

 
k. Close the Plot window.  
 

4. Associate the sample s1 with the plasma data. 
 

a. Double-click s1 to open the Sample Attributes dialog box. 
 
b. In the Associate with Data Name box, type “plasma”. The Sample Attributes 

dialog box will appear as follows: 
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c. Click Done. 

 
5. Specify and define the input function. 
 

In this example, the input function is assumed to be known, and to be equal to  
A*(exp(-a*t)-exp(-b*t)). This will be entered as equation input, and the  
parameters A, a and b estimated from the data. 
 
a. In the SAAM II Toolbox, click Input. 
 
b. Click on Compartment q1 and then the Drawing Canvas. The input ex1 will appear. 
 
c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Specify the equation input. 
 

(1) In the Input Type pane, select Equation 
 
(2) In the Equation box, type “ex1=A*(exp(-a*t)-exp(-b*t))”. 
 
(3) In the Event Start box, type “0”. 
 
(4) In the Event Stop box, type “9”. (Remember the time of the experiment in 

study_0 is 9 days). Click Add. The Exogenous Input dialog box will appear as 
follows: 
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(5) Click Done. 

 
6. Specify the parameter values. 
 
a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, click 

Parameters . The Parameters dialog box will open, as shown below: 
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The model parameters are all present and fixed. These are the k(i,j) and vol. In 
parametric deconvolution, the model parameters are assumed to be known precisely, 
and hence must be fixed. 
 
The unknown model parameters are those characterizing the input function. In 
parametric deconvolution, the “type” of input function is assumed to be known but 
the parameters of the function are unknown.  
In this case, these parameters are A, a and b. 

 
b. Enter the parameter values. 
 

(1) If A is not selected, double-click A to select it. Type “100” in the Value box, and 
click Save. 

 
(2) Double-click a to select it. Type “0.05” in the Value box, and click Save. 
 
(3) Double-click b to select it. Type “0.5” in the Value box, and click Save. The 

Parameters dialog box will appear as follows: 
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(4) Click Done. 
 

7. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
c. Click s1:plasma to move this to the Current Selection pane. Your plot will appear 

as shown below (in linear mode). 
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Leave the Plot window open. 
 

8. Fit the model to the data and view the results. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar click Fit 
. The plot will be updated as follows: 

 

 
 
 Close the Plot window. 
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b. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar, click 

Statistics . The Statistics window will open as follows: 
 

 
 
 Close the Statistics window. 
 
 

9. View the unknown input function. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 
. Your previous plot should open. 

 
b. In the Set menu, click Plot/Table Variables, or alternatively, on the SAAM II 

Toolbar, click Plot, or right-click in the plot window and select Variables. The Plot 
and Table Variables dialog box will open. Be sure the List All Variables check 
box is selected. 

 
c. Click ex1.infusion to move this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as follows: 
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d. Click Done. The plot of the unknown input function will appear as follows (the plot 

is in linear mode, and the Y Axis maximum has been set equal to 80): 
 

 
 
e.  Close the Plot window. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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Multiple Input-Output Experiments 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” It will be helpful to have 
worked through the Using SAAM II Tutorial “Using Delays – Part 1.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you have to deal with experiments with multiple inputs 
and multiple outputs. You will learn how to 
 

 Create multiple input-output experiments using the Duplicate command (Part 1). 
 Create multiple input-output experiments using Create Experiment in the SAAM II 

Toolbox (Part 2). 
 
Files Required 
 

Study Files: The study files for this tutorial are 
 

io_duplicate.stu 
io_expt.stu 
io_expt_final.stu 

 
The study file io_duplicate.stu is saved for convenience and can be used with Part 1. 
The study file io_expt.stu will be used for Part 2. The study file io_expt_final.stu is the 
study file created in Part 2. 

 
Data File: The data file for this tutorial is 

 
io.dat 

 
This file is included as part of this tutorial.  

 
 



Advanced Tutorials SAAM II v.2.1 Multiple I-O Experiments 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Multiple IO – 2 SAAM  II Version 2.1 

Introduction 
 
There are many instances when your experimental protocol may call for multiple inputs. 
Examples in metabolic kinetics come from multiple tracer studies. For example, carbon and 
hydrogen labeled glucose can be injected (two-inputs) and both tracers followed in plasma 
samples (two-outputs). In pharmacokinetic studies, an example would be the IV and oral 
administration of a drug in the same individual. Normally this is done at different times so the 
assumption has to be made that the subject is in the same “state” in both experiments. More 
recently, it has become possible to label a drug with a stable isotope. The drug and isotopically 
labeled drug can then be administered IV and orally (two-inputs), and plasma levels of drug and 
stable isotope followed (two-outputs). Finally, the increased use of tools such as MRI and PET 
is making multiple input-output studies more common. Multiple input-output studies will 
become more important especially in the pharmaceutical industry as the process of drug 
discovery and development becomes more sophisticated. 
 
There are two ways multiple input-output studies can be created in SAAM II. One uses the 
model duplication command in the Edit menu. Here, as illustrated in Part 1, you can create a 
model, and then duplicate the model structure. You have the option of having corresponding 
rate constants set equal, or they can be different. In Part 1, you will see that you can create a 
model for the IV system. Then you can duplicate this model, and add to it components to 
describe absorption. 
 
The other method uses the Create Experiment option in the SAAM II Toolbox. Here you first 
create the system model. In the system model, you can have inputs at different sites. SAAM II 
does the book keeping via the Create Experiment option. You create a different experiment for 
each input. 
 
The most common experiment is the single input experiment. When you create your experiment, 
the compartment names change from, for example, 1 to q1. When you create multiple 
experiments, q1 changes to, for example, q1.1 for a second experiment, q1.2 for a third 
experiment, etc. Using this option makes it much easier to keep track of the individual inputs 
and outputs. 
 
The data to be used in this tutorial come from a pharmacokinetic study in which a drug was first 
given IV, and then given later via a suspension into the upper GI tract. 
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Part 1. Creating a Multiple Input-Output Experiment Using the Duplicate Command 
 
In this tutorial, you will simultaneously analyze data following an iv administration and oral 
suspension administration of a drug using the Duplicate command. In the IV experiment, the 
drug was infused for 20 minutes while in the suspension, it was given as a bolus. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Create the following system model for the IV data on the Drawing Canvas: 
 

 
3. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog box 

will open. 
 

a. Type “480” in the End At box. The Experiment Attributes dialog box should 
appear as follows: 

 

 
 
b. Click Done. The Create Experiment dialog box will open as follows: 
 

 
 
c. Click Create. The model will appear on the Drawing Canvas as follows: 
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4. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
b. In the File menu, click Open. The file io.dat should appear in the list (if it does not, 

find the folder where you have put this data file). 
 
c. Double-click io.dat. The data file contains drug data following the 20 minute 

constant infusion, “ivplasma”, and following the oral administration, “suspension.” 
The oral data will be used later. The Data window appears as follows: 
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The weighting scheme is FSD; you can leave the variance model set as the default 
data-relative.  

 
d. Close the Data window. 
 

5. Create a sample and an input 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1 and then the Drawing Canvas. The sample s1 will appear 

associated with Compartment q1. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “ivplasma” in the Associate with Data Name box. 
 
e. Edit the sample equation to read “s1=q1/V1”. The Sample Attributes dialog box 

will appear as follows: 
 

 
 
f. Click Done. 
 
g. In the SAAM II Toolbox, click Input. 
 
h. Click Compartment q1 and then the Drawing Canvas. The input ex1 will appear 

associated with Compartment q1. 
 
i. Specify the 20 minute infusion. 
 

(1) Double-click ex1 to open the Exogenous Input dialog box. 
 
(2) Select Infusion in the Input Type pane. 
 
(3) Type “12500” in the Constant Rate box. 
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(4) Type “0” in the Event Start box. 
 
(5) Type “20” in the Event Stop box. 
 
(6) Click Add. The Exogenous Input dialog box should appear as follows: 
 

 
 
(7) Click Done. The model will appear as follows: 
 

 
 

6. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open. 

 
The parameter V1 should be selected. If it is not selected, double-click V1. Be sure 
the Adjustable option is selected. 
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b. Type “13000” in the Value box, “2000” in the Low Limit box, “20000” in the High 
Limit box, and click Save. 

 
c. Double-click k(0,1) to select it. 
 
d. Type “0.07” in the Value box, and click Save. 
 
e. Double-click k(1,2) to select it. 
 
f. Type “0.02” in the Value box, and click Save. 
 
g. Double-click k(2,1) to select it. 
 
h. Type “0.2” in the Value box, and click Save. The Parameters dialog box should 

appear as follows: 
 

 
 
i. Click Done. 
 

7. Solve the model and view the solution. 
 

a. It will be helpful to have better resolution of your plots than the default. In the 
Compute menu, click Settings. The Computational Settings dialog box will open. 
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Change the entry in the Min. Nr. of Calculation Intervals from “20” to “200”. The 
Computational Settings dialog box should appear as follows: 

 

 
 

Click Done. 
 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 

 
c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
d. Click s1:ivplasma; it will move to the Current Selection pane. 
 
e. Click Done. The following plot will appear (in linear mode): 
 



Advanced Tutorials SAAM II v.2.1 Multiple I-O Experiments 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Multiple IO – 9 SAAM  II Version 2.1 

 
 
f. Close the Plot window. 

 
You have now created the model which will be used to analyze the IV plasma data. The system 
model for the oral suspension data will now be created assuming once the drug enters plasma it 
behaves the same as the drug introduced using the IV infusion. 
 

8. Create the following system model for the oral suspension data using the Duplicate 
command. 

 

 
 

a. While pressing the CTRL key, click q1, q2 and s1. Alternatively, use a crossing 
window, selecting all (you can delete the ex2 input later if necessary). 

 
b. In the Edit menu, click Duplicate. The Duplicate dialog box will open. 
 
c. Change the entry in the Start new Compartment/Delay numbers at box equal to 

“11”. Select the Set New Parameters Transfer Coefficients equal to counterparts 
box. The Duplicate dialog box will appear as follows: 
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d. Click Duplicate. As instructed in the Duplicate dialog box, click on the Drawing 

Canvas approximately where you would like the duplicated model to appear. The 
following models will appear on the Drawing Canvas (after some rearrangement): 

 

 

Duplicating. The Duplicate command allows you to duplicate a model, or a portion of 
a model. There are several features that are important. 

 The duplicated sample s2 will appear associated with Compartment q11 (in 
this case). It is not, however, associated with data and hence the circle is 
open. In addition, the equation for the sample is “s2=q11”, that is, the 
equation for sample s1 does not carry over to s2. 

 You have the option of setting the compartment number from where the 
duplicated model will start. For this reason, the order in which you click the 
compartments as you begin the duplication process can be important. 

 You have the option of having the parameters of the duplicated model be 
different. In that case, the structure is preserved but the parameters, k(0,11), 
k(12,11) and k(11,12) would appear in the Parameters dialog box. The other 
option, the one chosen here, is to set the new parameters’ transfer coefficients 
equal to their counterparts. 
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To see how this works, double-click, for example, k(0,11). The Loss Attributes 
dialog box will appear as follows: 
 

 
 
SAAM II has defined “k(0,11)=k(0,1” thus saving you the trouble of having to do 
this for every parameter in the duplicated model. (Of course, you can remove this 
equation if you wish in which case k(0,11) would appear as a parameter in the 
Parameters dialog box.) 
 
IMPORTANT If the option of setting the parameters equal to their counterparts is 
chosen, it is necessary to Solve the original model first in order for the model to be 
created internally in SAAM II. 

 
e. Create the model for oral absorption. 
 

(1) In the SAAM II Toolbox, click Model. The Model tools are now available. 
 
(2) In the SAAM II Toolbox, click Compartment. 

 
(3) Click on the Drawing canvas where you would like the new compartment to 

appear. Compartment 3 will appear. Double-click Compartment 3 to open the 
Compartment Attributes dialog box. Change the number of the compartment 
from “3” to “13”. The Compartment Attributes dialog box will appear as 
follows: 
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  Click Done. 
 
(4) In the SAAM II Toolbox, click Delay. 
 
(5) Click on the Drawing Canvas where you would like the delay to be located. 

Place it between Compartments 13 and 11. Your model for the oral dose should 
appear as follows: 

 

 
 

(6) Double-click Delay 3. The Delay Attributes dialog box will open. 
 
(7) Change the entry in the Delay Time box to “tlag”. tlag will become an adjustable 

parameter equal to the delay time in absorption. 
 
(8) Change the entry in the Number of compartments box to “5”. The Delay 

Attributes dialog box should appear as follows: 
 

 
 (9) Click Done. 
 
(10) Add the fluxes k(0,13), k(3,13) and d(11,3). The model will appear as follows: 
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 Remember the output from the delay is denoted by “d” to signify the fraction of 

the material in the delay moving along this transfer pathway. In this case, 
d(11,3) is equal to 1. 

 
9. Create an input into Compartment q13. 
 

a. In the SAAM II Toolbox, click Experiment to make these tools available. 
   
b. Click Input. 
 
c. Click Compartment q13 and then the Drawing Canvas. The input ex2 will appear 

associated with Compartment q13. 
 
d. Double-click ex2 to open the Exogenous Input dialog box. Be sure “Bolus” is 

selected as the Input Type. 
 
e. In the Initial Amount box, type “2.5e+05”. 
 
f. Click Add. 
 
g. Click Done. 

 
10. Associate s2 with the oral data, and change the sample equation. 
 

a. Double-click s2 to open the Sample Attributes dialog box. 
 
b. Type “suspension” in the Associate with Data Name box. 
 
c. Edit the sample equation to read “s2=q11/V1” The Sample Attributes dialog box 

will appear as follows: 
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d. Click Done. Notice it is assumed that the volume of Compartments q1 and q11 are 
the same. 

 
11. Specify the new parameter values. 
 
 There are three new parameters to specify, tlag, k(0,13) and k(3,13). Compartment q13 

is the compartment into which the suspension is introduced, and hence is really a part of 
the delay which is the GT tract. Thus Compartment q13 should turn over at 
approximately the same rate as the compartments in the delay. These turn over at the rate 
“tlag/5”, i.e. the delay time divided by the number of compartments in the delay. 

 
 However not all of the suspension may be absorbed. Define a new parameter “pa” equal 

to the fraction absorbed. Then you can write: 
 
 k(3,13) = pa*(5/tlag) 
 k(0,13)=(1-pa)*(5/tlag) 
 
 This will allow you to estimate the fraction “pa”, or percent “pa*100”, of the drug in 

suspension absorbed. 
 

a. Double-click k(3,13) to open the Transfer Attributes dialog box. 
 
b. In the Equation pane, type the equation “k(3,13) = pa*(5/tlag)”. The Transfer 

Attributes dialog box will appear as follows: 
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c. Click Done. 
 
d. Double-click k(0,13) to open the Loss Attributes dialog box. 
 
e. In the Equation pane, type the equation “k(0,13) = (1-pa)*(5/tlag)”.  
 
f. Click Done. 
 
g. Open the Parameters dialog box, and enter values as shown below for pa and tlag. 
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Notice the default Low and High Limits have not been used for pa or tlag. The 
reason for pa is that it is a fraction, and cannot exceed “1”. The reason for tlag is that 
the lag time cannot be longer than the experiment itself. 

 
h. Click Done. 
 

12. Solve the model and view the solution. The plot of s1:ivplasma and s2:suspension 
should appear as follows (in linear mode): 
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13. Fit the model to the data. The plot will be updated as follows: 
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The statistics will appear as follows: 
 

 
 

Viewing all of the Parameter/Variable window: 

 
 

Close the Statistics and Plot windows. 
 

Quit the SAAM II Compartmental application. You may save this study file if you wish. The 
study file io_duplicate.stu is this study before the Fit. 

 

Multiple input-output study. In studies such as this one where, on different occasions, a 
drug is administered iv and later orally (or in this case, as a suspension), there are 
two essential assumptions made when analyzing the data simultaneously: 
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 Assumption 1: The subject is in the same “condition” during the two separate 
studies. That is, the determinants of how the drug is metabolized are the same on 
both days of the study. 

 
 Assumption 2: The metabolism of the drug that is absorbed into the systemic 

circulation is identical to that when the drug is introduced directly by IV. 
 
 For each such study, these assumptions must be considered if the “system model” is 

to be assumed identical for both studies. 
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Part 2. Creating a Multiple Input-Output Experiment Using Create Experiment 
 
In this tutorial, you will simultaneously analyze data following an iv administration and oral 
suspension administration of a drug by creating two separate experiments. In the iv experiment, 
the drug was infused for 20 minutes while in the suspension, it was given as a bolus. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file io_expt.stu. 

 
a. The file io_expt.stu should appear in the file list; if it does not, find the folder where 

you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

This is the system model which has been proposed to describe the drug data 
following an IV administration into plasma, Compartment 1, and into the GI tract, 
Compartment 4. Compartments 1 and 2 are proposed as the system model, i.e. to 
describe the drug kinetics in the body. Compartment 4 is proposed to be the upper 
end of the GI tract, the compartment into which the drug suspension is administered. 
The Delay 3 represents transit through the GI tract. The characteristics of the delay 
have been set in that the delay time is a parameter tlag, and the number of the 
compartments in the delay has been set equal to 5. You can confirm this by double-



Advanced Tutorials SAAM II v.2.1 Multiple I-O Experiments 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Multiple IO – 21 SAAM  II Version 2.1 

clicking on Delay 3, and examining the Delay Attributes dialog box. Also the time 
of the experiment has been set to 480 minutes. Thus when you click on Experiment 
in the SAAM II Toolbox, the Experiment Attributes dialog box will not open as is 
normally the case; the Create Experiment dialog box will open. 

 
3. Create the iv experiment. 
 

a. In the SAAM II Toolbox, click Experiment. The Create Experiment dialog box 
will open. 

 
b. Change the name of the experiment from “Exper” to “ivplasma”. The Create 

Experiment dialog box will appear as follows: 
 

 
 
c. Click Create. The model will appear as follows: 
 

 
4. Create the experimental input and sample for the IV experiment. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1 and then the Drawing Canvas. The sample s1 will appear 

associated with Compartment q1. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “ivplasma” in the Associate with Data Name box. 
 
e. Edit the sample equation to read “s1=q1/V1”. The Sample Attributes dialog box 

will appear as follows: 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Input. 
 
h. Click Compartment q1 and then the Drawing Canvas. The input ex1 will appear 

associated with Compartment q1. 
 
i. Specify the 20 minute infusion. 
 

(1) Double-click ex1 to open the Exogenous Input dialog box. 
 
(2) Select Infusion in the Input Type pane. 
 
(3) Type “12500” in the Constant Rate box. 
 
(4) Type “0” in the Event Start box. 
 
(5) Type “20” in the Event Stop box. 
 
(6) Click Add. The Exogenous Input dialog box should appear as follows: 
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(7) Click Done. The model will appear as follows: 

 

 
 

This is the model to describe the IV plasma data following the 20 minute constant 
infusion of drug. Notice that neither Compartment q4 nor Delay d3 will play any 
role whatsoever in describing the IV plasma data. 

 
5. Create the experiment for introducing the drug in suspension. 
 

a. In the SAAM II Toolbox, click Create. The Create Experiment dialog box will 
open. 

 
b. Change the name of the experiment from “Exper” to “suspension”. The Create 

Experiment dialog box will appear as follows: 
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c. Click Create. The model will appear as follows: 
 

 
 
Notice the compartment numbers have changed from, for example, q4 to q4.1. The 
“.1” means this is an experiment separate from the case where these is no such label. 
This is how SAAM II does its book keeping for multiple experiments. 

 
6. Create the experimental input and sample for the suspension experiment. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1.1 and then the Drawing Canvas. The sample s2 will appear 

associated with Compartment q1.1. 
 
c. Double-click s2 to open the Sample Attributes dialog box. 
 
d. Type “suspension” in the Associate with Data Name box. 
 
e. Edit the sample equation to read “s2=q1.1/V1. The Sample Attributes dialog box 

will appear as follows 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Input. 
 
h. Click Compartment q4.1 and then the Drawing Canvas. The input ex2 will appear 

associated with Compartment q4.1. 
 
i. Double-click ex2 to open the Exogenous Input dialog box. Be sure “Bolus” is 

selected as the Input Type. 
 
j. In the Initial Amount box, type “2.5e+05”. 
 
j. Click Add. 
 
l. Click Done. The model will appear as follows: 
 

 
 

This is the model to describe the suspension data following the bolus introduction of 
the drug as a suspension in the upper GI. Now both Compartment q4 and Delay d3 
will play any role in describing the suspension data. The data can be analyzed 
together because the “iv” experiment will analyze these data while the above will 
analyze the suspension data. The parameters in common are k(2,1), k(1,2), k(0,1) and 
V1. 

 
7. Enter the parameter values. 

 
Besides the system model parameters k(2,1), k(1,2), k(0,1) and V1, there are the 
parameters describing absorption. These are tlag, the time of the delay, and k(3,4) and 
k(0,4). 
 
Compartment 4 is the compartment into which the suspension is introduced, and hence is 
really a part of the delay which is the GT tract. Thus Compartment 4 should turn over at 
approximately the same rate as the compartments in the delay. These turn over at the rate 
“tlag/5”, i.e. the delay time divided by the number of compartments in the delay. 

 
 However not all of the suspension may be absorbed. Define a new parameter “pa” equal 

to the fraction absorbed. Then you can write the following equations in the respective 
Transfer Attributes dialog boxes: 
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 k(3,4) = pa*(5/tlag) 
 k(0,4)=(1-pa)*(5/tlag) 
 

This will allow you to estimate the fraction, or percent, of the drug in suspension 
absorbed. 
 
a. Double-click k(3,4) to open the Transfer Attributes dialog box. 
 
b. In the Equation pane, type the equation “k(3,4) = pa*(5/tlag)”. The Transfer 

Attributes dialog box will appear as follows: 
 

 
 
c. Click Done. 
 
d. Double-click k(0,4) to open the Loss Attributes dialog box. 
 
e. In the Equation pane, type the equation “k(0,4) = (1-pa)*(5/tlag)”.  
 
f. Click Done. 
 
g. Open the Parameters dialog box. The value for tlag is already in the study file. 

Enter the remaining parameters as shown in the Parameters dialog box below: 
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h. Click Done. Notice the default Low and High Limits have not been used for V1, pa 

or tlag. The reason for V1 is that it is known with more accuracy than the default 
Low and High Limits would indicate. The reason for pa is that it is a fraction, and 
cannot exceed “1”. The reason for tlag is that the lag time cannot be longer than the 
experiment itself. 

 
8. Solve the model and view the solution. The plot of s1:ivplasma and s2:suspension will 

appear as follows: 
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9. Fit the model to the data. The plot will be updated as follows: 
 

 
 
 The statistics will appear as follows: 
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 Close the Plot and Statistics windows. 

 
Quit the SAAM II Compartmental application. Do not save the changes to io_expt.stu. The 
study file with the parameter values before the fit has been saved as io_exp_final.stu. 

Multiple input-output study. In studies such as this one where, on different occasions, a 
drug is administered iv and later orally (or in this case, as a suspension), there are 
two essential assumptions made when analyzing the data simultaneously: 

 
 Assumption 1: The subject is in the same “condition” during the two separate 

studies. That is, the determinants of how the drug is metabolized are the same on 
both days of the study. 

 
 Assumption 2: The metabolism of the drug that is absorbed into the systemic 

circulation is identical to that when the drug is introduced directly  by iv. 
 
 For each such study, these assumptions must be considered if the “system model” is 

to be assumed identical for both studies. 
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Using Forcing Functions 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 

 How to use forcing functions defined by linear interpolation of data (Part 1). 
 How to use forcing functions defined by an equation (Part 2). 

 
Files Required 
 

Data: 
The data file for this tutorial is 
 
ff_pre_pro.dat 
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Introduction 
 
This tutorial will show you how to use forcing functions as a modeling tool in SAAM II.. They 
can be used for any precursor-product type system such as amino acid incorporation into a 
protein, drug absorption, or uptake from plasma by cells when data are available from imaging 
such as PET or MRI. Forcing functions can also be used as a model development and testing 
tool. That process is beyond the scope of this tutorial. 
 
What are forcing functions, and how does SAAM II create and use them? Overall, the situation 
can be described as shown in the following diagram: 
 
 

Input System of
Interest

 
 
The input refers normally to a substance whose input is either extravascular in the case of drug 
uptake and metabolism, or a plasma born substances such as a metabolite whose uptake is in a 
tissue one is studying. The “System of Interest” refers to the details of the system one wants to 
model. It can thus describe absorption of the drug. It also can deal with a protein (amino acid 
incorporation into a protein), another metabolite (parent-metabolite system), or measurements 
taken by an external device such as PET or MRI (in which case the substance of interest is 
transported in blood and taken up where it can be metabolized in the tissue of interest one is 
studying). 
 
To understand how forcing functions work, consider the model to be used in this tutorial: 
 

 
 
For this particular model, in the absence of the forcing function, SAAM II would create the 
following system of three differential equations: 

2)2,3(3)3,2(3

3)3,2(1)1,2(2))2,0()2,3((2

1)1,2(1

qkqk
dt

dq

qkqkqkk
dt

dq

qk
dt
dq
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In the case of the forcing function, Compartment 1 will be specified to represent the material 
that is “driving” the system. One has a choice either to develop a model for that system, or if 
one is not particularly interested in that system per se, to use a forcing function to describe 
Compartment 1. The need to develop a model for the metabolism of material represented by 
Compartment 1 is eliminated. 
 
Since this compartment will be used to drive the system, one needs a means by which to 
describe it. This is done by making Compartment 1 a forcing function, i.e. to force a known 
shape on the time course of q1(t). This procedure will be explained in this tutorial. The model 
you will develop is shown below: 
 

 
The difference in this figure is the presence of “FF” in Compartment 1 to indicate the 
compartment is now a “placeholder” for a forcing function. The equations SAAM II creates in 
this situation are 
 

2)2,3(3)3,2(3

3)3,2(.1)1,2(2))2,0()2,3((2

1)1,2(1

qkqk
dt

dq

qkFFqkqkk
dt

dq

qk
dt
dq

 

 
The essential point to note and the key to the forcing function is that everywhere in the system 
of differential equations where q1 appeared in the absence of the forcing function, when there is 
a forcing function, q1 is replaced by q1.FF everywhere in the system except in the differential 

equation 
dt
dq1 . Thus SAAM II does calculate a solution q1, but this has no effect on the other 

differential equations in the system. 
 
How are forcing functions defined? That is, how is q1.FF specified? There are two ways. One 
way is to write q1.FF as an equation such as a sum of exponentials. The other way is to connect 
sequential data points by a straight line. Both will be illustrated in this tutorial. 
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Part 1. Creating Forcing Functions by Data Interpolation. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. In the SAAM II Toolbox, click Model to be sure these tools are available. 

 
3. Create the following model on the Drawing canvas: 

 

 
 
4. Create the experiment on the model 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. 

 
b. Type “days” in the Units box. 
 
c. Type “7” in the End At box. The Experiment Attributes dialog box will appear as 

follows: 
 

 
 

d. Click Done. The Create Experiment dialog box will open. Be sure Exper is 
selected. The Create Experiment dialog box will appear as follows: 
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e.  Click Create. The model will appear on your drawing canvas as follows: 

 
5. Add the data to the model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 

b. On the File menu, click Open. The file ff_pre_pro.dat should appear in the list (if it 
does not, find the folder where you have put this tutorial and data file). 

 
c. Double-click ff_pre_pro. The data in this file will appear in the Data window as 

shown below.  

 
 

There are some important features of this data file that we will describe below. 
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Unit conversion in the Data window. This data file illustrates several features of the 
SAAM II Data window. First, it illustrates that several columns of data can be used 
with a single independent variable, usually time “t”. The column “pre” is the data 
driving the system; the column “pro” is the system whose characteristics will be 
modeled. 

 
This data file also illustrates how to do unit conversion in the SAAM II Data 
window. The first few rows of the data file are shown below: 

 

 
 

The three column names are “t” for time, “pre” for “precursor” and “pro” for 
“product”. Under these are a line containing (/1440), (), and (). In the “t” column, the 
first data samples were recorded in minutes and not days, the units of the model. 
Thus, “(/1440)” divides all elements in the column by 1440 to convert minutes into 
days. This divisor is in effect until the next set of parentheses is encountered further 
down the column. There are no unit conversions for either “pre” or “pro”; the “()” 
must be included to indicate no conversion. 

 
In the time column, the next unit conversion is shown below: 

 

 
 

You can see after 45 minutes, the “t” changes to 1, 1.5, etc. These are hours, so the 
next few samples are in units of hours, not minutes or days. The division by 24 
converts hours to days. 
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Finally, after 18 hours, you see in the time column () while () remains in both data 
columns. After 18 hours, the data are collected in days, and unit conversion is no 
longer necessary. The () tells SAAM II this is the point at which (/24) is no longer 
needed.  

 
This is a very powerful way to use the SAAM II Data window to be sure all of your 
units are consistent. 

 
 
d. Close the Data window. 

 
6. Create a sample. 

 
a. In the SAAM II Toolbox, click Sample. 

 
b. Click compartment q2, and then click on the Drawing Canvas. The sample s1 will 

appear. 
 

c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “pro” in the Associate with Data Name box.  
 
e. There is no need to edit the sample equation. The Sample Attributes dialog box will 

appear as follows: 
 

 
 
f. Click Done. Noticed s1 is now solid because it is associated with data. 

 
7. Create a forcing function. 

 
a. Double-click Compartment q1, to open the Compartment Attributes dialog box. 
 
b. Click Forcing Function. The Forcing Function dialog box will open as shown 

below (together with the Compartments Attributes dialog box): 
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There are three options in the FF Input from pane. The default option is Turned 
Off since no forcing function has been defined. The other two options are Associate 
with Data Name and Equation for q1.FF. If you select the Associate with Data 
Name option, the forcing function will be created by linear interpolation of 
sequential pairs of data. If you select the Equation for q1.FF option, you must 
specify an equation in the box provided. 

 
c. Click Associate with Data Name in the FF Input from pane. 
 
d. Type “pre” in the Associate with Data Name box. Your Forcing Function dialog 

box will appear as follows: 
 

 
 

Creating Forcing Functions. When you choose the Associate with Data Name option, 
SAAM II will create a forcing function by linearly interpolating between sequential 
data. 
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e. Click Done in the Forcing Function dialog box. 
 
f. Click Done in the Compartment Attributes dialog box. Your model will appear as 

follows: 

 
Notice that “FF” appears in Compartment q1. This is to remind you that this 
compartment is now defining a forcing function. 

 
8. Create a second sample to view the forcing function. 
 

You may visualize the forcing function that is driving the system. To do this, you can 
create a sample, and write the sample equation equal to the forcing function as described 
below. 
 
a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1, and then on the Drawing Canvas. The sample s2 will 

appear. 
 
c. Double-click s2 to open the Sample Attributes dialog box. 
 
d. Type the sample equation “s2=q1.FF” 
 
e. Type “pre” in the Associate with Data Name box. The Sample Attributes dialog 

box will appear as follows: 
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f. Click Done. You will notice that s2 is solid, but no longer connected to 
Compartment q1. This is because the sample equation is no longer associated with a 
specific compartment in your model. This is a difference between q1, the differential 
equation in the model, and q1.FF, the forcing function. The model is shown below. 

 

 
 

Samples. The Sample tool is a very powerful tool in SAAM II. Normally it is used to 
create samples that link a compartment, or compartments, with data. In this case, we 
are interested in viewing the forcing function. When we entered the equation 
“s2=q1.FF”, q1 no longer appeared in the sample equation, hence the line linking the 
sample to q1 was severed. 

 
Remember the name for the forcing function in SAAM II is cpt#.FF where cpt# is 
the number of the compartment with which the forcing function is associated. 

 
 

9. Enter the parameter values. 
 

Enter the parameter values as shown in the following Parameters dialog box: 
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a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 

click Parameter . The Parameters dialog box will open. 
 

b. Double-click k(2,1). Type “60” in the Value box, “10” in the Low Limit box, “100” 
in the High Limit box, and click Save. 

 
c. Double-click k(0,2). Type “0.3” in the Value box, and click Save. 
 
d. Double-click k(3,2). Type “1” in the Value box, and click Save. 
 
e. Double-click k(2,3). Type “1” in the Value box, and click Save.  
 
f. Click Done. 

 

Volumes. Why was there no volume included in the sample s1? That is, normally when 
writing the sample equation we have usually included the volume term. 

 
 There is no volume here because the forcing function “pre” has units of μg/ml so the 

volume term is already built in. The units of “pro” are also g/ml. It is assumed that 
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the “volume” for both “pre” and “pro” is the same. If the forcing function were in 
units of mass, then a volume term would be needed in s1. 

 
 

10. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . The following message will appear: 
 

 
 

Forcing Functions. When you are using data to define a forcing function, the data must 
cover the entire range of the experiment. This means there must be a datum at time 
zero, and a datum at the last time of the experiment. Usually there is not a datum 
available at time zero, so you will have to add a dummy value, usually close to the 
first datum, so the solution can proceed. 

 
 

b. Click OK. 
 
c. Open the Data window. Enter a value for “pre” of 35 at time equals zero. Type “n” 

in the “pro” column at time equals zero. The first lines of your data file will appear 
as follows: 

 

 
 

Data entry. Notice the “n” in the column for the pro. SAAM II expects an entry in 
each column for each time point. If there are no data, enter “n.” 
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d. Close the Data window. 

 
e. Re-Solve the model and view the solution in semilog. Your plot of s1:pro will 

appear as follows: 
 

 
 

You can also plot s2:pre; it will appear as follows: 
 

 
 

f. Plot s2:pre and s1:pro simultaneously. 
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 (1) With the Plot window open, on the Set menu, click Plot/Table Variables. The 
Plot and Table Variables dialog box will open. 

 
(2) Be sure the List All Variables check box is not selected. Click s1:pro. Press the 

CTRL key and click s2:pre. These will move to the Current Selection pane as 
shown below: 

 
 
(3) Click Done. The Plot will appear as follows: 

 
 



Advanced Tutorials SAAM II v.2.1 Working with Forcing Functions 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Forcing Functions – 15 SAAM  II Version 2.1 

g. Close the Plot window. 
 

11. Fit your model to your data and view the solution. 
 
a. Fit your model to your data. On the Compute menu, click Fit, or alternatively, on 

the SAAM II Toolbar, click Fit . The following message will appear: 
 

 
 

The message means that the data error model of “data-relative” is not appropriate for 
this model. We will follow the suggestion to set the error model to “data-absolute.” 

 
Close the Compute Log window. 

 
b. Change the data error model. 
 

(1) In the Compute menu, click Settings. The Computational Settings dialog box 
will open. 

 
(2) In the Variance Model pane, click Absolute. The Variance Model pane inside 

the Optimizer pane will appear as follows: 
 

 
 
(3) Click Done. 

 
c. Re-Solve the model to activate the change in the variance model.  
d. Re-Fit the model to the data. This time the fit is successful.  
e. Open the Plot window and view the solution 
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f. On the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar, click 

Statistics . The Statistics and Plot windows along with the model will appear as 
follows: 

 

 
 

g. Close the Statistics and Plot windows. 
 

 
Quit the SAAM II Compartmental application. If you wish, you may save the study file for 
future use. 
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Part 2. Creating Forcing Functions Using an Equation. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. In the SAAM II Toolbox, click Model to be sure these tools are available. 

 
3. Create the following model on the Drawing canvas: 

 

 
 
4. Create the experiment on the model 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 
box will open. 

 
b. Type “days” in the Units box. 
 
c. Type “7” in the End At box. The Experiment Attributes dialog box will appear as 

follows: 
 

 
 

d. Click Done. The Create Experiment dialog box will open. Be sure Exper is 
selected. The Create Experiment dialog box will appear as follows: 
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e.  Click Create. The model will appear on your drawing canvas as follows: 

 
5. Add the data to the model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 

b. On the File menu, click Open. The file ff_pre_pro.dat should appear in the list (if it 
does not, find the folder where you have put this tutorial and data file). 

 
c. Double-click ff_pre_pro. The data in this file will appear in the Data window as 

shown below.  
 

 
 

There are some important features of this data file that we will describe below. 
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Unit conversion in the Data window. This data file illustrates several features of the 
SAAM II Data window. First, it illustrates that several columns of data can be used 
with a single independent variable, usually time “t”. The column “pre” is the data 
driving the system; the column “pro” is the system whose characteristics will be 
modeled. 

 
This data file also illustrates how to do unit conversion in the SAAM II Data 
window. The first few rows of the data file are shown below: 

 

 
 

The three column names are “t” for time, “pre” for “precursor” and “pro” for 
“product”. Under these are a line containing (/1440), (), and (). In the “t” column, the 
first data samples were recorded in minutes and not days, the units of the model. 
Thus, “(/1440)” divides all elements in the column by 1440 to convert minutes into 
days. This divisor is in effect until the next set of parentheses is encountered further 
down the column. There are no unit conversions for either “pre” or “pro”; the “()” 
must be include to indicate no conversion. 

 
In the time column, the next unit conversion is shown below: 

 

 
 

You can see after 45 minutes, the “t” changes to 1, 1.5, etc. These are hours, so the 
next few samples are in units of hours, not minutes or days. The division by 24 
converts hours to days. 
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Finally, after 18 hours, you see in the time column () while () remains in both data 
columns. After 18 hours, the data are collected in days, and unit conversion is no 
longer necessary. The () tells SAAM II this is the point at which (/24) is no longer 
needed.  

 
This is a very powerful way to use the SAAM II Data window to be sure all of your 
units are consistent. 

 
 
d. Close the Data window. 

 
6. Create a sample. 

 
a. In the SAAM II Toolbox, click Sample. 

 
b. Click compartment q2, and then click on the Drawing Canvas. The sample s1 will 

appear. 
 

c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “pro” in the Associate with Data Name box.  
 
e. There is no need to edit the sample equation. The Sample Attributes dialog box will 

appear as follows: 
 

 
 
f. Click Done. Noticed s1 is now solid because it is associated with data. 

 
7. Create a forcing function. 
 

You will be creating the forcing function by fitting “pre” by a sum of exponentials. Thus 
the first step will be to examine “pre” to estimate how many exponentials will be 
required, and to obtain initial estimates for the coefficients and exponentials. 
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a. Examine the “pre” data. 
 

(1) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar click 

Plot . The Plot and Table Variables dialog box will open. Be sure the List 
All Variables check box is selected. 

 
(2) Click pre to move this to the Current Selection pane. 
 
(3) Click Done. The plot of the pre will appear as follows. 
 

 
 

You can see there are an extremely rapid initial fall and a very slow final decay. To 
examine the characteristics of the initial decay, change the Plot and Table Scale. 
 
(3) On the Set menu, click Plot/Table Scale. Alternatively, click the Set Scales 

Button , or right-click in the plot window and select Scale… The 
Plot and Table Scale dialog box will open. 

 
(4) In the X Axis pane, click Set. Type “1” in the Maximum box. The Plot and 

Table Scale dialog box will appear as follows: 
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(5) Click Done. The plot will appear as follows: 
 

 
 

You can see there are probably three exponentials in these data, so the forcing 
function will be: 
 

)*3exp(*3)*2exp(*2)*1exp(*1.1 taAtaAtaAFFq  
 
Estimates for A1, A2 and A3 respectively will be 30, 3 and 3. This comes from 
the zero time point being approximately 36, and most of the material disappears 
with the first exponential. This is the 30. The remaining two are half of the 
remaining. Since these are linear parameters, close estimates are not really 
required. 
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Estimates for a1, a2 and a3 respectively will be 75, 3 and .003. These estimates 
are obtained from a curve peeling method. 

 
b. Double-click Compartment q1, to open the Compartment Attributes dialog box. 
 
c. Click Forcing Function. The Forcing Function dialog box will open as shown 

below (together with the Compartments Attributes dialog box): 
 

 
 

There are three options in the FF Input from pane. The default option is Turned 
Off since no forcing function has been defined. The other two options are Associate 
with Data Name and Equation for q1.FF. If you select the Associate with Data 
Name option, the forcing function will be created by linear interpolation of 
sequential pairs of data. If you select the Equation for q1.FF option, you must 
specify an equation in the box provided. 

 
c. Click Equation for q1.FF in the FF Input from pane. The Equation box will 

become active. 
 
d. In the Equation box, type the equation “q1.FF = A1*exp(-a1*t) + A2*exp(-a2*t) + 

A3*exp(-a3*t)”. Your Forcing Function dialog box will appear as follows: 
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Creating Forcing Functions. When you choose the Equation for q1.FF option, you 
must enter a specific equation that will be used for the forcing function. In the above, 
you are using a sum of three exponentials meaning there are six parameters, A1, A2, 
A3, a1, a2 and a3. These can be fixed or adjustable. In this case, they will be 
adjustable meaning the forcing function will be defined (fitted) as part of the 
modeling exercise. 
 
The advantage here is that the forcing function can be determined simultaneously 
with examining the system model for “pro”. Once the forcing function parameters 
are determined, they will be fixed before the final Fit to the “pro” data. 

 
 
e. Click Done in the Forcing Function dialog box. 
 
f. Click Done in the Compartment Attributes dialog box. Your model will appear as 

follows: 

 
Notice that “FF” appears in Compartment q1. This is to remind you that this 
compartment is now defining a forcing function. 

 
8. Create a second sample for the forcing function. 

 
a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1, and then on the Drawing Canvas. The sample s2 will 

appear. 
 
c. Double-click s2 to open the Sample Attributes dialog box. 
 
d. Type the sample equation “s2=q1.FF” 
 
e. Type “pre” in the Associate with Data Name box. The Sample Attributes dialog 

box will appear as follows: 
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f. Click Done. You will notice that s2 appears solid, but no longer connected to 
Compartment q1. This is because the sample equation is no longer associated with a 
specific compartment in your model. The model is shown below. 

 

 
 

Samples. The Sample tool is a very powerful tool in SAAM II. Normally it is used to 
create samples that link a compartment, or compartments, with data. In this case, we 
are interested in viewing the forcing function. When we entered the equation 
“s2=q1.FF”, q1 no longer appeared in the sample equation, hence the line linking the 
sample to q1 was severed. 

 
Remember the name for the forcing function in SAAM II is cpt#.FF where cpt# is 
the number of the compartment with which the forcing function is associated. 

 
 

9. Enter the parameter values. 
 

Enter the parameter values as shown in the following Parameters dialog box: 
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Notice that some of the parameters do not use the default values for the Low Limit 
and/or High Limit. 

 

Volumes. Why was there no volume included in the sample s1? That is, normally when 
writing the sample equation we have usually included the volume term. 

 
 There is no volume here because the forcing function “pre” has units of μg/ml so the 

volume term is already built in. The units of “pro” are also g/ml. It is assumed that 
the “volume” for both “pre” and “pro” is the same. If the forcing function were in 
units of mass, then a volume term would be needed in s1. 

 
 

10. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve .  
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e. Plot s1:pro. Your plot of s1:pro will appear as follows (you may have to change the 
Plot and Table Scale resetting the X Axis maximum to “7”; you may also have to 
change the plot to the semilog shown below): 

 

 
 

You can also plot s2:pre; it will appear as follows: 
 

 
 

You can see that the estimates for the exponentials are reasonable, but the estimate 
for A1 needs to be increased. 
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f. Plot s2:pre and s1:pro simultaneously. 
 

(1) With the Plot window open, on the Set menu, click Plot/Table Variables. The 
Plot and Table Variables dialog box will open. 

 
(2) Be sure the List All Variables check box is not selected. Click s1:pro. Press the 

CTRL key and click s2:pre. These will move to the Current Selection pane as 
shown below: 

 

 
 
(3) Click Done. The Plot will appear as follows: 
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g. Leave the Plot window open. 

 
11. Fit your model to your data and view the solution. 

 
a. Fit your model to your data. On the Compute menu, click Fit, or alternatively, on 

the SAAM II Toolbar, click Fit . The following message will appear: 
 

 
 

The message means that the limits on these parameters need to be changed. 
Remember, however, that what you want is a curve which has the characteristics of 
the data. The statistics on these parameters are thus not that important as they will be 
fixed before the final Fit. 

 
Close the Compute Log window. 

 
b. Change the limits on A2 and a3. 
 

(1) Change the Low Limit on A2 to “0.5”. 
 
(2) Change the High Limit on a3 to “0.3” respectively 
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c. Re-Fit the model. Another warning the “A3 hit lower limit“ will appear. Change the 
Low Limit on A3 to “0.5”. 

 
d. Refit the model to the data. This time the fit is successful. The plot of s1:pro and 

s2:pre will be updated as follows: 
 

 
 
e. On the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar, click 

Statistics . The Statistics window will appear as follows: 
 

 
 

f. Close the Statistics windows. The Plot window is still open. 
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g. View the weighted residuals associated with the fit of s2 to pre. 
 

(1) On the Set menu, click Plot/Table Variables. Be sure the List All Variables 
check box is selected. 

 
(2) Click s2:wres to move this to the Current Selection pane. 
 
(3) Click Done. The plot of the weighted residuals, in linear mode, will appear as 

follows: 
 

 
 

You can see the residuals are randomly distributed around zero and line in a band 
essentially between -1 and 1; thus the sum of three exponentials is providing a good 
description of the forcing function. 

 
h. Re-Plot s1:pro in semilog mode. 

 
12. Fix the parameters defining the forcing function, and fit the model to the data. 

 
a. Open the Parameters dialog box, and fix all parameters associated with the forcing 

function. The Parameters dialog box will appear as follows: 
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Fixing the parameters of the forcing function. The parameters of the forcing function 
should be fixed before performing a final fit of the system data, in this case the 
“pro”. In this situation, the parameters of the forcing function could be estimated 
from the data. There will be situations when this is not the case. For example, you 
may have a situation when a sum of two exponentials has excellent statistics but does 
not describe the data. When you try three exponentials, you get an excellent 
description of the data but the statistics are not good. 

 
What is important in this case is the shape of the forcing function. Thus even though 
a sum of three exponentials has bad statistics, because it has the correct shape, it 
should be used as the forcing function. 
 
Finally, by fixing these parameters, the weights associated with the forcing function 
are not taken into account in the system model fit; this is what is desired when you 
are examining only the system model and using the forcing function simply to drive 
the system. 

 
 
b. Fit the model to the data. The plot of s1:pro will appear as follows: 
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c. View the statistics. The Statistics window will appear as follows (after scrolling in 

the Parameter/Variable pane): 
 

 
 

You can see the parameters of the system model are quite well-determined. 
 
d. Close the Statistics and Plot windows. 

 
 
Quit the SAAM II Compartmental application. If you wish, you may save the study file for 
future use. 
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Working with Parameters, Advanced 
 
Prerequisites 
 

The prerequisites for this tutorial are having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental” and the Basic Tutorial 
“Working with Parameters.” 

 
What you will learn in this tutorial 
 
The Basic Tutorial, “Working With Parameters”, showed you how to use the different options in 
SAAM II to define and use the most commonly used types of parameters.  The purpose of this 
tutorial is to show you how to use the additional options in SAAM II to define and refine 
parameters. You will learn 

 
 How to create zero order losses (Part 1) 
 How to write parameters and variables in the Equations window (Part 2) 
 How to re-parameterize the two-compartment model (Part 3) 
 How to set parameter upper and lower limits (Part 4) 
 How to use the Bayesian option (Part5) 

 
This tutorial is divided into parts to which you can refer individually for specific information. 
Since you know how to enter parameters in the Parameters dialog box, you can proceed to any 
specific part of this tutorial without needing the information that preceded it. 
 
Files Required 
 

Study Files: The study files for this tutorial are 
 

study_0.stu 
Para_Limits.stu 
Para_Limits.dat 

 
These files are included as part of this tutorial. The file study_0.stu is the same as 
study_0.stu that is installed in the SAAM II program folder and referred to in the 
SAAM II Basic Tutorials.. The file Para_Limits is a one-compartment model with two 
parameters. 
 
 
 

Jake Kraft
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Introduction 
 
This tutorial is designed to show you have to use the additional options available in SAAM II to 
work with parameters. 
 
In general, most losses are first-order or nonlinear as covered in the basic tutorial, “Working 
with Parameters.”  There may be instances, when the loss is at a constant rate independent of the 
mass in the ith compartment.  In these cases, a zero-order loss is required. Part 1 of this tutorial 
shows how to create a zero-order loss.  Zero-order inputs can also be created, but these are 
equivalent to constant infusions. 
 
A multi-compartmental model in SAAM II is specified by the compartments, transfers and 
losses. The transfers k(i,j) and losses k(0,i) specify the terms in the different differential 
equations created internally by SAAM II. These are called the primary parameters. Often there 
are a number of parameters – volumes, clearances, absorptions – that are functions of these 
primary parameters. These parameters can be specified as variables in the Equations dialog 
box. This procedure is explained in Part 2 of this tutorial. Some models such as the commonly 
used two-compartment model can be re-parameterized based upon the desired secondary 
parameters; this is illustrated in Part 3 of this tutorial. 
 
All adjustable parameters must have initial values specified with high and low limits. For an 
adjustable parameter, if you simply enter a value and click Save, SAAM II will create default 
high and low limits that are 10 times and 0.1 times the initial value. SAAM II actually uses the 
information in the limits as part of fitting. The information is a measure of how well you think 
you know your limits. As will be illustrated in Part 4 of this tutorial, if your limits are widely 
divergent from the initial value, you may have trouble fitting. This is because SAAM II thinks 
you don’t know the parameter very well. On the other hand, if you know a parameter reasonably 
well, this information should be included when you set the limits. 
 
Finally, SAAM II has implemented a partial Bayesian option. This is explained in Part 5 of this 
tutorial. The Bayesian option provides a means by which a priori information about a specific 
parameter, or parameters, can be entered in the Parameters dialog box. 
 

Jake Kraft
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Part 1. Creating a zero-order loss 
 
In general, most losses are first-order or nonlinear. There may be instances, however, when a 
zero-order loss is required. The difference is the following. For the ith compartment, the loss is 
generally expressed (in terms of the differential equation): 
 

 !)(),0( tqik
dt
dq

i
i  

 
That is, the loss is proportional to the mass in the ith compartment. In the case of the zero-order 
loss, this is not the case: 
 

 !),0( ik
dt
dqi  

 
That is, the loss is at a constant rate independent of the mass in the ith compartment. This tutorial 
will explain how to create zero-order losses. 
 
Incidentally, by the same logic, you can see why a zero-order input and a constant infusion are 
the same. If Compartment 1 transferred material to Compartment 2 via a zero-order process,   
 

 !)1,2(2 k
dt

dq
 

 
The parameter k(2,1) is simply a constant rate of input, and hence, in SAAM II notation, is 
equivalent to 
 

 !)2(2 ex
dt

dq
 

 
where ex(2) is specified as a constant infusion. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 
 

b. In the File menu, click Open and click Experiment in the SAAM II Toolbox. The 
SAAM II Compartmental main window will appear as shown below: 
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3. View the Parameters dialog box. In the Show menu, click Parameters, or alternatively, 

on the SAAM II Toolbar, click Parameters . The Parameters dialog box will 
open. The Parameters dialog box should appear as follows: 
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These are the parameters for study_0.stu. 
 

4. Modify k(0,1) so that it is a zero-order loss. 
 

a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equation pane, type “k(0,1)=k_loss/q1”. The Loss Attributes dialog box will 

appear as follows: 
 

 
 

c. Click Done. 
 
The result is that k(0,1) is no longer a primary model parameter, but is a function of a 
new parameter, k_loss. In the differential equation for q1: 
 

""" lossktq
tq

lossktqk
dt

tdq _)(1
)(1

_)(1)1,0()(1  

 
The result is now the loss from Compartment q1 is zero-order, and specified by k_loss. 
A value for this parameter must be entered in the Parameters dialog box. 
 

5. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, click 

Parameters . The Parameters dialog box will open. 
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a. Type “1” as the Value for k_loss, and click Save. The Parameters dialog box will 
appear as follows: 

 

 
 

b. Click Done. 
 

6. Solve the model, and view the solution. A plot of the solution is shown as follows: 
 

 
 

It is of interest, however, to plot k(0,1) which is no longer a constant but a function of 
time since q1(t) appears in the equation defining it. While this is the case, the rate of 
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loss, flux(0,1), should be constant. Both will be plotted. Be sure to keep your plot  open 
so Plot is active. 

 
a. Open the Plot and Table Variables dialog box, and be sure the List All Variables 

check box is selected. {Remember this can be accessed by right clicking on the plot, 
or using the Select variables tool on the SAAM II Toolbar.} 

 
b. Click k(0,1) to move this to the Current Selection pane. The Plot and Table 

Variables box will appear as follows: 
 

 
 

c. Click Done. The plot of k(0,1) will appear as follows (in linear mode): 
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d. Open the Plot and Table Variables dialog box, and select flux(0,1) as the Current 
Selection. When you click Done, the following plot of flux(0,1) should appear: 

 

 
 

This is a constant indicative of the loss from Compartment q1 being zero-order. 
e. Close the Plot window. 
 

7. Restore the original study_0. 
 

a. Open the Loss Attributes dialog box associated with k(0,1), and delete the equation 
“k(0,1)=k_loss/q1”. Click Done. 
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b. Open the Parameters dialog box. Notice k_loss no longer appears; k(0,1) does. 
Select k(0,1), and type “0.1” in the Value box. Click Done. This should restore the 
original settings in study_0. 

 
c. Re-Solve the model. If you open the Plot window, since flux(0,1) was the previous 

plot, the Plot window will appear as follows: 
 

 
 

The flux is no longer a constant since the loss is now a first-order process. If you 
wish, you can change the plot to s1:plasma to be sure you have restored the original 
solution for study_0. 

 
d. Close the Plot window. 
 

8. Create a zero-order loss from Compartment 2. 
 

a. In the SAAM II Toolbox, click Model. The Model tools are now available. 
 
b. Create a loss k(0,2). 
 
c. In the SAAM II Toolbox, click Experiment. The model will appear as follows: 
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d. Double-click k(0,2) to open the Loss Attributes dialog box. 
 
e. In the Equation pane, type “k(0,2)=k_loss/q2”. The Loss Attributes dialog box will 

appear as follows: 
 

 
 
f. Click Done. 
 
g. Open the Parameters dialog box, double-click k_loss to make it the current 

selection, and type “1” in the Value box. Click Save. The Parameters dialog box 
will appear as follows: 
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Click Done. 

 
h. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . The following error message will appear: 

 
Close the Compute Log. 

  Division by zero. What is happening in this situation is that, at time zero, there is no 
mass in Compartment q2, i.e. q2(0) = 0. Remember k(0,2) has been defined by the 
equation k(0,2) = k_loss/q2. This cannot be evaluated at time zero. There are two 
solutions to this problem. The first solution is to change the equation for k(0,2) 
slightly. You know what the mass will be in the compartment because of the 
magnitude of the initial conditions in Compartment q1. Using a number much 
smaller, you can modify the equation for k(0,2) to, for example, k(0,2) = 
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k_loss/(q2+0.00001). The second solution is to introduce a very small bolus into 
Compartment q2, e.g. ex2 = 0.0001. Neither will have a significant effect on the 
solution. 

 
i. Method 1: Modify the equation for k(0,2). 
 

(1) Open the Loss Attributes dialog box associated with k(0,2). 
 
(2) Change the equation to read “k(0,2)=k_loss/(q2+0.00001). The Loss Attributes 

dialog box will appear as follows: 

 
 
(3) Click Done. 
 
(4) Re-Solve the model. This time, the solution will be successful, and a plot of 

s1:plasma will appear as follows: 
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 (5) Close the Plot window. 
 

j. Method 2: Introduce a small bolus into Compartment q2. 
 

(1) Open the Loss Attributes dialog box associated with k(0,2), and re-enter the 
original equation “k(0,2)=k_loss/q2”. Click Done. 

 
(2) In the SAAM II Toolbox, click Input. 
 
(3) Click Compartment q2 and then the Drawing Canvas. The input ex2 will appear 

associated with Compartment q2. The model will appear as follows: 
 

 
 
(4) Double-click ex2 to open the Exogenous Input dialog box. 
 
(5) Enter a bolus of 0.00001. The Exogenous Input dialog box should appear as 

follows: 
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(6) Click Done. 
 
(7) Re-Solve the model. This time, the solution will be successful, and a plot of 

s1:plasma will appear as follows: 
 

 
 
This plot is essentially identical with that obtained using the first method. 
 

(8) Close the Plot window. 
 

  Zero-order losses. If you specify a zero-order loss from a compartment in your 
model where the initial conditions in that compartment are non-zero, the method 
described for k(0,1) is the method to use. If you specify a zero-order loss from a 
compartment whose initial conditions are zero, you must use either of the two 
methods described above to eliminate the problem of division by zero. Either method 
works fine – it is a matter of personal preference. 

 
 

 
Quit the SAAM II Compartmental application. Do not save the changes to study_0.
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Part 2. Specifying parameters and variables in the Equations window 
 
This part of the tutorial will show you have to specify parameters in the Equations window. 
You have seen how equations involving parameters can be written in the Transfer or Loss 
Attributes dialog boxes. Writing such equations in the Equations window is another option in 
SAAM II. In pharmacokinetic studies, this is how you would enter the pharmacokinetic 
parameters that are functions of the model parameters; examples are clearances and volumes. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear as follows: 
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4. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, click 

Equations . The Equations dialog box will open. 
 

a. Enter the following equations in the Equations Defined Here pane: 
 

CLe = vol*k(0,1) 
vol2 = vol*k(2,1)/k(1,2) 
Vss = vol + vol2 
Frac_01=k(0,1)/(k(2,1)+k(0,1)) 

 
CLe is the clearance of material from Compartment 2. vol2 is the volume of 
Compartment 2 assuming the concentrations in Compartments 1 and 2 are the same. 
Vss is the total system volume, or equivalent volume of distribution. Frac_01 is the 
fraction of material in Compartment 1 that is irreversibly lost. 
 
When you have finished, the Equations dialog box should appear as follows: 
 

 
 

b Close the Equations dialog box. 
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5. Fit the model to the data, and view the solution and statistics. The results are 
summarized in the following: 

 

 
 

The “Fit” is quite good as are the statistics. Note statistical information on the 
parameters you defined in the Equations dialog box appear as Derived Variables in the 
Parameter/Variable pane of the Statistics window. 
 

5. Close the Plot and Statistics windows. 
 
Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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Part 3.  Re-parameterizing the two-compartment model 
 
It is sometimes desirable to reparameterize a model so that the desired pharmacokinetic 
parameters become the model parameters. In this part of the tutorial, the two-compartment 
model with loss from the plasma compartment will be reparameterized. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 

 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear as follows: 
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4. Re-specify the model parameters. 
 

The model parameters as the model is currently configured are vol, k(2,1), k(1,2) and 
k(0,1). The model will be reparameterized in terms of clearances. The equations which 
will be used are: 
 

CLe = vol*k(0,1) 
CLi = vol*k(2,1) 
vol2 = vol*k(2,1)/k(1,2) 
Vss = vol + vol2 

 
In SAAM II, these will be rewritten: 
 

k(0,1) = CLe/vol 
k(2,1) = CLi/vol 
k(1,2) = CLi/vol2 

 
The result will be that the model parameters become CLe, CLi, vol and vol2. 

 
 
a. In the Experiment, double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equations pane, type “k(0,1)=CLe/vol”. The Loss Attributes dialog box will 

appear as follows: 
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c. Click Done. 
 
d. Double-click k(2,1) to open the Transfer Attributes dialog box. 
 
e. In the Equation pane, type “k(2,1) = CLi/vol”. The Transfer Attributes dialog box 

will appear as follows: 
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f. Click Done. 
 
g. Double-click k(1,2) to open the Transfer Attributes dialog box. In the Equations 

pane, type “k(1,2) = CLi/vol2”. The Transfer Attributes dialog box will appear as 
follows: 

 

 
 
h. Click Done. 
 
At this point, your model has been reparameterized. 
 

4. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open as shown below: 
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You need to provide initial estimates for CLe, CLi, vol and vol2.  
Note that vol is the only parameter that remains from the original setup 
and retains its initial estimate, change as appropriate. 

 
b. An initial estimate for CLe is 700, for CLi is 400, for vol is 2000 and vol2 is 1500. 

When you enter these values, the Parameters dialog box should appear as follows: 
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Click Done to close the Parameters dialog box. 
 

6. Solve the model and view the solution. The initial parameter estimates are reasonable so 
you can proceed to Fit the model to the data. 

 
7. Fit the model to the data and view the results. A summary of the results follows: 
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  Model re-parameterization. In the above situation it is quite easy to parameterize the 
model in terms of the pharmacokinetic parameters. The results here should be 
essentially the same as the part in this tutorial where these parameters were defined 
in the Equations dialog box. Notice in this case the k(i,j) become the derived 
variables. 

 
For the one-compartment model, the one-compartment model with absorption and 
the three-compartment model, re-parameterization is relatively straightforward. 
However, in instances when there is a single-input multiple-output study (e.g. plasma 
and urine samples), when the model has more than four compartments, or when the 
model is nonlinear, re-parameterization can be a very tricky bookkeeping exercise, 
and should be conducted with caution. 

 
 

7. Close the Plot and Statistics window. 
 
Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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Part 4.  Work with parameter high and low limits 
 
In the Parameters dialog box, for each adjustable parameter you must specify a Low and High 
Limit. SAAM II uses this information when you Fit your model to your data. It interprets the 
values for the Low and High Limit as a measure of the confidence you have in your knowledge 
of a particular parameter. SAAM II is very forgiving in these values, but if a particular limit 
strays too far from the Value, it can affect the statistical results following a Fit. 
 
This tutorial will illustrate what can happen using a simple one-compartment model with two 
parameters, a loss k(0,1) and a volume parameter vol. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file Para_Limits. 
 

a. The file Para_Limits.stu should appear in the file list; if it does not, find the folder 
where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear as follows: 
 

 
This study file contains a set of monoexponentially decaying data. The default weighting 
value has been changed from the default “data-relative” to “data-absolute”. This can be 
verified by viewing the Computational Settings dialog box which will as appear as 
shown below: 
 

 
 
4. Solve the model and view the solution 
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a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
c. Click s1:plasma to move this to the Current Selection pane. 
 
d. Click Done. If the plot is not in semilog, in the View menu, click Semilog. The plot 

will appear as follows: 
 

 
 
e. Close the Plot window. 
 

5. Perform a series of Fits with the Low and High Limit of k(0,1) set at different values. 
The Low and High Limits of the parameters in Para_Limits have been set using the 
default values in SAAM II. The Parameters dialog box will appear as follows: 
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Perform a series of Fits with the Low and High Limit of k(0,1) set at the values shown 
in the following table. The left-hand columns are the Low and High Limit for k(0,1). 
The columns “k(0,1)(CoeffVar)” and “vol(CoeffVar)” are the final parameter values and 
coefficients of variations respectively. The column “Obj” is the value of the objective 
function following the Fit. 
 

k(0,1) Limits k(0,1)(CoeffVar) vol(CoeffVar) Obj

[0.001,0.1]

[0.005,0.05]

[0.0001,1.0]

[1.0e-07,100]

[0,1000]

[0,0.1]  
 

You should fill in this table starting with the default Low and High Limit of k(0,1) 
respectively equal to 0.001 and 0.1. After the first fit, your table should appear as 
follows: 
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k(0,1) Limits k(0,1)(CoeffVar) vol(CoeffVar) Obj

[0.001,0.1] 0.0089(7.4) 3288(4.4) 10.65

[0.005,0.05]

[0.0001,1.0]

[1.0e-07,100]

[0,1000]

[0,0.1]  
 
You should reset the initial estimates of the parameters to their original values of 0.01 
and 3400 respectively, and set the Low and High Limits for k(0,1) equal to 0.005 and 
0.05 respectively for the second Fit. You should continue in this fashion until you have 
completed the table which should appear approximately as follows: 
 

k(0,1) Limits k(0,1)(CoeffVar) vol(CoeffVar) Obj

[0.001,0.1] 0.0089(7.4) 3288(4.4) 10.65

[0.005,0.05] 0.0089(7.4) 3288(4.4) 10.65

[0.0001,1.0] 0.0089(7.4) 3288(4.4) 10.65

[1.0e-07,100] 0.0089(7.9) 3287(4.5) 10.65

[0,1000] 0.0089(14.2) 3288(5.3) 10.65

[0,0.1] 0.0089(7.4) 3288(4.4) 10.65  
 
After each Fit, you can check the plot of s1:plasma. As expected, it will not change 
since the parameter values do not change, as noted above. 
 
What you should observe in this exercise is that, when you can Fit successfully, the Low 
and High Limits will have little or no effect on the parameter estimates themselves, or 
the value of the objective function. What will be effected are the estimated coefficients 
of variations. However, in this instance, the limits have to move far away from the Value 
before this becomes noticeable. Thus SAAM II is, in general, robust. 
 
Understanding the effect of high and low parameter limits becomes crucial is when you 
have a large model with many parameters, some of which may be better estimated from 
the data than others. Here setting the Low and High Limits can have a dramatic effect 
on the final results. 

 
Close all open windows and dialog boxes. 

 
Quit the SAAM II Compartmental application. Do not save the changes to Para_Limits. 
Some additional comments on parameter limits are necessary. 
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The previous tutorial illustrated a simple case of setting the parameter limits on one parameter. 
In linear compartmental models, SAAM II is quite forgiving in setting these limits. There are 
instances when limits must be set, or instances when realistic limits must be set in order to 
achieve a successful fit of the model to the data. 
 
An example of an instance in which a limit must be set rather than using the default value is the 
following. Suppose you have a delay in your model where there are two losses from the delay. 
This is illustrated in the following model: 
 

 
 
There are two possible routes by which material can leave Delay 2. Remember in SAAM II, loss 
from a delay is a fraction, i.e. a fraction of the material in the delay along the possible routes of 
loss. When there is only one loss, the fraction is 1. In this situation above, d(3,2) + d(4,2) = 1, 
and both d(3,2) and d(4,2) must lie between 0 and 1. A convenient way of doing the 
bookkeeping is the following. You can define 
 

d(3,2) = frac 
 
and 
 

d(4,2) = 1 – frac 
 
frac becomes a parameter for which a Value, Low Limit and High Limit must be specified. If 
you enter, for example, 0.5 in the Value box and use the default limits, the Low Limit will be 
0.05 which is okay, but the High Limit will be 5 which is not okay since if in the process of 
fitting, frac goes above 1, d(4,2) will become negative and Conservation of Mass will be 
violated. Thus you must determine Low and High limits for frac that lie between 0 and 1. 
 
Another example of where setting reasonable parameter limits rather than using the default 
values is the following example which will use the SAAM II Numerical application. The data 
to be analyzed are shown in the following plot: 
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These data are cholesterol concentrations in 40 subtractions of high density lipoprotein. The 
problem is to describe these data by a Sum of Gaussians using the SAAM II Numerical 
application. 
 
A Gaussian is a function of the form 
 

 
f (t) 1

2
exp 1

2
t 2

t
 

 
where, in this expression,  is called the mean and  the standard deviation. It is known that 
the area under this so-called bell shaped curve is unity, i.e. 
 
  f (t)dt 1. 
 
The mean  determines the location while the standard deviation  provides a measure of the 
"sharpness" of the gaussian. That is, the smaller the , the narrower the peak. 
 
A sum of four Gaussians will be used to describe these data. In SAAM II, a single Gaussian is 
written: 
 

A1/(SA1*2.51)*exp(-((t-MA1)^2)/(2*SA1^2)) 
 

Where A1 is a parameter characterizing the magnitude of the contribution of the Gaussian. SA1 
and MA1 are the standard deviation and mean of the gaussian. 2.51 approximates 2 . Thus 
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the single Gaussian term has three parameters, A1, SA1 and MA1. Thus in the sum of four 
Gaussians, there will be 12 parameters, and the expression will be: 
 
ya(t) = A1/(SA1*2.51)*exp(-((t-MA1)^2)/(2*SA1^2)) + A2/(SA2*2.51)* 
exp(-((t-MA2)^2)/(2*SA2^2)) + A3/(SA3*2.51)*exp(-((t-MA3)^2)/(2*SA3^2)) + 
A4/(SA4*2.51)*exp(-((t-MA4)^2)/(2*SA4^2)) 
 
Initial estimates for the four means, MA1, MA2, MA3 and MA4 can be obtained by looking at 
the data and estimating where the peaks may lie. Similarly initial estimates for the four standard 
deviations can be obtained again just by looking at the sharpness of the peaks.  
 
Initial estimates were obtained visually, and default values for the Low and High Limits have 
been used. When the model is fitted to the data (with the FSD option), the best fit is shown as 
follows: 
 

 
 
Obviously this is not satisfactory. Neither are the statistics which are shown below: 
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What is happening is that the limits set on the means and standard deviations are not realistic 
using the default values. For example, the High Limits for all the means are well beyond the 
data which end at “40”. Visually, more realistic estimates for the Low and High Limits for both 
the means and standard deviations can be obtained visually.  
 
You can see the limits for the means and standard deviations are much closer to their initial 
estimated Values. The default limits on the Ai are okay since these are linear parameters and are 
not that sensitive to the limits. 
 
Using these initial estimates and limits, if you fit the model to the data (with the FSD option), 
you will obtain the following fit: 
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The statistics are also satisfactory: 
 

 
 
This example thus illustrates the need to be aware of setting limits on your adjustable 
parameters, and to pay attention to how they may need to change as you go through your 
modeling exercise. 
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Part 5. Using the Bayesian option to incorporate prior knowledge 
 
What happens if you have prior information about a parameter in your model? It may be the 
case, for example, a relationship between two parameters has been developed as a result of 
research conducted elsewhere. How can you incorporate this knowledge in your model? 
 
One way you can incorporate priori knowledge is to use the Bayesian option in SAAM II. This 
part of the tutorial will illustrate how this can be done. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 
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3. View the model and the experiment on the model, and change the model. 
 
a. In the SAAM II Toolbox, click Experiment. The model of the experiment will 

appear as follows: 
 

 
 

b. Modify the model by adding a loss from Compartment 2. Your model for the 
experiment should appear as follows: 

 

 
 

4. Specify a relationship between k(0,1) and k(0,2). 
 

Suppose from the literature there is a known relationship between k(0,1) and k(0,2). 
Suppose it is known that k(0,1) is approximately twice k(0,2). How can this be 
incorporated in the model? 
 
a. Double-click k(0,1) to open the Loss Attributes dialog box. 
 
b. In the Equations pane, type “k(0,1) = a * k(0,2)”. The Loss Attributes dialog box 

will appear as follows: 
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c. Click Done. A new parameter, a, has been added to the model. 
 

5. Enter parameter values, and Solve and Fit the model to the data. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open. 

 
b. Be sure a is selected. Set a as a fixed parameter, type “2” in the Value box, and click 

Save.  
 
c. Double-click k(0,2) to select it. Type “0.05” in the Value box, and click Save.  
 
d. Enter the other parameters as shown below:   appear as follows: 
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d. Click Done. 
 

6. Solve the model. The initial parameter value, while not great, are sufficient to proceed 
with a “Fit”. Fit the model to the data and view the solution. A summary of the “Fit” is 
shown in the following: 
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Close the Plot and Statistics windows. 
 
In this case, a was assumed to be known and equal to 2. The result is that there are four 
parameters to be estimated from the data, and the “Fit” was successful. What would 
happen if parameter a was adjustable? 

 
7. Set a as an adjustable parameter. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open. 

 
b. Double-click a to select it. 
 
c. Set a as an adjustable parameter. Leave the initial Value equal to “2”. Type “0.5” 

and “5” in the Low Limit and High Limit boxes respectively. The Parameters 
dialog box will appear as follows: 
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d. Fit the model to the data. The following warning message will appear: 
 

 
 

The warning is that a hit a lower limit. If you continue to adjust the Low Limit, a 
will continue to hit the lower limit. This means there are more parameters in the 
model than can be estimated from the data. 
 

e. Close the Compute Log dialog box. 
 
f.  Note the effect of initial values. Set a as an adjustable value as noted above and 

restore all initial values of each parameter, the Parameters dialog box will appear as 
follows: 

Jake Kraft
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g. Fit the model to the data. The following warning message will appear: 
 

 
 

The warning is that the covariance matrix is unreliable and suggests that the user 
consider using the Bayesian estimation.   
 
However, you may note that incorporating the Bayesian option, as shown below, 
after receiving either one of these Compute Log Warnings, produces the same fitted 
solution. 
 

h. Close the Compute Log dialog box. 
 

 
8. Incorporate prior knowledge about a into the model. 
 

Suppose you really believed that k(0,1) was about twice k(0,2). Suppose you had 
information on the value of a from another study. You can incorporate this knowledge 
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using the Bayesian option in SAAM II. Suppose you know from the literature that a 
value for a is “2” with a standard deviation of “0.05”. In this part of the tutorial, this 
information will be incorporated into the model. 
 
a. In the Compute menu, click Settings. The Computational Settings dialog box will 

open. 
 
b. Select the Include Bayesian Term check box. The Computational Settings dialog 

box will appear as follows: 
 

 
 

c. Click Done. 
 
d. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 

click Parameters . The Parameters dialog box will open. 
 

(1) Double-click a to select it. 
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(2) Select the type for a as Bayesian. 
 
(3) Type “2” in the Mean box and “0.05” in the SD box.  
 
(4) Click Save. The Parameters dialog box will appear as follows: 
 

 
 

(5) Click Done. 
 

  The Bayesian option. If you have information about the value of a model parameter 
from the literature, it is useful to include this in your model. When you have 
Bayesian parameters in your model and you fit your model to your data, SAAM II 
takes this information into account. If there is information in your data about a 
Bayesian parameter, SAAM II will adjust it from its mean value. If there is little or 
no information in your data about a Bayesian parameters, SAAM II will not adjust it 
from its mean value. 

 
 

e. Fit the model to the data. A summary of the results is shown below: 
 

Jake Kraft
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  Bayesian parameters. The Bayesian parameter option is a powerful way to 
incorporate prior information about a parameter in your model. In almost all cases if 
you use this option, you will achieve convergence. If your data do not contain much 
information about the Bayesian parameter, then the value you entered for the Mean 
and SD will not change much; if your data do contain information, they will change. 
In this case, the Mean didn’t change; the SD changed a little. 

 

Jake Kraft
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You should note that the precision of the model parameters is not as good as the 
case, for example, when there were only four parameters to be estimated. This is 
because of the additional uncertainty added by the Bayesian parameter. 
 
Using this option can also be useful as a modeling technique. If in the process of 
developing a model you cannot achieve a fit, you can sometimes use the Bayesian 
option on a specific parameter. You can then tell from the resulting statistical output 
which of the model parameters may be giving difficulty in achieving a “Fit.” This 
can help identify where constraints on parameters or model simplification must be 
undertaken. 

 
 
 

f. Close the Plot and Statistics windows. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
 
 

Jake Kraft
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Saving and Restoring Solutions 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how save and restore solutions. 
 

 How to save solutions and compare results among other solutions 
 How to restore a specifically saved solution. 

 
Files Required 
 

Study Files: The study file for this tutorial is 
 

study_0.stu 
 

This file is included as part of this tutorial. This file is the same as study_0.stu that is 
installed in the SAAM II program folder and referred to in the SAAM II Basic Tutorials. 
 

Introduction 
 
SAAM II enables you to save and work with different solutions of the model you are using.  
When you save a solution you are, in effect, saving the state of the model (i.e., the current 
values of the model parameters).  Additionally, you may save selected variables with their 
values as calculated during the last solve or fit. This can be used to compare results from other 
solutions.   
 
When you restore a solution, you are merely resetting the parameter values back to the saved 
state for that solution.  You are not resetting the values of any other variables.  You must solve 
to restore all other values. 
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Part 1. Saving and restoring solutions 
 
1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 

window will open. 
 
2. Open the SAAM II Compartmental study file study_0. 
 

a. The file study_0.stu should appear in the file list; if it does not, find the folder where 
you put this file. 

 
b. In the File menu, click Open. The SAAM II Compartmental main window will 

appear. In the SAAM II Toolbox, click Experiment. The model of the experiment 
for study_0.stu will appear on the Drawing Canvas as follows: 

 

 
 

3. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, click 

Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 

. The Plot and Table Variables dialog box will open. Be sure the List All 
Variables check box is not selected. 

 
c. Click s1:plasma to move this to the Current Selection pane.  
 
d. Click Done. Your plot will appear as shown below (in linear mode): 
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Leave the Plot window open. 
 

4. Save the solution. 
 

a. In the Compute menu, click Solutions. The Solutions dialog box will open as 
follows: 
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 The Solutions dialog box. The Solutions dialog box contains  
 

The Name Prefix box. Here you can type the name of the solution; the default name 
is “1.” If you type, for example, “base”, the solution will be saved with the name 
“base1”; thus a number is always added to your name. This allows you to create a 
sequence of solutions such as “base1”, “base2”, etc. 
 
The Solutions pane listing the names of the saved solutions.  
 
The Solution Variables pane with the names of the saved solutions variables for a 
given solution, Clicking on the name of a solution in the Solutions pane will produce 
a list of the variables saved in the Solution Variables pane. 
 
The Current Solution pane providing you the option to Add a solution, or to 
Restore Selected, a selected solution. 

 
 
b. Type “Base_” in the Name Prefix box. 
 
c. Click Add in the Current Solution pane. The Solution Variables dialog box will 

open as follows: 
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 The Solution Variables dialog box. The Solution Variables dialog box contains the 
names of the model variables and/or parameters you may save with the solution. 
These saved variables can be accessed for plotting or tabular purposes. They will be 
saved with a suffix added to them. In this case, because the name of the saved 
solution is “Base_” hence saved as “Base_1”, the variables will be saved with the 
name {Base_1} associated with them. For example, if you save s1, the name 
s1{Base_1} will appear in the Plot and Table Variables dialog box. 

 
 

d. In the Solution Variables dialog box, click s1 and then click Done. The Solutions 
dialog box will appear as follows: 

 

 
 

e. In the Solutions pane, click “Base_1”. The Solutions dialog box will appear as 
follows: 
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 The Solutions dialog box. When you click the name of a solution in the Solutions 
dialog box, the variables and parameters saved with that solution will appear in the 
Solution Variables pane. 

 
 
f. Close the Solutions dialog box. 
 

5. Change the value of k(0,1) and compare solutions. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open. 

 
b. Change the value of k(0,1) from “0.1” to “0.2”. 
 
c. Close the Parameters dialog box. 
 
d. Solve the model. The plot will be updated as follows: 
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e. Compare this solution with the original base solution. 

 (1) In the Set menu, click Plot/Table Variables; use the   task bar 
button or right-click in the plot window. The Plot and Table Variables dialog 
box will open. Be sure the List All Variables check box is selected. 

 
(2) Press the CTRL key, and click plasma, s1 and s1{Base_1}. The Plot and Table 

Variables dialog box will appear as follows: 
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 Saved variables and parameters. Notice in the Variable for Y-Axis pane the saved 
original solution s1{Base_1} appears. This is the only saved variable. If you had 
saved other variables or parameters, these would appear in this list followed by 
{Base_1}. 

 
 

(3) Click Done. The plot will appear as follows: 
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6. Save the solution. 
 

a. In the Compute menu, click Solutions.  The Solutions dialog box will open as 
follows: 

 

 
 

Notice “Base_” appears in the Name Prefix box, and “Base_1” is the original saved 
solution. Leave the Name Prefix as “Base_”. 
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b. Click Add. The Solution Variables dialog box will open. Clear the selected 
variables, press the CTRL key, and click q1, q2 and s1. The Solution Variables 
dialog box will appear as follows: 

 

 
 
c. Click Done. The Solutions dialog box will appear as follows: 
 

 
 

Notice the Name Prefix “Base_” remains, but the number “2” is added. Thus 
“Base_2” is the second “Base_” saved solution. 
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d. In the Solutions pane, click “base2”. The Solutions dialog box will appear as 

follows: 
 

 
 

The variables in the Solution Variables pane are those that you saved; they will 
appear as variables in the Plot and Table Variables dialog box. 

 
e. Close the Solutions dialog box. 

 
7. Fit the model to your data. In the Compute menu, click Fit, or alternatively, on the 

SAAM II Toolbar click Fit . Since the Plot window was open during the “Fit”, the 
Plot window will be updated as shown below: 

 



Advanced Tutorials SAAM II v.2.1 Working with Solutions 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Solutions – 12 SAAM  II Version 2.1 

 
 

Remember your previous plot had s1{base1} as a variable in the Current Selection 
pane; thus this plot compares the best fit of the model to the data with the original 
solution. 

 
8. Compare all three solutions. 
 

a. In the Set menu, click Plot/Table Variables; click the select variables button or 
right-click in the plot window and select Variables… The Plot and Table Variables 
dialog box will open. Be sure the List All Variables check box is selected. 

 
b. Clear the selected variables, press the CTRL key, and click plasma, s1, s1{Base_1} 

and s1{Base_2} to move these variable to the Current Selection pane. 
 
c. Click Done. The plot will appear as follows: 
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d. Close the Plot window. 
 
e. In the Show menu, click Table, or alternatively, on the SAAM II Toolbar click 

Table . The following table will open. 
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Because the previous plot had the Plot and Table Variables  plasma, s1, s1{base1} 
and s1{base2} selected, these the variables will appear in the table. To change the 
variable, simply open the Plot and Table Variables dialog box, and select those 
variables you would like to view in tabular form. 
 

f. Close the Table window. 
 

9. Compare q1{base2} with q1 from the best fit. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click Plot 
. The previous plot will open. 

 
b. In the Set menu, click Plot/Table Variables; click the select variables button or 

right-click in the plot window and select Variables…  The Plot and Table Variables 
dialog box will open. Be sure the List All Variables check box is selected. 

 
c. Press the CTRL key, and click q1 and q1{base2} to move these variables to the 

Current Selection pane. Notice there is no q1{base1}; this is because you did not 
save q1 as a variable for base1.  Click Done. The plot will appear as follows: 

 

 
 

d. Close the Plot window. 
 
10. Save the solution from the best fit. 
 

a. In the Compute menu, click Solutions. The Solutions dialog box will open. 
 
b. Type “Fit_” in the Name Prefix box. 
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c. Click Add. The Solutions Variables dialog box will open. 
 
d. Click s1 and Done. 
 
e. In the Solutions dialog box, click “Fit_1”. The Solutions dialog box will appear as 

follows: 
 

 
 

f. Close the Solutions dialog box. 
 
11. Restore the original solution {Base_1}. 
 

a. In the Compute menu, click Solutions. The Solutions dialog box will open. 
 
b. Click “Base_1”. The saved variables for “Base_1” will appear in the Solution 

Variables pane as shown below. Notice also in the Current Solution pane, Restore 
Selected is active. You now have the option to restore this solution. 
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c. Click Restore Selected. The following message will appear: 
 

 
 
d. Click OK. 
 
e. Solve the model and view the solution. You will see it is the original solution. You 

can confirm this by examining the parameter values. Close all open windows and 
dialog boxes. 

 
11. Add a compartment to the model. 
 

a. Add a third compartment to your model. The new model should appear as follows: 
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b. Add parameter values to your model. 
 

(1) In the Show menu, click Parameters, or alternatively, on the SAAM II 
Toolbar, click Parameters . The Parameters dialog box will open. Notice 
the values for k(2,1), k(1,2), k(0,1) and vol are those for study_0. 

 
(2) Double-click k(3,2) to make it active. Type “0.01” in the Value box, and click 

Save.  Repeat the process for k(2,3). The Parameters dialog box will appear as 
follows: 

 

 
 
(3) Click Done. 
 

c. Solve the model, and compare the solution with the best fit to a two-compartment 
model solution. 



Advanced Tutorials SAAM II v.2.1 Working with Solutions 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Solutions – 18 SAAM  II Version 2.1 

 
(1) In the Compute menu, click Solve, or alternatively, on the SAAM II Toolbar, 

click Solve . 
 
(2) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, click 

Plot . A plot of the current solution s1 and the plasma data may appear. If a 
plot opens, in the Set menu, click Plot/Table Variables; click the select 
variables button or right-click in the plot window and select Variables… The 
Plot and Table Variables dialog box will open. If a plot does not open, the Plot 
and Table Variables dialog box will open. Be sure the List All Variables check 
box is selected. 

 
(3) Press the CTRL key, and click plasma, s1 and s1{fit1}. The Plot and Table 

Variables dialog box will appear as follows: 
 

 
 
(4) Click Done. The Plot window will appear as follows: 
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 Saved solutions. It is important to know that, even though you changed the model 
structure by adding a third compartment, the solutions saved for the two-
compartment model remain, and can be compared with your work on the third 
compartment. 

 
 

d. Fit the model to the data.  In the Compute menu, click Fit, or alternatively, on the 

SAAM II Toolbar click Fit . The following warning message will appear: 
 

 
 
 The Plot window will be updated as follows: 
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NOTE: The combination of the warning message and the identical fit of the model 

to the data indicate a third compartment is not supported by the data.  
 

e. Close the Compute Log window and the Plot window. 
 

12. Restoring the original two-compartment model 
 

a. In the Compute menu, click Solutions. The Solutions dialog box will open. 
 
b. In the Solutions pane, click “Base_1”. The Solutions dialog box will appear as 

follows: 
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 Although “Base_1” is active, the Restore Selected option in the Current Solution 
pane is dimmed. 
 

 Restoring solutions. When you restore a solution, the model on the drawing canvas 
must be the same structural model as the saved solution. In the above case, the 
current model is a three-compartment model while the saved “base1” solution is a 
two-compartment model. Thus it cannot be restored. 

 
 

c. Close the Solutions dialog box. 
 
d. Delete Compartment 3 from the model. 
 

(1) Click Compartment q3 to make it active. 
 
(2) Press the Delete key. The model and a warning message will appear as follows: 
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(3) Click OK. The original two-compartment model will appear on the Drawing 

Canvas. 
 

e. In the Compute window, click Solutions. The Solutions dialog box will open. 
 
f. In the Solutions pane, click “Base_1”. The Solutions dialog box will appear as 

follows: 
 

 
 

Now because the model on the Drawing Canvas is the same as the original saved 
model, the Restored Selected option is available in the Current Solution pane. 

 
g. Click Restored Selected. The following message will appear: 
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h. Click OK, and close the Solutions dialog box. 
 
i. Solve the model, and view the solution. In the Plot Variables dialogue box, uncheck 

the ‘List All Variables’ box.  Double-clicking ‘s1:plasma’ will clear the ‘Current 
Selection’ replacing it with s1 and plasma. The original solution will appear as 
indicated by the following plot. 

 

 
 
j. Close all open windows and dialog boxes. 

 
13. Save this study file and its solutions.  

 
a. In the File menu, click Save As. The Save As dialog box will open.  

 
b. Type “solutions” in the File Name box. 

 
c. Click Save. 
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14. Quit the SAAM II Compartmental application. In the File menu, click Exit. The 
following message will appear: 

 

 
 

If you click Yes, a file called solutions.sol. containing the solutions will be created. The 
“.sol” indicates a SAAM II solutions file. When you open solutions.stu, the solutions 
saved will be available in the Solutions dialog box. If you click No, the solutions will 
not be saved. 

 
Click Yes. Now when you open solutions.stu, your solutions will be available. 
 
 

 

 Restoring solutions.  
In order to restore a solution, the model on the drawing canvas must be the same 
structural model as the saved solution. Otherwise, ‘Restore Selected’ will be greyed 
out in the Solutions dialog box 
When you restore a solution, the Minimum Number of Calculations Intervals in the 
Computational Settings must be the same as the saved solution. Otherwise, 
‘Restore Selected’ will be greyed out in the Solutions dialog box 
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Simulating Data 
 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II introductory 
basic tutorial, “Getting Started with Compartmental SAAM II.” It will be helpful to 
have worked through the Advanced SAAM II tutorial “Working with Change 
Conditions.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to simulate experimental data given a model. 
You will learn 
 

 How to create plasma data (a single input-single output experiment) (Part 1) 
 How to create plasma and 24 hour urine collections (a single input-two output 

experiment) (Part 2) 
 
Files Required 
 

Study File: The study file for this tutorial is 
 

study_0.stu 
 

This file is included as part of this tutorial. This file is the same as study_0.stu that is 
installed in the SAAM II program folder and referred to in the SAAM II tutorials. 
 
Data File: The data file for this tutorial is 
 

SimPlasUrine.dat 
 

Introduction 
 
This tutorial will show you how to simulate experimental data for a single subject given a model 
and an experiment on the model. The simulated data are generated using the FORTRAN 
function RAND(). RAND() is a random number generator that will generate random numbers 
between zero and 1. 
 
The way the RAND() function will be used is the following. If RAND() generates a random 
number between zero and 1, then 

 
5.0()RAND    - will generate a random number between -0.5 and 0.5. Thus            

)5.0()(*2 RAND   - will generate a random number between -1 and 1.  
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Consider now, for example, Compartment q1. q1(t) is the solution of the differential equation 
q1’(t); its values are calculated at the times samples were collected. The sample s1, for example, 
is a function of q1(t) such as “s1=q1/vol.” 
 
To create simulated data, a new sample on the desired compartment will be created. In the 
Equation dialog box, a function “error” will be created as follows: 
 

)5.0()(*2 RANDerror  
 
The new sample equation, if the sample is in terms of concentration, will be written: 
 

s2  = (q1 + (wt*error)*q1)/vol 
 
What is the effect of this equation? The key is in the term “wt*error”. “wt” will be the weight 
assigned. Thus the product “wt*error*q1” will produce a random error term equal to “wt” 
associated with q1(t). If “wt” is a fractional standard deviation of 10%, then this would be 
written: 
 

s2  = (q1 + (0.1*error)*q1)/vol 
 
 
You can assign any error structure you want as long as it falls in the general equation supported 
by SAAM II: 
 

wt = A + B*q1(t)^C 
 
The simulated data can be used in the DATA window for analytical purposes, or can be used to 
create a table which can be exported to a spreadsheet. 
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Part 1. Simulating plasma data 
 
Suppose you had one or two prototype experiments and you were developing a model of the 
system. Simulating data sets will allow you to examine the robustness of your model and can be 
used to suggest changes in the experimental protocol, particularly when samples should be 
drawn. 
 
In creating simulated plasma data, one can start from a model (with parameters and 
experimental design) and no data. To create the simulated data, one must create a data file 
containing the desired data (sample) points. For example, one could have a model and create the 
following data file: 
 

 
 
This will result in simulated plasma samples at 15 and 30 minutes, 1, 3, 6, 12 and 18 hours, and 
then daily to 9 days. The “n” in the plasma column is simply a placeholder for “plasma”. 
 
The alternative is to use an existing study file that contains data. This part of the tutorial will use 
the study file study_0, which already contains a data set. What you will learn is how to create a 
new data set that parallels the existing data 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder where 

you put this tutorial. 
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b. In the File menu, click Open. The SAAM II Compartmental main window will 

appear as shown below: 
 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 

 

 
 
4. Solve the model and view the solution. The plot of s1:plasma will appear as follows (in 

semi-log mode): 
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Close the Plot window. 
 
5. Create the error function. 
 

a. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 
click Equations . The Equations dialog box will open. 

 
b. Type the following equation in the Equations Defined Here box: 
 

error = 2*(rand()-0.5) 
 

The Equations dialog box will appear as follows: 
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c. Close the Equations dialog box. 
 

6. Create the sample to generate the simulated data. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The sample s2 will 

appear associated with q1. 
 
c. Double-click s2 to open the Sample Attributes dialog box. 
 
d. Change the equation for s2 to read: 
 

s2=(q1+fsd*error*q1)/vol 
 

The Sample Attributes dialog box will appear as follows: 
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The model will appear as follows: 
 

 
 

 
Samples and simulated data. Notice the original sample s1 remains associated with 
the original plasma data. Sample s2 will be used to generate simulated data. Keeping 
both samples will let one compare the original and simulated data. 

 
 

e. In the Sample Attributes dialog box, click Done. 
 

 Creating simulated data. As explained in the Introduction to this tutorial, the 
function “error” will generate a random number between -1 and 1. The effect of the 
“fsd*error*q1” part of the sample equation is the following. In this example, the 
error associated with the simulated data will be fractional standard deviation. An 
actual value could be used in the equation instead of “fsd” if you know exactly what 
the percent error should be. Writing the equation in this way will result in “fsd” 
becoming a parameter, fsd, which will appear when you open the Parameters dialog 
box. In this way you can adjust the percent error to a value which will generate 
simulated data in line with the kinds of real data you anticipate generating in a real 
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experiment. Thus the term “fsd*error” will be a random number not between -1 and 
1, but between –fsd and fsd. This, when multiplied by the model solution q1(t) will 
give a random error equal to the assigned “fsd”. When added to q1(t), it will produce 
a datum with a random “fsd” error. 

 
 

7. View the Parameters dialog box, and enter a value for fsd. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open. 

 
b. Double-click fsd to make this the active parameter. 
 
c. In the Value box, type “0.05”. 
 
d. Select Fixed as the Parameter type. 
 
e. Click Save. The Parameters dialog box will appear as follows: 
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f. Click Done. 
 
8. Fit the model to the data. The plot of s1:plasma will appear as follows: 
 

 
 

 Parameters and simulated data. The strategy in simulating data in this situation is to 
simulate data comparable to the original data. In this case, you want to simulate data 
similar to that in study_0.dat. Thus you need to Fit the model to the data since the 
simulated data are based upon the model, and you need a good model description of 
the original data as a starting point. Once the Fit is performed, you will only be 
solving to generate new simulated data sets. Of course fsd must be a fixed parameter. 

 
 

9. View the simulated data. 
 

As part of the fitting process, you solve the model so you will have generated a set of 
simulated data. A plot of s2 in linear mode will appear approximately as follows: 



Advanced Tutorials SAAM II v.2.1 Simulating Data 
 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Simulate Data – 10 SAAM  II Version 2.1 

 
 

A plot of the solution s1 compared with s2 in linear mode will appear as follows: 
 

 
 
There are two points that need to be made. 
 
The word “approximately” is used because each time you Solve, you will obtain a new 
set of simulated data. Thus your simulated set may not look exactly like these. 
 
The second is s2 not smooth while s1 is smooth? The answer is that s1 contains the 
solution q1 which is a smooth, continuous function. On the other hand, s2 contains the 
solution q1 to which error has been added. At each SAAM II calculation point, a value 
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of s2 which contains this error is calculated, and plotted. This is why s2 is not smooth. In 
this case, fsd is 0.05 or only a 5% error. If you increase the value of fsd, the s2 will 
exhibit much more variability when compared with s1. 
 
Close the Plot window. 
 

10. Modify the format for the simulated data. 
 
a. View the simulated data in tabular format. In the Show menu, click Table, or 

alternatively, on the SAAM II Toolbar, click Table . Since the Plot window 
was previously opened with s1 and s2, the Table window will open as follows: 

 

 
 

This allows you to compare the simulated solution s1 with the new simulated data set 
s2. There are many more simulated data than in your original data file because 
SAAM II will calculate a simulated datum at each calculation point. How to deal 
with this will be explained below. 
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b. In the Compute menu, click Settings. The Computational Settings dialog box will 

open. 
 
c. Type “1” in the Min. Nr. of Calculation Intervals box. The Computational 

Settings dialog box will appear as follows: 
 

 
 

d. Click Done. Notice the Table window changes as follows: 
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This now has the sample times in agreement with the original data file because the 
minimum number of calculation intervals has been set equal to 1. Notice there are no 
values for s1 or s2; this is because the computational settings have been changed. To 
obtain values, you must Re-Solve. 
 

e. Re-Solve the model. The Table will be updated as follows: 
 

 
 
Notice there are two values at day 9. SAAM II always calculated two values at the 
last sample point. You can simply delete one of them when you continue your work. 
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 Solving and simulated data. Every time you Solve, you will generate a new set of 
simulated data. This is because, in this case, s2 gets calculated with each Solve. Thus 
if you compare the data set generated above with the original set of simulated data, 
there will be differences. This is useful if you are generating several sets of simulated 
data. You can simply Solve, save the data as described in Step 10, Re-Solve and 
continue. 

 
 

10. Use the simulated data. 
 

There are many ways you can use the simulated data. One is to cut and paste the data to 
a spread sheet. Another way, cutting and pasting directly into the Data window, and 
fitting the model to the data will be illustrated how. 
 
a. In the Set menu, click Plot/Table variables. The Plot and Table Variables dialog 

box will open. Click s2 to move this (as the only variable) to the Current Selection 
pane. Click Done. The Table window will appear as follows: 

 

 
 
b. Select and copy the data in the Table window. Close the Table window. 
 
c. Open the Data window, and select the contents of this window as shown below: 
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Notice the first two and last lines have not been selected. 
 
c. In the Edit menu, click Paste. The Data window will appear as follows: 
 

 
 
d. In the Data window: 
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(1) Change “s2” to “plasma”. 
 
(2) Remove the zero time value. Remove the second datum at day 9. 
 
(3) Remove any spaces before the “END” statement. 
 
(4) In the Edit menu, click Check Data Format. Correct any errors if there are any. 

The Data window should appear as follows: 
 

 
 
(5) Close the Data window. 
 

e. Save the study file with the new data. 
 

Since these data are not those in study_0.dat, if you want to work with this new set 
of data, you should save the study file with a new name. 
 
(1) In the File menu, click Save As. 
 
(2) In the File Name box, type the desired new file name (e.g. Simulate_1). 
 
(3) Click Save. You can now use this file to continue your analyses. For example, a 

plot of the simulated data is shown as follows: 
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and a plot of the solution (remember using the initial parameter estimates for 
study_0) is shown below: 
 

 
 
Close the Plot window if you created these plots. 

 
Quit the SAAM II Compartmental application. You may want to check to be sure there are no 
changes to study_0. 
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Part 2. Simulating plasma data and 24 hour urine collections 
 
This part of the tutorial will use the study file study_0. study_0 already contains a data set. You 
will change the experimental protocol for one lasting 14 days instead of 9, and use a data file 
which contains only the times at which you wish samples. Such a strategy can be used in 
establishing experimental protocols when you want to determine, for example, an optimal, 
practical sampling schedule. Thus this is an example of using an existing system model, and 
modifying it as part of an experimental design process. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental main 
window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder where 

you put this tutorial. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window will 
appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 

Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 

 

 
 

4. Modify the experiment in study_0. 
 

a. Change the time of the experiment from 9 to 14 days. 
 

(1) In the Set menu, click Experimental Attributes. The Experimental Attributes 
dialog box will open. 

 
(2) Change the value in the End At box from “9” to “14”. The Experimental 

Attributes dialog box will appear as follows: 
 

 
 
(3) Click Done. 
 

b. Add a compartment to the model for urine. Modify the model to the following: 
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Compartment q3 will be used to simulate the 24 hour urine collections. 
 
c. Change the data in the Data window. 
 

(1) Open the Data window (the original data for study_0 will appear). 
 
(2) Replace these data with SimPlasUrine.dat. Open the Data window. In the File 

menu, click Open. Double-click SimPlasUrine.dat to replace the data in 
study_0. A Warning will be appear: 
 

 
 
Click on OK. The Data window should appear as follows. 
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Notice in the Data window the first few samples are in hours. Division by 24, 
which is invoked by (/24), will convert these times to days. There are separate 
data segments for plasma and urine since urine and plasma sample times do not 
always coincide. 

This Data window is different from Part 1 of the tutorial. In Part 1, you were 
starting from a given set of data, and generating new data. In this part of the 
tutorial, the Data window contains only the time points at which you want to 
produce simulated data. 

  (3) Close the Data window. 
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d. Reset the parameter values. 
 

When you eliminated k(0,1) and introduced Compartment q3, essentially k(0,1) was 
replaced by k(3,1). Open the Parameters dialog box, and type “0.1” in the Value 
box for k(3,1). Click Save. The Parameters dialog box should appear as follows: 
 

 
 
Close the Parameters dialog box. 
 

e. Create the mechanism for the 24 hour urine collections. 
 

To create the 24 hour urine collections, the contents of Compartment q3 will be reset 
to zero using Change Conditions. 
 
(1) In the SAAM II Toolbox, click Change Conditions. The Change Conditions 

dialog box will open. 
 
(2) In the Duration pane, select Instantaneous. 
 
(3) In the First Event box, type “1.001”. 
 
(4) In the Interval box, type “1”. 
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(5) In the Last Event box, type “13.001” 
 
(6) In the Equation box, type “q3=0”. 
 
(7) Click Add. The Change Conditions dialog box will appear as follows: 
 

 
 

Remember the purpose of setting the value of Compartment q3 equal to zero at 
1.001, 2.001, etc. is because the actual sample is at 1, 2, etc, and the container is 
emptied just after the sample. Adding “0.001” to the time accommodates this. 

 
(8) Click Done. 
 

f. Save the study file as SimPlasUrine (this to ensure you do not over write study_0.) 
 

5. Create the error function. 
 

a. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 
click Equations . The Equations dialog box will open. 

 
b. Type the following equation in the Equations Defined Here box: 
 

error = 2*(rand()-0.5) 
 

The Equations dialog box will appear as follows: 
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c. Close the Equations dialog box. 
 

6. Create the samples to generate the simulated data. 
 

a. Double-click s1 to open the Sample Attributes dialog box. 
 
b. Edit the sample equation to read: 
 

s1 = (q1+fsd1*error*q1)/vol 
 
c. Remove “plasma” from the Associate with Data Name box. The Sample 

Attributes dialog box should appear as follows: 
 

 
 
d. Click Done. 
 
e. In the SAAM II Toolbox, click Sample. 
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f. Click Compartment q3 and then click on the Drawing Canvas. The sample s2 will 

appear associated with q3. 
 
g. Double-click s2 to open the Sample Attributes dialog box. 
 
h. Change the equation for s2 to read: 
 

s2=q3+fsd2*error*q3 
 

The Sample Attributes dialog box will appear as follows: 
 

 
 

The model will appear as follows: 
 

 
 
i. In the Sample Attributes dialog box, click Done. 
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 Creating simulated data. As explained in the Introduction to this tutorial, the 
function “error” will generate a random number between -1 and 1. The effect of the 
“fsd1*error*q1” part of the sample equation is the following. In this example, the 
error associated with the simulated data will be fractional standard deviation. An 
actual value could be used in the equation instead of “fsd1” if you know exactly what 
the percent error should be. Writing the equation in this way will result in “fsd1” 
becoming a parameter, fsd1, which will appear when you open the Parameters 
dialog box. In this way you can adjust the percent error to a value which will 
generate simulated data in line with the kinds of real data you anticipate generating 
in a real experiment. Thus the term “fsd1*error” will be a random number not 
between -1 and 1, but between –fsd1 and fsd1. This, when multiplied by the model 
solution q1(t) will give a random error equal to the assigned “fsd1”. When added to 
q1(t), it will produce a datum with a random “fsd1” error. Similarly for the urine, 
except “fsd2” is used in the expression. This will permit the possibility of the plasma 
and urine simulated data having different coefficients of variation. 

 
 

7. View the Parameters dialog box, and enter a value for fsd1 and fsd2. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II Toolbar, 
click Parameters . The Parameters dialog box will open. 

 
b. Double-click fsd1 to make this the active parameter. 
 
c. In the Value box, type “0.05”. 
 
d. Click Save.  
 
e. Double-click fsd2 to make this the active parameter. 
 
f. In the Value box, type “0.2”. 
 
h. Click Save. The Parameters dialog box will appear as follows: 
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 Parameters and simulated data. Even though the parameters in study_0 are 
adjustable, only simulations will be performed when simulating data. Thus the 
parameters can be regarded as fixed. 

 
 

i. Click Done. 
 
8. Solve the model and view the simulated data s1 and s2. The plot of s1 in linear mode 

will appear (approximately) as follows: 



Advanced Tutorials SAAM II v.2.1 Simulating Data 
 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Simulate Data – 28 SAAM  II Version 2.1 

 
 

The plot of s2 will appear in linear mode as follows: 
 

 
 

There are two points that need to be made. 
 
The word “approximately” is used because each time you Solve, you will obtain a new 
set of simulated data. Thus your simulated set may not look exactly like these. 
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The second is neither s1 nor s2 are smooth. Why? The answer is that both contain the 
solutions q1 and q3 respectively which are smooth, continuous functions. At each 
SAAM II calculation point, the values of s1 and s2 contain the errors, i.e. the errors are 
calculated and added to q1 and q3 respectively. This is what is plotted. Obviously it is 
not as noticeable in s2 because these are simulated 24 hour urine collections. 
 
Close the Plot window. 
 

9. Modify the format for the simulated data. 
 
a. View the simulated data in tabular format. In the Show menu, click Table, or 

alternatively, on the SAAM II Toolbar, click Table . Since the Plot window 
was previously opened with s2, the Table window will open (in part) as follows: 
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There are many more simulated data than in your original data file. This is because 
SAAM II will calculate a simulated datum at each calculation point. How to deal 
with this will be explained below. 
 
Leave the Table window open. 

 
b. In the Compute menu, click Settings. The Computational Settings dialog box will 

open. 
 
c. Type “1” in the Min. Nr. of Calculation Intervals box. The Computational 

Settings dialog box will appear as follows: 
 

 
 

d. Click Done. Notice the Table window changes as follows: 
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This now has the sample times in agreement with the original data file because the 
minimum number of calculation intervals has been set equal to 1. As before, there 
are no calculated values for s2 as the computational settings have changed. 
 

e. Include s1 in the table. 
 

(1) In the Set menu, click Plot/Table variables; or select the Plot/Table Variables 

button .  The Plot and Table Variables dialog box will open. 
 
(2) Include s1 in the Current Selection pane. 
 
(3) Click Done. The Table window will appear as follows: 
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f. Re-Solve the model. The Table will be updated as follows: 
 



Advanced Tutorials SAAM II v.2.1 Simulating Data 
 

www.saam.com  © 2011 University of Washington and The Epsilon Group 
 Simulate Data – 33 SAAM  II Version 2.1 

 
 

 Change conditions and simulated data. The table is different from the table with no 
calculated values. This is because when SAAM II calculates a solution in a model 
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that includes Change Conditions, it will calculate and report the model calculated 
value at the Change condition time (e.g. 1.001); it will then report the value after the 
Change Condition has occurred. Thus for the time point 1.001 at which a Change 
Condition occurred, you see a value followed by a second value of zero. This is a 
check to let you know the calculations are being performed correctly. SAAM II also 
calculates two values for the end of experiment time. You will simply remove one of 
these as you work with this table. 

 
 

 Solving and simulated data. Every time you Solve, you will generate a new set of 
simulated data. This is because, in this case, s1 and s2 get calculated with each 
Solve. Since the error term is included and is random, it also is calculated producing 
different values for s1 and s2 with each solve. 

 
 

10. Use the simulated data. 
 

There are many ways in which you can use the simulated data. One is to cut and paste 
the data to a spread sheet. Another way, cutting and pasting directly into the Data 
window, and fitting the model to the data will be illustrated how. 
 
a. Select and copy the data in the Table window. Close the Table window. 
 
b. Open the Data window, and select all the contents of this window. 
 
c. In the Edit menu, click Paste. The Data window will appear as follows: 
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d. In the Data window: 
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(1) Add the first two lines “DATA” and “(FSD 0.1)”; add the last line “END” 
 
(2) Change “s1” to “plasma” and “s2” to “urine”. 
 
(3) Remove the zero time value. 
 
(4) Remove all values at time points with “.001”. 
 
(5) Replace all simulated urine samples up to day 1 with “n”. 
 
(6) Remove the second datum at day 14. 
 
(7) In the Edit menu, click Check Data Format. Correct any errors if there are any. 

The Data window should appear as follows: 
 

 
 

Remember the data were simulated with an FSD equal to 0.1 and 0.2 respectively 
for plasma and urine. In the above, FSD equal to 0.1 applies to both sets of data. 
If you wish, you can modify the first lines in the Data window to reflect the 
weighting scheme used to simulate the data. The line (FSD 0.1) can be removed, 
and the three columns can be headed: 
 
 t plasma (FSD 0.1) urine (FSD 0.2) 
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(8) Close the Data window. 
 

e. Save the study file with the new data. 
 

Since these data are not those in SimPlasUrine.stu, if you want to work with this 
new set of data, you should save the study file with a new name. 
 
(1) In the File menu, click Save As. 
 
(2) In the File Name box, type the desired new file name (e.g. SimPlasUrine_1). 
 
(3) Click Save. You can now use this file to continue your analyses. For example, a 

plot of the simulated plasma data is shown as follows: 
 

 
 

A plot of the simulated urine data is shown as follows: 
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A plot of the solution using the model parameters to generate the simulated data is 
shown as follows: 

 
 

You can now work with these simulated data as you would with a set of experimental 
data. 
 
Quit the SAAM II Compartmental application.  
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